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Preface 2

Preface

Copyright

This manual is published by Revvity, Inc., 68 EIm Street, Hopkinton, MA 01748
USA. Copyright 2014 - 2024, Revvity, Inc and its parent, affiliated, and subsidiary
companies. All rights reserved, including but not limited to those rights to reproduce
this publication or parts thereof. Reproduction of this publication or parts thereof or
the products it describes by any means or in any form is expressly prohibited
without the written permission of Revvity is a registered trademark of Revvity, Inc. All

other trademarks are the property of their respective holders.
Trademarks

Any errors or omission which may have occurred in this publication, despite the
utmost care taken in its production, will be corrected as soon as possible, but not

Content necessarily immediately upon detection. Revvity provides this publication “As Is”
without warranty of any kind, either express or implied, including but not limited to
the implied warranties of merchantability or fithess for a particular purpose. Some
states or jurisdictions do not allow disclaimer of express or implied warranties in
certain transactions; therefore, this statement may not apply to you. Revvity
reserves the right to revise this publication and to make changes from time to time in
the content hereof without obligation of Revvity to notify any person of such revision
or changes. Further, Revvity may make modifications to the product described in
this manual at any time without any obligation to notify any person of such
modifications.

If you have a question about the LabChip GX Reviewer software that is not
answered in this manual or online Help, or if you need assistance with this product,

Contact Us contact the Revvity Customer Care Center from 8:00 A.M. to 8:00 P.M., Eastern
Time, Monday through Friday:

Phone: (US Toll Free): 800-762-4000
(Worldwide): +1 203-925-4602
Fax: +1 203-944-4904

Email: L3LabChip@Revvity.com
Internet: https://www.Revvity.com

For support outside the United States, contact your local Revvity representative.

Before you call, you should have the following information available for the technical
representative:

*  Product serial number
»  Software version (found by choosing About from the main Help menu)
« If applicable, the error number shown in the software or in the log file.
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Product Service and Customer Support Plans

Revvity offers a full range of services to ensure your success. From our original
factory warranty through a comprehensive line of customer support plans, Revvity
offers you Field Service Engineers and in-house Specialists who are dedicated to
supporting your hardware, software and application development needs.

Call:  (US Toll Free): 800-762-4000
(Worldwide): +1 203-925-4602

Fax: +1 203-944-4904
Email: LASService@Revvity.com

Our programs can include such useful services as:
*  Preventive maintenance

« Diagnostic servicing performed on-site by Revvity field service engineers or
remotely via Technical Support

+ Validation performed on-site by Revvity field service engineers
+  Extended use of the Revvity Technical Support Center

*  Software updates

+ Parts, labor, and travel expense coverage

»  Other customized services upon request

Training For Your Product

Contact the Revvity Center for Training and Development for information about
the availability of training courses for your product:

Call: +1 203-925-4602

Fax: +1 203-944-4904

FCC

This device complies with part 15 of the FCC (United States Federal
Communications Commission) Rules. Operation is subject to the following two
conditions:

. This device may not cause harmful interference, and

+  This device must accept any interference received, including interference that
may cause undesired operation.
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CE

This device complies with applicable CE rules and requirements.

NOTE
|

Changes or modifications to this equipment not expressly approved by the party
responsible for compliance could void the user’s authority to operate the

equipment.

REMARQUE

Tout changement ou modification apporté a cet instrument non expressément
approuvé par I’entité responsable de la conformité peut annuler 'autorisation
d’opérer I'appareil accordée a I'utilisateur.

Table of Symbols

Table 1 contains symbols that identify particularly important information and alert
you to the presence of hazards. These symbols may appear in this manual and/or
on the product it describes.

Table 1. Important Symbols

Symbol
Symbole

Description
Description

N

WARNING: Caution. Refer to the User’'s documentation. (ISO
7000-0434B)

AVERTISSEMENT: Attention. Se reporter a la documentation
de I'utilisateur.

NOTE: A cautionary statement; an operating tip or maintenance
suggestion; may result in instrument damage if not followed.
REMARQUE: Enoncé indiquant une précaution a prendre, un
conseil de fonctionnement ou une suggestion d’entretien; son
non-respect peut provoquer des dommages a I'instrument.

Ce

CE compliance mark.
Marque de conformité CE.

Helpful hints, additional information
Conseils utiles, informations supplémentaires

Revision History

Revision

Description of Change

E

Update for LabChip GX Reviewer V5.10 software changes.

F

Update for LabChip Reviewer V5.11 and AAV Empty/Full assays.
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Introduction

This manual includes instructions for using the LabChip GX
Reviewer software. It includes procedures for analyzing data from
LabChip GX/GXIl and GX Touch/GXII Touch instruments, software
troubleshooting, and using the optional LabChip GxP software to
provide compatibility with 21 CFR Part 11 requirements.

Using the LabChip GxP option alone does not ensure 21 CFR Part
11 compliance. Laboratory processes and procedures must comply
with 21 CFR Part 11 regulations.

This section contains the following information:

» Usage on page 11

* Assays on page 11

* Principles of Operation on page 12

LabChip GX Reviewer User Manual
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Usage

Assays

PN CLS151165 Rev H

LabChip GX Reviewer software is for use with LabChip GX/GXII
and LabChip GX Touch/GXIl Touch instruments. LabChip GX/GXII
and GX Touch/GXIl Touch instruments are for research use only
and not for use in diagnostic procedures.

DNA, gDNA, RNA, Protein, Glycan, and Protein Charge Variant
(CZE) Chip and Reagent Kits are available to run specific assays on
the LabChip GX or GX Touch instruments. The Assay Kits include
the reagents and consumables required to run the specific assay.
Protein, Glycan, and Protein Charge Variant assays are only
supported on LabChip GXII or GXII Touch instruments.

Assay User Guides

Assay User Guides provide information about the assay.
Instructions for preparing the chip, the plate, the ladder vial, and the
buffer vial are included in the LabChip GX Touch/GXIl Touch Assay

User Guide you are running. Detailed information about the assays,
including Specifications, Safety Warnings, Preparation Procedures,

Expected Results, Troubleshooting, LabChip Kit Essential
Practices, and Reordering Information is also located in the

LabChip GX Touch/GXIl Touch Assay User Guide for the specific
assay that you are running.

The current version of the Assay User Guides can be accessed on
the Revvity web site at: https://www.Revvity.com.

Assay Quick Guides

Assay Quick Guides are included with each Assay Kit and include
instructions for preparing the chip to run an assay.

The current version of the Assay Quick Guides can be accessed on
the Revvity web site at: https://www.Revvity.com.
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Principles of Operation

The LabChip GX/GX Touch assays are based on traditional gel
electrophoresis principles that have been transferred to a chip
format. The chip format dramatically reduces separation time and
provides automated sizing and quantitation information in a digital
format.

The LabChip Reviewer software is used to analyze data generated
by LabChip GX and GX Touch instruments. The LabChip Reviewer
software should be installed on the computer that will be used to
analyze the data. Note that the LabChip GX Reviewer software
must be able to access the location where the LabChip GX or GX
Touch data files are stored.

The LabChip GX Reviewer software can be set up to access the
data files directly on the instrument, or can access copies of the
data files that are copied to a network location.

If the LabChip GxP option is installed, the data files are stored in a
secure folder that can only be accessed by the GX instruments, GX
Touch instruments, and the LabChip GX Reviewer software. The
folder can be located on the GX Touch instrument, on the GX
Reviewer computer, or on a network server.

The LabChip GX Reviewer software plots fluorescence intensity
versus time and produces electropherograms for each sample (see

Figure 1).
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Figure 1. Electropherogram

PN CLS151165 Rev H LabChip GX Reviewer User Manual



Introduction 13

Principles of Operation (Continued)
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The data can be viewed in a gel-like format on the Gel Tab to
achieve the appearance of a slab gel. (The colors of the gel can be
changed.)
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Figure 2. Gel View

For DNA, RNA, Protein, and Glycan assays, quantitating the
concentration and accurately sizing each fragment are achieved by
comparing against a sizing ladder and running internal standards or
“‘markers” with each sample. Internal standards of known
concentration are mixed with the sample to aid in quantitation.

The amount of sample sipped into the chip depends on pH, salt
concentration, and buffer additives. The internal standards
normalize these factors so that the software can use the ratio of the
area of the curve of the standard to the unknown peak to determine
concentration directly. The internal standards lie slightly outside the
assay range so they do not interfere with analysis.

Capillary Zone Electrophoresis (CZE) is an electrophoretic
separation technique used to evaluate the charge heterogeneity of
proteins in a sample. For Protein Charge Variant assays, analytes
are separated based on their net charges, with molecules with a
higher net charge migrating faster than those with a lower net
charge. The data is analyzed to calculate the % Relative Amount of

the peaks.
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Operation

This section includes general instructions for using the LabChip GX
Reviewer software.

This section contains the following information:

» Setting Up the LabChip GX Reviewer Software

* Opening the LabChip GX Reviewer Software

» Saving Workspace Files

Setting Up the LabChip GX Reviewer Software

PN CLS151165 Rev H

If the LabChip GxP option is installed, the LabChip GX Reviewer
software must be connected to the CDR before it can be used to
analyze data files or manage user accounts. If the LabChip GxP
option is not installed, this procedure is not necessary.

To set up the LabChip GX Reviewer software:

1 After the LabChip GX Reviewer software and the LabChip GxP
option is installed, open the LabChip GX Reviewer software
(see Opening the LabChip GX Reviewer Software). The CDR /
Database Server Mapping Window opens.

2 Type the name or IP address of the server where the CDR is
installed in the Server Name/IP Address text box and click the
Apply button.

NOTE
|

If desired, the server can be remapped to a different address after
setup. See Remapping the CDR Server on page 133.

3 Wait for the server connection to be established, and then click
OK in the Connection Established window.

4 Login to the LabChip GX Reviewer software as administrator
with the password administrator.

5 Create the desired LabChip GX Touch user accounts for use in
the GX Reviewer software and the GX Touch software (see
Adding New Users on page 119).

6 To switch users, close and re-open the LabChip Reviewer
software. Log in as the desired user.

LabChip GX Reviewer User Manual
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Opening the LabChip GX Reviewer Software

To open the LabChip GX Reviewer software:

1 Double-click on the LabChip GX Reviewer icon on the
Windows desktop.

2 If the LabChip GxP option is installed, the Login Window opens.
Type a valid LabChip GX Touch user name and password into
the text boxes and click the OK button. (For instructions on
creating LabChip GX Touch user names, see Adding New Users
on page 119.)

The LabChip GX Reviewer Main Window opens.

Saving Workspace Files

PN CLS151165 Rev H

When viewing plate data in the LabChip GX Reviewer main window,
you view the selected Data Files in a Workspace. The Data Files
are not saved in the Workspace file. The workspace file contains
links to the revision of the data file that was last open in the
collection. If a Workspace file is moved to another folder or
computer, the data files must be moved with the Workspace file.
The data files must be in the same location relative to the
Workspace file as they were, otherwise you are prompted to find the
missing data files when you open the Workspace. It is a good
practice to save the workspace files in the same location as the
data files that are included in the workspace.

Saving a Workspace file automatically saves any changes to the
data files that are open in the workspace, and the settings for each
collection in the workspace.

If the LabChip GxP option is installed, saving Workspace files does
not require permission to save data files unless the data files in the
workspace have been modified.

LabChip GX Reviewer User Manual
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Data Analysis

After a run is complete, use the LabChip GX Reviewer software to
view and analyze the plate data. The LabChip GX Reviewer
software can open multiple data files in the same workspace to
compare the data from different plates. Analysis settings can be
changed for single wells, entire plates, or all plates in the
workspace.

This section contains the following information:

+ How the Software Analyzes DNA Data

* How the Software Analyzes Protein Data

* How the Software Analyzes RNA Data

*  How the Software Analyzes Glycan Data

* How the Software Analyzes Protein Charge Variant Data

* How the Software Analyzes Genomic DNA Data

* How the Software Analyzes NAQuant NGS Data

* How the Software Analyzes AAV Empty/Full Data

* Organizing, Retrieving, and Backing Up Data Files

* Opening a New Workspace

* Opening a Data File

* Adding a Collection to a Workspace

» Selecting the Wells in a Collection

* Using Sample Names Files

* Using Expected Fragments/ Expected Proteins/ Expected
Glycans

* Using Filters

* Using Replicates

* Modifying Analysis Parameters
* Marker Peaks

» Saving and Exporting Assays

* Viewing AAV Empty/Full Assay Results
+ Changing the View of the Data
+ Copying Information

* Reanalyzing a Data File

*  Printing Workspace Information
» Exporting Data

LabChip GX Reviewer User Manual
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How the Software Analyzes DNA Data

The LabChip GX DNA Assay Analysis calculates the size and
concentration of nucleic acid fragments.

The data analysis process for DNA assays consists of the following
steps:

1 Raw data is stored by the system for each individual well.

2 The data is filtered (see Data Filtering on page 278) and the
resulting electropherograms of all wells are plotted.

3 Peaks are identified (see Understanding Peak Finding on
page 108) for all wells and are tabulated by migration time. The
peak find settings can be changed for all wells or only for
specific wells.

4 Asizing ladder (see Figure 3), which is a mixture of DNA
fragments of different known sizes, is run first from the ladder
vial. The concentrations and sizes of the individual base pairs in
the ladder can be changed on the Analysis Tab.
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Figure 3. Ladder Graph - DNA
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How the Software Analyzes DNA Data
(Continued)
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5 The ladder is analyzed (see Ladder Analysis on page 282) and

a standard curve of migration time versus DNA size is plotted
from the DNA ladder by interpolation between the individual

DNA fragment size/migration points. The standard curve derived
from the data of the ladder well should resemble Figure 4.
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Figure 4. Standard Curve Window - DNA

6

Two DNA fragments, the Lower Marker and Upper Marker, are
run with each of the samples, bracketing the DNA sizing range.

The Lower Marker and Upper Marker are internal standards
used to align the ladder data with data from the sample wells.
Figure 5 shows an example of assigned marker peaks in a

sample well.
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Figure 5. Markers - DNA
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How the Software Analyzes DNA Data

(Continued)

7

10

The standard curve and the markers are used to calculate DNA
fragment sizes for each well from the migration times measured.

To calculate the concentration of the individual DNA fragments
in all sample wells, the upper marker, in conjunction with a
calibration curve plotting assay-specific concentration against
base-pair size, is applied to the individual sample peaks in all
sample wells.

To calculate the concentration of a smear, the entire area under
the curve defined by the smear is partitioned into sections
corresponding to different base-pair sizes. The area of each
section is evaluated against the area of the upper marker and
the calibration curve. The total area of all the evaluated sections
is given as the concentration of the smear.

If a titer is being used, the ladder is not used for quantization.
Instead, peak sample areas or smear sample areas are
normalized using the upper marker and then quantization is
performed using the titer standard curve to convert normalized
area to concentration; see Titer on page 299.

NOTE

The software allows you to define upper and lower markers.
Changing the markers causes quantitative changes in the
calibration procedure, however, and therefore in the entire data
evaluation.

How the Software Analyzes Protein Data

The LabChip GX Protein Assay Analysis consists of the following
steps:

1
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Raw data is read and stored by the system for each individual
well.

The data is filtered (see Data Filtering on page 278) and the
resulting electropherograms of all wells are plotted.
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Data Analysis 20

How the Software Analyzes Protein Data

(Continued)

3

Peaks are identified (see Understanding Peak Finding on

page 108) for all wells and are tabulated by migration time. The
settings of the peak find algorithm can be changed and the data
can be reanalyzed after the run has finished. (See Reanalyzing
a Data File on page 94.) The peak find settings can be changed
for all or only certain wells.

A sizing ladder (see Figure 6), which is a mixture of protein
fragments of different known sizes, is run from the ladder vial
before and after every 12 samples. The concentration and sizes
of the individual proteins (in kDa) in the ladder can be changed
on the Analysis Tab.

Fluoresconcs

[F200_LF1 RUNT_2008-3-7_9-52-9_1/Ladder1] Ladde
1200+

X5y

Y

=

S0 =

25 30 5 40
Aligned Tirne (sec)

=
-
ka
i L

Figure 6. Ladder Graph - Protein

5

The ladder is analyzed (see Ladder Analysis on page 282) and
a standard curve of migration time versus mobility is plotted
from the ladder by interpolation between the individual protein
size/migration points. The standard curve derived from the data
of the ladder well should resemble Figure 7.
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How the Software Analyzes Protein Data
(Continued)
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Figure 7. Standard Curve - Protein

6 ALower Marker is the internal standard used to align the ladder
data with data from the sample wells. Figure 8 shows an
example of the assigned Lower Marker peak (marked LM) in a
sample well.
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How the Software Analyzes Protein Data
(Continued)

7 Before calculating either the protein size or concentration, the
sample data is processed relative to the two ladders that
bracket every 12 samples. First, all of the data is aligned to the
lower marker and then stretched, relative to the highest
molecular weight protein in the ladder.

8 The concentration of the sample proteins is determined relative
to the bracketed ladders. There are seven proteins in the ladder
(not including the lower marker). The ladder concentration can
be changed on the Analysis Tab (see page 193).

9 |If atiteris being used, the ladder is not used for quantization.
Instead, peak sample areas are normalized using the lower
marker and then quantization is performed using the titer
standard curve to convert normalized area to concentration; see
Titer on page 299.

NOTES
|

* The seven proteins are assumed to represent the average
staining behavior of proteins and are used to determine an
average peak area per ug/mL of protein. This factor is used to
convert sample peak areas into relative concentration. The total
relative concentration of all proteins is calculated by addition of
the relative concentration of the individual proteins and is
displayed in the Well Table View (see page 170).

» Since the conversion factor is determined for each ladder, the
factor can be linearly interpolated for each sample and thus
account for any assay drift.

» The software allows you to define the lower marker. Changing
the selection of the marker will lead to quantitative changes in
the calibration procedure, and therefore in the entire data
evaluation.
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How the Software Analyzes RNA Data

The LabChip GX RNA Assay Analysis determines the quality of the
RNA sample by measuring the relative amounts of know RNA
fragments relative to the total RNA present in the sample. Results
for each well are calculated after all data for the well has been read.

PN CLS151165 Rev H

The data analysis process for RNA assays consists of the following
steps:

1

Raw data is read and stored by the system for each individual
well.

The data is filtered (see Data Filtering on page 278) and the
resulting electropherograms of all wells are plotted.

A curve spline fit to the data is performed to generate a baseline
above which RNA fragment peaks are detected. This baseline is
displayed as a blue line on the electropherogram when Show
Peak Baselines is selected in the Graph View Properties (see
page 162).

Peaks extending above the baseline are identified (see
Understanding Peak Finding on page 108) for all wells and are
tabulated by migration time. The settings of the peak find
algorithm can be changed and the data can be reanalyzed after
the run has finished. The peak find settings can be changed for
all or only certain wells.

A sizing ladder (see Figure 9), which is a mixture of RNA
fragments of different known sizes, is run first from the ladder
vial. The concentrations and sizes of the individual nucleotides
in the ladder can be changed on the Analysis Tab.
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How the Software Analyzes RNA Data
(Continued)
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Figure 9. Ladder Graph - RNA

6 The ladder is analyzed (see Ladder Analysis on page 282) and
a standard curve of migration time versus RNA size is plotted
from the RNA ladder by interpolation between individual RNA
fragment size/migration points. The standard curve derived from
the data of the ladder well should resemble Figure 10.
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How the Software Analyzes RNA Data
(Continued)

7 Adye matching the lowest peak in the ladder is run with each of
the samples. This lower marker, labeled LM in the RNA sample
(see Figure 11) is used to align the ladder data with data from
the sample wells.
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Figure 11. Markers - RNA

8 The standard curve and the markers are used to calculate RNA
fragment sizes for each well from the migration times measured.
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How the Software Analyzes RNA Data

(Continued)
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9

The Total RNA present is computed by finding the area under
the electropherogram trace. The baseline for this integration is a
straight line starting at the end of the lower marker and ending
at the baseline end time. The height of the baseline endpoints is
computed from an average of a five second window around the
baseline Start Time and End Time (shown on the Peak Find
Tab). View the baseline by selecting Show Peak Baselines in
the Graph View Properties. Adjust the Start Time and End Time
by dragging the left (Start) and right (End) vertical dashed lines
to areas that more properly reflect the signal baseline. (Right-
click in the graph, select Set Scale, and change the X axis
Minimum and Maximum values if the start and end times are not
shown in the graph.)
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Figure 12. Peak Baseline - RNA

10 The Total RNA concentration in the sample is computed from

the ratio of the RNA area in the sample to the RNA area in the
ladder multiplied by the ladder concentration specified in the
assay.

If a titer is being used, the ladder is not used for quantization.
Instead, peak sample areas are normalized using the lower
marker and then quantization is performed using the titer
standard curve to convert normalized area to concentration; see
Titer on page 299.
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How the Software Analyzes RNA Data
(Continued)

Fluorescence

i I

11 Assay-defined RNA fragments are identified from the peaks in

the peak table. Fragments are located by finding the largest
peak within a size range associated with the fragment. For
Eukaryote RNA assays, 55, 18S and 28S fragments are
located. For Prokaryote assays, 5S, 16S and 23S fragments are
identified.

12 The following values are calculated for RNA assays:

Fragment_Area: Area of each rRNA Fragment.
%_of_Total_Area: Each Fragment area as a percent of total
area.

Corrected RNA Area: Total RNA Area corrected with Lower
Marker height.

RNA Concentration (ng/ul): Estimated Total RNA
Concentration in the sample.

rRNA Area Ratio [28S / 18S]: 28S area divided by 18S area.
rRNA Height Ratio [28S / 18S]: 28S height divided by 18S
height or 23S height divided by 16S height.

rRNA Fast Area Ratio: Region between 5S and 18S or 16S,
percent of total area.

RNA quality metrics: rRNA Area and Height Ratios (28S/18S
or 23S/16S) and Fast/Total RNA area ratio are computed.
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Figure 13. rRNA Graph Analysis

13 Messenger RNA Assay: The RNA contamination ratio is

computed. This is the ratio of the area of all the fragments to
total RNA area.
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How the Software Analyzes Glycan Data

The LabChip GX Glycan Assay Analysis consists of the following
steps:

1 Raw data is read and stored by the system for each individual
well.

2 The data is filtered (see Data Filtering on page 278) and the
resulting electropherograms of all wells are plotted.

3 Peaks are identified (see Understanding Peak Finding on
page 108) for all wells and are tabulated by migration time.

4 Asizing ladder (see Figure 14), which consists of multiples of a
basic sugar molecule, is run from the ladder vial before and after
every 12 samples. The simplest molecule is assigned a size unit
of 1 CGU (Caliper Glucose Unit). The sequence of ladder peaks
is assigned integer size values, providing a migration time to
size ruler for sizing other sugar molecules.
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Figure 14. Ladder Graph - Glycan

5 The ladder is analyzed (see Ladder Analysis on page 282) and
a standard curve of migration time versus mobility is plotted
from the ladder by interpolation between the individual
glycan/migration points. The standard curve derived from the
data of the ladder well should resemble Figure 15.
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How the Software Analyzes Glycan Data
(Continued)
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Figure 15. Standard Curve - Glycan

6 ALower Marker is the internal standard used to align the ladder

data with data from the sample wells. Figure 16 shows an

example of the assigned Lower Marker peak (marked LM) in a

sample well.
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Figure 16. Markers - Glycan
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How the Software Analyzes Glycan Data

(Continued)
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7 The standard curve and the markers are used to calculate
glycan sizes in each well from the migration times measured.

8 The area under each peak is calculated.

9 All the sample peak areas are added together and an area ratio
is calculated for the %Area for each peak.

NOTES

In Glycan assays, the lower marker does not precede all ladder
peaks but appears between the 6th and 7th ladder peak. The
concentration of the lower marker has been made sufficiently
large to avoid confusion with ladder peaks. Since peaks before
the lower marker are ignored, the ladder peaks used for the
sizing ruler range from 7 to 13 CGU.

The software allows you to define the lower marker. Changing
the selection of the lower marker will lead to quantitative
changes in the calibration, and therefore in the entire data
evaluation.
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How the Software Analyzes Protein Charge

Variant Data
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The LabChip GX Protein Charge Variant Assay Analysis consists of
the following steps:

1

Raw data is read and stored by the system for each individual
well.

The data is filtered (see Data Filtering on page 278) and the
resulting electropherograms of all wells are plotted.

A baseline is generated for the data using the settings on the
Peak Find tab on the Assay Analysis Window. This baseline is
displayed on the electropherogram when Show Peak Baselines
is selected in the Graph View Properties (see page 162).

Peaks are identified (see Understanding Peak Finding on

page 108) for all wells and are tabulated by migration time. The
settings of the peak find algorithm can be changed and the data
can be reanalyzed after the run has finished. (See Reanalyzing
a Data File on page 94.) The peak find settings can be changed
for all or only certain wells.

The % Relative Amount for each peak is calculated as a percent
of total area.
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How the Software Analyzes Genomic DNA Data
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The Genomic DNA (gDNA) assay analyzes data similar to the other
DNA assays, except that the alignment of the sample data with the
ladder data is based solely on the Lower Marker. To improve the
accuracy of the alignment of the 12 samples between ladders,
gDNA assays use the bracketed alignment described in How the
Software Analyzes Protein Data on page 19.

For calculating concentration, the Genomic DNA assay uses a GQS
Smear, starting at 0.175 kb and extending to 300 kb, by default (see
Figure 17). The start size of the gDNA smear can be changed on
the Advanced Tab in the Assay Analysis window before the run
starts or on the Smear Analysis Tab after the run. The calculation of
concentration is similar to that used for individual peaks, as
described in How the Software Analyzes DNA Data; however, the
GQS Smear is used in place of individual sample peaks, and the
lower marker is used in place of the upper marker to normalize
areas. The Total gDNA Concentration of each sample is reported in
the Well Table.

The Genomic DNA assay also reports a Genomic Quality Score
(GQS) for each sample in the Well Table. The GQS represents the
degree of degradation of a sample, with 5 corresponding to intact
gDNA and 0 corresponding to highly degraded gDNA. The GQS is
calculated using the size distribution of the sample.
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Figure 17. Genomic DNA GQS Smear (in orange)
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How the Software Analyzes NAQuant NGS Data

The NAQuant NGS dsDNA sample fluorescent intensity is
measured at a steady state between 33 and 37 seconds and is
averaged to obtain the Fluorescence Intensity value.

The concentration of the sample is calculated using calibration
curves generated from the eight Standards. The molarity of each
sample is calculated using the sample concentration, the DNA
fragment size (in base pairs), and the Dilution factor. The Sample
Size and Dilution factor can be provided in the Sample Names file,
in the Sample Names Tab before a well is run in the LabChip GX
Touch software, or in the Sample Name Editor Window in the
LabChip GX Reviewer software.

How the Software Analyzes AAV Empty/Full Data

The AAV Empty/Full assay analysis requires two assays, an AAV
DN DNA assay and an AAV Pico Protein assay (sample
concentration less than 1E12 VP/mL) to calculate the percent of AAV
capsids that contain ssDNA in a sample. The percent impurities of
high or low molecular weight nucleic acid is also calculated.

1 Run the AAV DN DNA assay and the AAV Pico Protein assay on
the samples. The samples must be in the same order in each
data file.

2 The AAV DN DNA assay sips the ladder, the standard,

12 samples and then repeats for each 12 samples. The AAV
Pico Protein assay has the same sips with an additional ladder
sip after the last sample.

3 The data in each assay is analyzed using the data analysis
settings and is displayed in GX Touch Reviewer, but these
analysis settings are not used to calculate the AAV Percent Full
or the AAV Percent Impurity. Only the settings in the AAV
Analysis Window are used.

4 Set one AAV DN DNA plate and one AAV Pico
Protein plate for AAV Analysis in LabChip GX Reviewer.

5 Select the desired parameters in the AAV Analysis Window.
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How the Software Analyzes AAV Empty/Full Data
(Continued)

6 The AAV Empty/Full Protein Assay is analyzed as follows, using
the settings in the Protein Settings Tab on the AAV Analysis
Window:

a Identifies the VP3 peak using the size or time specified in
the Protein Settings tab.

b Identifies VP2 as the next successive peak after VP3 within
the specified number of seconds after VP3.

¢ Identifies VP1 as the next successive peak after VP2 within
the specified number of seconds after VP3.

d Calculates corrected areas for each peak. Corrected area is
the area under the peak divided by the peak migration time.

e Calculates VP3/VP1 and VP2/VP1 ratios to show the molar
ratio of the capsid.

7 The AAV DN DNA Assay is analyzed as follows, using
the settings in the DNA Settings Tab on the AAV Analysis
Window:

a Identifies and sizes the ssDNA peak using the Migration
Time and % Window.

b Calculates the ssDNA Aligned Area.

8 If the sample contains AAV partial capsids, a partial peak can
occur before the ssDNA Peak. Use the Electropherograms Tab
to identify a partial peak, if necessary.

9 The software calculates the area ratio of the samples and
standard for the protein peaks and the ssDNA peak respectively.

10 The software calculates the Percent Full for each sample using
the AAV Standard % Full specified in the AAV Analysis tab.

11 The AAV Analysis Tab on the AAV Analysis window displays the
analyzed DNA data, the analyzed Protein data, the % AAV Full,
the % Empty Capsids, and the % DNA Impurity for each sample.

See Viewing AAV Empty/Full Assay Results on page 79 for details
on setting analysis parameters for AAV Empty/Fill assays.
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Organizing, Retrieving, and Backing Up Data
Files

As you work in the LabChip GX Reviewer software, it's a good
practice to organize the LabChip GX Reviewer files.

* Create a folder in which to save the data files. If desired, each
person can save data files to their own subfolder to organize the
data files.

+ Save Workspace files in the same directory as the data files to
prevent missing data files in the workspaces.

* Review the files periodically, even if only one person uses the
LabChip GX Reviewer software. If you are not using the
LabChip GxP option, archive files you are no longer using but
want to save to a backup disk, and discard unneeded files.
Verify there is enough free space on the hard drive to save new
plate data files. If you are using the LabChip GxP option, see
LabChip GxP Option on page 115 for backup options.

» Each user in the laboratory can specify a particular data file
name prefix to easily differentiate data files.

Opening a New Workspace

A workspace displays data from one or more plate data files from
the same type of assay. Each workspace can contain one or more
Collections to display the data.

To open a new workspace:

1 On the menu bar, select File > New Workspace. If changes
have been made to an open workspace, you are prompted to
save any unsaved changes. A blank workspace opens in the
LabChip GX Reviewer Main Window.

To view data, see:

* Opening a Data File

» Adding a Collection to a Workspace

» Selecting the Wells in a Collection

* Modifying Analysis Parameters

« Saving and Exporting Assays

For AAV Empty/Full assays, see Viewing AAV Empty/Full Assay
Results on page 79.
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Opening a Data File

Open a data file to view the data, to compare the data to other data
files in the same workspace, or to change analysis setting and view
the reanalyzed data. Data files generated by the LabChip GX or GX
Touch software have a .gxd file extension.

To open a data file:

1 Open a new workspace (see page 35) or a workspace that
already contains compatible data files.

2 Onthe menu bar, select File > Import Data File. If the LabChip
GxP option is not installed, the Select a Data File Window
opens. If the LabChip GxP option is installed, the CDR Manager
Window opens.

3 Select the name of the data file to open and click the Open
button. The selected data file is imported into the open
workspace. Use Ctrl+click or Shift+click to select multiple files.

+ To select a .cla file, select CLA from the Files of Type drop-
down list in the Select a Data File window. The selected .cla
file is converted to a .gxd file, and the new .gxd file is
imported into the open workspace. The new .gxd data file is
saved in the same folder as the original .cla file. Any
changes are saved to the .gxd file. The .cla file cannot be
changed.

NOTE
|

After the .cla file is converted to a .gxd file, use the .gxd file in any
workspaces. Re-importing the same .cla file will overwrite the
existing .gxd file and any analysis changes saved in the .gxd file will
be lost.

4 If desired, right-click the data file name in the Plate View or
Plate List and select Rename Plate to change the name of the
plate in the display. (If desired, select the Rename File to
Match check box to change the name of the data file.)

5 Select the desired wells to view in each collection in the
workspace (see page 38).

6 See Modifying Analysis Parameters on page 64 for information
about changing analysis parameters.
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Adding a Collection to a Workspace
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Collections are used to specify the wells selected for view in each
plate data file, the layout of the views in the Collection tab, and the
display properties for each view in each collection.

To add a new collection to an open workspace:

1 On the menu bar, select Collection 2 New Collection. The
New Collection Window opens.

2 Select the desired option for creating the new collection:

+ Template - Opens a new collection with the same settings
as a saved collection template file.

* Blank Collection - Opens a new template using the default
collection settings.

* Current Collection - Opens a new template based on the
current settings in the currently open collection.

3 If no plates are open in the collection, choose the desired Assay
Type for the collection: DNA, Protein, RNA, Glycan, CZE, or
gDNA. Only data files from the selected assay type can be
imported into the workspace.

4 |If desired, type a new name for the collection in the name text
box.

5 Click the OK button to open the new collection.
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Selecting the Wells in a Collection

Each collection can display different wells or the same wells in
different orders. To select the wells to display in a collection:
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1 Select the collection where the wells will be displayed.

2 In the plate diagram in the Plate View, select the wells to
display:
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Figure 18. Selecting Wells

Select individual wells: click the well.

Select a block of wells: click the well in one corner and
drag to the opposite corner well.

Select an entire row: click the row letter at the left.

Select an entire row and the corresponding
ladder/standards: click the row letter at the right (if the
plate sip order is row-wise).

Select an entire column: click the column number at the
top.

Select an entire column and any corresponding
ladder/standards: click the column number at the bottom (if
the plate sip order is column-wise).

Select all the wells by rows: click the button aligned with
the plate column numbers in the top left corner of the
microplate.

Select all the wells by columns: click the button on the top
right corner of the microplate.

Select all ladder/standard wells and microplate wells:
click the button in the bottom right corner of the microplate.
Select individual ladders/standards: click the
ladder/standard well. Clicking a Standard well for NAQuant
NGS assays selects the first of the eight standards.

Clear individual ladders/standards: right-click the well and
select Remove Ladder or Remove Standard.
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Selecting the Wells in a Collection (Continued)

« Select all ladder/standard wells: click the “L” icon at the
top left corner of the microplate.

+ Clear individual wells: right-click on the well and select
Remove Well.

3 Save the workspace to save the wells selected in the collection.

Using Sample Names Files
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Sample Names files are used to import sample names into a data
file in the LabChip GX Reviewer software. The Sample Name file

can also contain expected peaks or for NAQuant NGS assays can
contain Size and Dilution factors.

After the run is complete, you can use the Sample Name Editor
Window to rename the samples or to import an existing sample
name file. Sample Name files are saved as .CSV files and can be
edited with a spreadsheet program such as Microsoft® Excel.

The Color, Name, and Display Property for an Expected Peak
cannot be set in the Sample Name Editor window. When new
Expected Peaks are created in the Sample Name Editor window,
default values are assigned for these properties.

This section contains:

» Creating a Sample Names File on page 40

* Importing a Sample Names File into a Data File on page 40

+ Sample Name File Format (.CSV Format) on page 41

* Applying Different Window Values to Expected Peaks of the
Same Size in Different Wells on page 42

* Sample Name File Import Errors on page 42
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Creating a Sample Names File

To create a Sample Names file to specify the sample names,
comments, and Expected Peaks:

1

Select Tools > Sample Name Editor on the LabChip GX
Reviewer Main Window. The Sample Name Editor Window
opens.

Modify the sample names as desired in the Sample Name
column.

Enter any desired comments for the samples in the User
Comment column.

For DNA, gDNA, Protein, or Glycan assays, if desired, click the
Edit Expected Peaks check box and enter the desired Expected
Peaks and Window (%) in the columns. Separate each peak
size or window value with a semi-colon (;). If only one Window
% value is entered, the same value applies to all expected
peaks. If multiple values are entered, separated by semi-colons,
each expected peak will use the corresponding Window value. If
more expected peaks are entered than Window values, the last
Window applies to all remaining expected peaks in the list.

For NAQuant assays, if desired, click the Add Size and/or the
Add Dilution check boxes to display the Size and Dilution
columns. Type the appropriate Size and Dilution factor into the
row for each sample. (Current concentration x Dilution Factor =
original concentration)

Click the Export button, navigate to the desired location for the
file, type the desired name for the file, and click the Save button.

Importing a Sample Names File into a Data File

To import the sample names into a data file:

1

PN CLS151165 Rev H

Open the data file in an open workspace in the LabChip GX
Reviewer Main Window.

Select Tools 2> Sample Name Editor. The Sample Name
Editor Window opens.

Click the Import button, navigate to the file location, select the
name of the CSV file that contains the sample names, and click
the Open button.
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If a Sample Names file is imported into the Sample Name Editor
window, rows are added for any wells that are not listed in the
original Sample Names file. All wells are included in the new
Sample Names file.

4 Click the Apply button in the Sample Name Editor window to
apply the sample names to the active plate.

Sample Name File Format (.CSV Format)
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The Sample Names created in the Sample Name Editor Window
can be exported to a CSV file. A CSV file can also be created in
Microsoft® Excel or generated automatically with a LIMS to import
the Sample Names into the data file. Figure 19 shows a Sample
Names file open in Microsoft® Excel.

&4 sampletames. cev -|Of %

. A | B C ] E F —_—
[ I adder 200,300,50 1055 E
[ 2 |22 Phidi74 BsuRl 200,300 105
3 A3 Bilank 200,300,580 1055

[ 4 |4 Ladder 200,300 105

|5 25 Phixi74 BsuRl 200,300 105

| & 45 Blank 200300 105

7 a7 Ladder 200300 105

| 8 Phix174 BsuRl 200300 105 =
|v|'”‘vllu:I u\gm?ﬁamsf w;‘.ﬂlq = [ [

Figure 19. Sample Name CSV File

A Sample Name CSV file must use the following format:

Column A: The well label (A1 to P24). The wells labels can be
entered in any order and do not need to cover the entire plate.

Column B: The desired sample name for each well.
Column C: A user comment to be added to the well properties.

Column D: A list of Expected Peak sizes for the well. This list is
separated by semi-colons (;).

Column E: The search window size for each Expected Peak in
column D as a % (10 = +/-10% of Expected Peak size). If all
Expected Peaks use the same window size, enter a single value;
otherwise enter unique values as a semicolon separated list. If
fewer windows than EPs are entered, the last window applies to all
remaining EPs in the list.

Column F: The dsDNA Size in BP, for NAQuant NGS assays
(optional).

Column G: The dilution factor, for NAQuant NGS assays (optional).
(Current concentration x Dilution Factor = original concentration)

Column H... Any higher columns are ignored.
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Applying Different Window Values to Expected Peaks of the
Same Size in Different Wells

Only one Expected Peak of a particular size can exist in the assay
analysis settings. If the same Expected Peak size with a different
Expected Peak window is entered in the Sample Name Editor
window, only the first Expected Peak is created. All other Expected
Peaks of the same size use the same window as the first Expected
Peak. To overcome this restriction, use Expected Peaks of slightly
different sizes; e.g. 200, 200.1, 200.2, etc. to apply different
windows to the same Expected Peak in different wells.

Sample Name File Import Errors
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Any row in the CSV file that does not match the expected format
and cannot be interpreted is ignored. If none of the rows can be
interpreted, usually because the first column does not contain the
well label, the following error message displays: “No rows found
matching format: label, name, comment, EP, window.”
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Using Expected Fragments/ Expected Proteins/
Expected Glycans

You can track expected DNA fragments (EFs), proteins (EPs),
Glycans (EGs), or peaks (EPs) for the samples in a DNA, gDNA,
Protein, Glycan, or Protein Charge Variant assay, respectively. You
enter the EFs, EPs, and EGs in the Assay Analysis Window.

This section contains:

* Entering EFs, EPs, or EGs in the Assay Analysis Window on
page 43

* Exporting EFs, EPs, or EGs on page 44

* Importing EFs, EPs, or EGs on page 45

* Forcing Expected Peaks on page 45

* Viewing the EFs/EPs/EGs in the Graph View on page 46
* Viewing the EFs/EPs/EGs in the Gel View on page 47

* Viewing the EFs/EPs/EGs in the Well Table on page 47
* Viewing the EFs/EPs/EGs in the Peak Table on page 48

Entering EFs, EPs, or EGs in the Assay Analysis Window
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1 Select Analysis > Analysis Settings on the Menu Bar. The
Assay Analysis Window opens.

2 Click on the Expected Fragments/Proteins/Glycans Tab.
3 Click in the bottom (empty) row in the table.

4 In the Size column, type the size of the expected fragment (bp
for DNA or kb for gDNA), protein (kDa), or glycan (CGU).

5 For CZE assays, type the time of the expected peak, in
seconds, in the Time Column.

6 In the Window (%) column, if desired, change the tolerance
value to allow for variations in the expected fragment/protein/
glycan size or peak time. This value is specified as a percent of
the expected size for that fragment/protein/glycan or time for a
peak. The default is 10% for DNA, protein, and CZE, and 2.5%
for Glycan.

Note: If there are multiple peaks in the tolerance range, the
largest peak is labeled as the expected peak, even if it is not the
exact size specified. To change the peak identified as an
expected peak, see Forcing Expected Peaks on page 45.
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Entering EFs, EPs, or EGs in the Assay Analysis Window

(Continued)

10

11

12

13

A default color is automatically assigned. To change the color,
click the color in the Color column and select the desired color
in the Color window.

If desired, change the name shown in the name column.

If desired, change the Property Displayed in the Well Table.
This setting specifies the property that will be displayed in the
Expected Peak column for each expected peak listed in the Well
Table View.

To align the data to one or more specific peaks, select the For
Aligning check box. The data is realigned so the selected
peaks match their aligned size. Note: Incorrect alignment
settings can cause analysis errors.

To apply the expected peak only to specific wells, click in the
Apply to Wells column. The Select Wells window opens. Click
(or click and drag) to select the wells that you want to apply the
expected peaks to, and then click the OK button.

To apply the EFs, EPs, or EGs to the active plate, click the
Apply button.

To apply the EFs, EPs, or EGs to all plates in the workspace,
click the Apply Global button.

Note: To delete a row, click to select the row and then press the
Delete button.

Exporting EFs,

1
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EPs, or EGs

After the EFs, EPs, or EGs are entered in the Expected
Fragments/Proteins/Glycans Tab, click the Export button at the
bottom of the window. The Export Expected
Fragments/Proteins/Glycans Window opens.

Navigate to the desired location for the file, type the desired
name for the file in the File Name text box, and then click the
Save button. A GEP file is created to save the expected peak
settings.
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Importing EFs, EPs, or EGs

After an Expected Peak file (*.GEP) has been exported, you can
import the settings into another plate or workspace.

1 With the plate open in a workspace, in the Expected
Fragments/Proteins/Glycans Tab, click the Import button at the
bottom of the window. The Import Expected
Fragments/Proteins/Glycan Table window opens.

2 Navigate to the location of the file, select the name of the file to
import, and then click the Open button. The expected peak
settings are imported into the tab.

3 To apply the EFs, EPs, or EGs to the active plate, click the
Apply button.

4 To apply the EFs, EPs, or EGs to all plates in the workspace,
click the Apply Global button.

Forcing Expected Peaks

If there are multiple peaks in the tolerance range, the largest peak
is labeled as the expected peak, even if it is not the exact size
specified. If a different nearby peak should have been selected as
the expected peak, you can specify which peak is labeled the
expected peak.

1 Inthe Graph View, right-click on the peak that should be labeled
as the expected peak.

2 On the shortcut menu, select Force Expected Fragment/Peak
and then select the desired fragment or peak from the menu.

3 For AAV Empty/Full assays, you can choose whether each peak
is a Partial peak or an ssDNA peak by selecting the desired
peak type under Force Expected Fragment.

To clear a forced peak and revert to the default expected peak,
right-click on the forced expected peak and select Clear Forced
EP.
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Viewing the EFs/EPs/EGs in the Graph View

Expected Fragments, Expected Proteins, and Expected
Glycans are identified in the electropherogram by open triangles
over the peaks. The triangles are the same color as specified in the
Expected Fragments/Proteins/Glycans Tab.

To display the expected peak indicators in the Graph view:

1 Click the Properties tab on the right side of the Graph view to
open the Graph View Properties.

2 To view the size of all expected peaks, select Expected
Fragments, Expected Proteins, or Expected Glycan in one of
the Annotation list boxes.
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Figure 20. Expected Fragments
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Viewing the EFs/EPs/EGs in the Gel View

Expected Fragments/Proteins/Glycans are indicated in the Gel
View by colored lines. The color of the line matches the color
specified in the Expected Fragments/Proteins/Glycans Tab.

To display the expected peaks in the Gel View:

1 Click the Properties tab on the right side of the Gel View to
open the Gel View Properties.

2 Select the Show Expected Peaks check box.

To display the legend that identifies the colors and sizes of the
expected peaks:

1 Click the Properties tab on the right side of the Gel View to
open the Gel View Properties.

2 Select the Show Expected Peaks Legend check box.

Well Table 7 Peak Table ' Fiter ¥ Gel ||

m— | 100
L300
— | 500
L700
L1100
— 1300
L2500
L4500 F—
m— EPT2 T
EP118 e
m— EF154
— P34
EF271
— EPI81

Figu;é”22. Expected Peaks Legend
Viewing the EFs/EPs/EGs in the Well Table

A column is added to the Well Table for each Expected Peak
entered in the Expected Fragments/Proteins/Glycans Tab. The
column displays the property selected in the Property Displayed in
Well Table list in the Assay Analysis Window.

114 Ladder
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FhiX174/B...
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Viewing the EFs/EPs/EGs in the Peak Table
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Expected Fragments, Expected Proteins, and Expected
Glycans are identified in the Peak Table with the peak name
displayed in the Type column.

Well Sample T Size
Label Name e BP
I
ADT |Ladder  [L100 | 100
A0 lsdder L300 | 289
A1 |Ladder  |1500 | 498
| AD1 |Ladder  |L700 | 698
A01 | Ladder [L1100 | 1091
AO1Lsdder L1500 | 1875

Conc.
{ngAul)

1.24 |
119
14|
111
1.15|
108

Figure 23. DNA Assay Peak Table
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Using Filters

Filters are used to select the wells included in a collection based on
specific criteria specified in each filter. The types of filters available
depend on the type of data in the workspace. Each filter is available
in all collections in the workspace. Each collection can contain
unique combinations of filters. Well and filter selections are specific
to each collection if the workspace contains multiple collections.
This section contains:

* Creating a New Filter

» Selecting Filters in a Collection

* Well Colors in a Filtered Collection

» Searching Data Files Using a Filter

» Filter Example for Expected Peaks
Creating a New Filter

The filter specifies the criteria that determines whether a well is
included in the current collection. Filters can be turned on and off to
change the wells selected in a collection.

To create a new filter:
1 Open the data files that you want to filter.
2 Click the Filter View tab.

3 Select the desired wells to apply the filter to in the Filter Plate
diagram. The Filter Plate diagram always displays a 384-well
plate. For 96-well plates, any wells selected outside the 96-well
plate boundaries are ignored.

! Wel Table ¥ Pesk Table ¥ Filter M

Select wells to apply fitter:
Quadrart Select

a1 @a2
[C] Ladder(s)
[ Rek [ Rerd
=
n
Filter Options:
© OR O ANDPeak) () AND(Wel)

Figure 24. Selecting Wells to Apply Filter
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Creating a New Filter (Continued)
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a To select or clear quadrants, select or clear the Quadrant
Select check boxes.

b To include or exclude ladder wells, select of clear the
Ladder(s) check box.

¢ To select all wells in the plate, click the Select All Rows
button in the upper right corner of the Filter Plate Diagram.

d To select or clear specific wells or columns, click the row
letter or column number in the Filter Plate diagram.

In the Type drop-down list, select the desired filter type. The
filter types available depend on the assay that was used to
create the data file.

If desired, click the Color button to the right of the Type drop-
down list and select the desired color for the filter. Any wells
selected by the filter display the filter color in the Plate View or
List View. (See Well Colors in a Filtered Collection on page 52
for more information.)

Select the desired filter criteria. Numeric value operators are
equal to (with percent threshold), between, less than, or greater
than. Text expressions can contain wild cards. Expected Peaks
criteria specify expected peaks in a well.

Click the Add button. The filter is added to the Available Filters
list box and is selected by default. The Plate View displays the
selected wells.

If multiple filters are selected, select the desired Filter Options:
OR, AND(Peak), or AND(Well). (See Selecting Filters in a
Collection for more information.)
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Selecting Filters in a Collection

The Available Filters list box displays all of the filters that are part
of the current workspace. The check box next to each filter in the
list is used to include or exclude that filter from the analysis for the
current collection. Each collection in a workspace can have a
different filter selection.

1 If the workspace contains more than one collection, click a
collection tab to select the desired collection.

2 Open the data files that you want to filter.

3 In the Available Filters list box, select or clear the check box
next to a filter to enable or disable the desired filters.

~Mvailable fitters:

W Expected Peaks: 100210%
] Expected Peaks: 300=10%

=

Figure 25. Selected Filters

4 Select the desired Filter Options to determine how multiple
filters are logically combined. The options available are OR,
AND(Peak), and AND(Well). See Well Colors in a Filtered
Collection on page 52 for information about well colors.

* OR - Selects any well that contains a peak that matches any
of the filters selected in the Available Filters list.

+ AND(Peak) - Selects any well that contains a single peak
that matches all of the filters selected in the Available Filters
list.

* AND(Well) - Selects any well that contains peaks that match
all of the filters selected in the Available Filters list. Different
peaks in the same well can match different filters, as long as
all filter conditions are met in the same well.
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Well Colors in a Filtered Collection

The wells selected in a collection by a filter are color-coded in the
Plate View and the Gel View to indicate which wells are selected by
each filter. By designating a different color for each filter when using

the OR filter option, the color indicates which wells meet which filter
criteria.

If a well is selected by more than one filter, the well color is a
combination of the filter colors. If a well is selected by both a yellow
filter and a red filter, the well is colored orange. In the Plate diagram
in Figure 26, the orange and yellow wells are the wells that meet
the filter criteria. White wells are not selected. Gray wells were not
run.

[1] (READ ONLY) Demo DNA 5K 96 wells

Jl 234567889 101112|||||
......I.....

e t;gii++++++"
© 4% OISO
:ooo ’ol:"ooo

mrmvmvnw

Figure 26. Plate View with Filters

The Gel View in Figure 27 shows the expected peaks marked with
colored lines on the Gel view. The well header is yellow if the well
meets the filter criteria for the yellow filter, and orange if it meets the
filter criteria for both the yellow and red filters. The filter option is
OR so that any well meeting either or both of the filters are
selected.

| el Tabie ¥ peakTabe [ Fiter ¥ Gel
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Figure 27. Gel View with Filters
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Searching Data Files Using a Filter
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When using filters, the normal process is to load all the desired data
files, and then apply the filter to select the desired wells in the
plates. If the exact data files that contain the wells are unknown, or
if there is a large number of data files, you can use the Search Data
Files feature to search a specified folder for plate data files that
contain wells that match the filter criteria. As the matching wells are
located, only the data files with matching wells are loaded into the
workspace.

To search the data files using a filter:

1
2

Open at least one data file in the workspace.

Create the desired filters in the workspace (see Creating a New
Filter on page 49).

Click the Search Data Files button in the Filter View. The
Search for Plates Matching Filter window opens as shown in
Figure 28.

Search for Plates Matching Filter

Select Search Folder

C:\Program Files (x86)\Revvity\LabChip GX Reviewer\Data
[[] Search subfolders 0 data files found -
Looking for:

% Purity: value = 10 £ 10%

Figure 28. Search for Plates Matching Filter Window

4

Either type the desired path to the data file folder in the Select
Search Folder text box, or click the Browse button and select
the desired data file folder. The number of data files in the
selected folder and subfolders displays in the window.

To search data files in subfolders of the selected folder, select
the Search Subfolders check box. If not selected, only data
files saved in the specified folder are searched. Subfolders of
the specified folder are not searched.

Click the Begin Search button. The Plate Search Progress
window displays the progress of the search.

As plates with matching wells are found, the plates are added to
the workspace. The wells that match the filter criteria are
selected in the current collection.
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Filter Example for Expected Peaks
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Figure 29 shows a single Expected Peaks filter that includes three
expected peaks: 100 +/- 10%, 300 +/- 10%, and 500 +/- 10%, with
each expected peak size identified by a different color. This filter will
select any wells that contain all three expected peaks: 100, 300,
AND 500. The wells selected by this filter are colored orange in the
Plate View or the Gel View. Note that the filter is selected (checked)
under Available Filters, indicating that the filter is being applied to
the data.

Aor e Fillieers

B Epectad Peakos: 100210 30010, 500100

T | Expectod Pasks ~ G
Sipe Windc o Property Displayed  For Apphy,
EP] [ (ool Neme e Tabie Abgring Vel

* m 10 - EPE] wl [0 <l
30 |10 EF131 wl [0 |as
50 |10 -EF1.‘-EE~ wl O |ab

<] >

Figure 29. Expected Peaks Filter with Three Peaks

To select wells that contain any of the three peaks, create a
separate filter for each peak as shown in Figure 30 and select the

OR option.

A bl Tl

]
[+] Epected Peaks: 300210%
[] Boected Peaks- 500=10%

Figure 30. Three Separate Expected Peaks Filters

When using multiple filters that include peak properties, if
AND(Peak) is selected, a single peak in the well must meet all
selected filter properties. See the examples below, which each use

two filters:
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Filter Example for Expected Peaks (Continued)
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Height > 100 AND(Peak) Conc > 50 selects any well that
contains a single peak that meets both criteria.

Height > 50 AND(Well) Conc > 50 selects any well that contains
a peak with height greater than 50 and a peak with
concentration greater than 50. (The peaks do not have to be the
same peak.)

Height >100 OR Conc > 50 selects any well that contains any
peak that meets either (or both) criteria.

Height >100 AND(Peak) Height <50 does not select any wells
because no peak can have a height that is both less than 50 and
greater than 100. Use OR to select wells that contain peaks that
match either criteria. Use AND(Well) to select wells that contain
peaks that each match a single criteria.

Expected Peak Filters can contain multiple size peaks in the same
filter as shown in Figure 29. Expected Peak filters with multiple
peak sizes in the same filter always select only wells that contain all
the peaks listed.
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Using Replicates

Replicates define wells on a plate that contain the same sample.
Since all replicates should contain the same peaks, replicates can
be used to identify erroneous peaks caused by signal noise over
baseline fluctuations. The identified erroneous peaks can be
excluded to remove them from the %Purity calculation. (Not
supported for NAQuant NGS assays.)

Replicates can also be used to improve measurement accuracy and
assess variability within a measurement. To use replicates:

1 Define the replicate wells (see Defining Replicates).

2 If automatic peak exclusion is desired, select the desired
Exclude Peak when Missing in Replicate Option (see page 59).

3 If replicates are being used to improve measurement accuracy
by averaging, print a replicate report (see page 60).

Defining Replicates

Before excluding a peak from replicate wells using the Excluded
Peaks Tab, the replicate wells must be defined in the Replicates
Tab. Replicates can be defined as part of the assay or after the run
in the assay analysis settings.

To open the Replicates tab:

» For an existing data file, open the data file in a workspace.
Select Analysis > Analysis Settings. The Assay Analysis
Window opens. Click the Replicates Tab.

* In an assay file, select Tools > Assay Editor. The Select
Assay To Edit window (or CDR Manager window for GxP
instruments) opens. Select the assay that you want to add the
replicates to and click the Open or Import button. The Assay
Analysis window opens. Click the Replicates Tab.

To define the replicates:

1 Select the wells that all contain the same sample. Click and drag
to select contiguous wells. Shift + click or Shift + click and drag
to add additional wells. To select the rows shown in Figure 31 on
page 57, click on well A1 and drag to well B6.
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Defining Replicates (Continued)

Assay Info  Mlignment  Analysis Peak Find Expected Fragments Excluded Fragments Smear Analysis Titer  Replicates  Advanced
§|123456739101112

.

.c . Across
DO @
R I
e
elelsle/e0 000000

Figure 31. Wells Selected for Replicate Set

Edit
Names...

Add

2 Click the Add button to create a replicate set. Each of the
selected wells is marked with the same number to indicate that
the wells contain the same sample as shown in Figure 32.

Assay Infa  Alignment Analysis Peak Find Expected Fragmerts Excluded Fragments Smear Analysis Tter ~ Replicates  Advanced

%123456789101112

Figure 32. Replicate Set Added

3 If the replicates use a common pattern, click any well in a
replicate set and then click the Copy Down or Copy Across
buttons to copy the defined pattern across the rows or down the
columns.

To create the pattern in Figure 33 on page 58, click any well
marked with the number “1” and then click the Copy Across
button.
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Defining Replicates (Continued)

Assay Info  Mignment Analysis Peak Find Expected Fragments Excluded Fragments Smear Analysis Titer  Replicates  Advanced

W2 20000
ialelelalaletalatelele
OIS
OIS

G

Figure 33. Copy Across

To create the pattern in Figure 34, click any well marked with the
number “1” and then click the Copy Down button.

AssayInfo  Alignment Analysie Peak Find Expected Fragments Excluded Fragments Smear Analysis Tier  Replicates  Advanced

‘%123456789101112

Figure 34. Copy Down

4 To rename a default replicate name, click the Edit Names
button. The Replicate Name Editor window opens. Type the
desired replicate name over the default name and click the OK
button.

5 To delete a single replicate set, click any well marked in the
replicate set and then click the Delete button.

6 To clear all selections and replicate sets on the plate, click the
Clear button below the plate diagram.
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Defining Replicates (Continued)

7

To copy a replicate definition to another plate:

Click the Export button. The Export Replicates Table
window opens.

Type the desired replicate export file name and click the
Save button.

Click the OK button or Cancel button on the Replicates Tab
to exit the Assay Analysis Window.

Select another plate in Workspace or select File > Import
Data File to add another plate.

Select Analysis - Analysis Settings to open the Assay
Analysis Window, and then click the Replicates Tab.

Click the Import button to import the saved exported file.

Selecting the Exclude Peak when Missing in Replicate Option
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After creating the desired replicates on the Replicates tab (see
Defining Replicates on page 56):

1
2

Click the Excluded Peaks Tab on the Assay Analysis window.

Select the desired Excluded Peaks option:

Disabled - No peaks will be excluded based on the
replicates.

Any - A peak is excluded if it is not found in ANY of the other
wells in the replicate set.

All - A peak is excluded if it is not found in ALL of the other
wells in the replicate set.

Note: If a replicate set only contains two wells, the Any and All
options produce the same results.
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Printing Replicate Reports
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After creating the desired replicates on the Replicates tab (see
page 56), replicate reports can be printed to a printer or to a PDF
file (if desired). See Print Replicate Report on page 101 for an
example of a replicate report.

To print a replicate report:

1 Select File & Print from the Menu Bar. The Print Window
opens.

2 Click the Print Replicate Reports button. The Replicate Report
Generator Window opens.

3 For each desired Replicate Report, complete Step 4 to Step 8
below create a replicate report definition.

4 Type the desired title into the Report Title column.

5 Select a well property to be analyzed from the Property drop-
down menu.

NOTE

|

The Property drop-down menu lists well properties only. To analyze
peak properties, convert the peak properties into well properties
using the existing Expected Peak mechanism (see Entering EFs,
EPs, or EGs in the Assay Analysis Window on page 43).

6 Double-click inside the Replicates column to select the
replicate wells to be analyzed (see Figure 35 on page 61).
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Printing Replicate Reports (Continued)
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Figure 35. Select Replicates for Report

Use the default “<all>” value in the Replicates column to
analyze all replicate sets defined for the plate (as described
in Defining Replicates on page 56).

7 To exclude a well from the replicate set due to an anomaly in the
well, click the Exclude Wells button. The Select Wells to
Exclude from Replicate averaging window opens (see
Figure 36). Select the wells not to use in the statistical analysis.
These wells appear in the report, but with strike-though values
to indicate they are not included in the statistics.

Selact Wells to Exclude from Replicate averaging

%123456?89101112

[10,0,0.,0.0.0.0.0.0,
0.0.0;

10,060,060,
cO
DO 9.0.0,
B
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HOO
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Figure 36. Select Wells to Exclude from the Replicate
averaging
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Printing Replicate Reports (Continued)

8 To add Custom Columns to enhance the Replicate Report
(optional):

a Double-click inside the Custom Columns field of the report.
The Replicate Equation Editor Window opens.

b Type the desired Custom Column title into the Title column.

¢ Select the Check Box? column to add a check box custom
column. If the result of the equation set in the Equation to
Evaluate column is true, the check box in the check box
column is selected in the replicate report. If the result of the
equation is false, the check box is not selected.

d Enter the annotations for the equation to evaluate in the
Replicate Report manually or automatically:

NOTE
|

Separate multiple annotations for the equation with a semicolon [;].

Manually

— Click the Annotate Results button on the Replicate
Report Generator Window. The replicate report displays
in table format.

— Type the desired annotations into the empty field in the
table.

— Edit any other fields as desired.

Automatically

— Double-click inside the Equation to Evaluate field in the
Replicate Equation Editor Window.

— Select the options above the table in the Replicate
Equation Editor Window to add the desired annotations
to apply to the equation to evaluate, including Mean,
StdDev, CV, a specific replicate property from the
Replicate Selector Drop-Down List, +, -, *, /, <, >, <=,
>=, And, Or, (, ), and/or a specific number from the
Insert Number text box.

— Click the OK button.

— If desired, click the Annotate Results button to preview
the report in table format and edit any of the fields as
desired.
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Printing Replicate Reports (Continued)
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NOTE
|

If you are familiar with the equation syntax, you can bypass the
function buttons and type the desired equation directly into the
Equation to Evaluate column, or use the manual method above.

9 Select the Select check box on the Replicate Report Generator
Window table to add the selected equation to the Replicate
Report.

10 Click the Print Preview button to view a preview of the
Replicate Report.

11 Click the Print To PDF button to print the Replicate Report as a
PDF file.

12 Click the Print button to print the Replicate Report to a printer.
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Modifying Analysis Parameters
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Some analysis parameters can be changed in the software to
modify the data evaluation for sample analysis. The following
procedures are included in this section:

Changing the Peak Find Parameters on page 65
Adding a Peak on page 66

Manually Excluding a Peak on page 66

Splitting a Peak on page 67

Merging Two or More Peaks on page 67

Removing a Peak Merge on page 69

Adjusting the Peak Baseline on page 69

Setting the Baseline for a Range of Peaks on page 70
Removing a Manual Baseline on page 70

Selecting a Default Ladder on page 71

Using the Default Ladder for Alignment on page 72
Exporting the Default Ladder in an Assay on page 72
Clearing the Default Ladder in a Plate on page 73
Changing the Time Window for Analysis on page 73

These settings can be changed after the run is complete or when
reanalyzing a previously saved data file.

(Analysis Parameters are not supported for NAQuant NGS assays.
See How the Software Analyzes NAQuant NGS Data for more
information. Analysis Parameters are not supported for AAV DN
DNA assays and AAV Pico Protein assays. See How the Software
Analyzes AAV Empty/Full Data for more information.)
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Changing the Peak Find Parameters
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After data filtering, the peak find algorithm locates the peaks and
calculates the local peak baselines. The algorithm begins by finding
all the peaks above the noise threshold to determine the baseline,
after which any peaks below the noise threshold are rejected. A
local baseline is calculated for each peak to allow for baseline drift.

The following Peak Find parameters can be changed:

Min Peak Height
Min Peak Width
Slope Threshold
Inflection Threshold
Start Time

End Time

Filter Width
Baseline Plateau

To change the Peak Find parameters for all wells:

1

Select Analysis > Analysis Settings to open the Assay
Analysis Window, and then click the Peak Find Tab.

Change the parameters as necessary at the top of the window.

Click the OK button to save the setting, reanalyze the data, and
close the window.

Click the Apply button to apply the changes and reanalyze the
data, but keep the Assay Analysis window open.

Click the Apply Global button the apply the settings to all plates
in the workspace and reanalyze the data, but keep the Assay
Analysis window open.

To change peak find settings for individual wells:

1

Select Analysis 2> Analysis Settings to open the Assay
Analysis Window, and then click the Peak Find Tab.

In the Well drop-down list, select the well number that you want
to change the settings for.

Change the settings at the bottom of the window under Well
Peak Find Settings to change the settings for the selected well.

Click the OK button to save the setting, reanalyze the data, and
close the window.

Click the Apply button to apply the changes and reanalyze the
data, but keep the Assay Analysis window open.
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Adding a Peak

You can manually add a peak in a region where a peak has not
been identified.

1 In the Graph View, right-click at the top of the area where the
peak is to be added. The area must be outside any previously
identified peak and the cursor must be an up arrow.

2 Select Add Manual Peak from the shortcut menu. A new peak
centered at the selected location is created.

3 If necessary, adjust the Peak Baseline.
Manually Excluding a Peak

You can manually exclude any peak or fragment from being used in
the analysis. (To exclude specific peaks sizes, use the Excluded
Peaks Tab.)

To manually exclude a peak:
1 In the Peak Table View, right-click on the peak to be excluded.

2 Select Exclude Peak from the shortcut menu. The Type for the
peak changes to X (excluded), and the value is not used in the
analysis.

3 Right-click on an Excluded Peak in the peak table and select
Include Peak to include the peak in the data analysis.

OR

1 In the Graph View, right-click near the top of the peak to be
excluded.

2 Select Exclude Peak from the shortcut menu. The Type for the
peak changes to X (excluded), and the value is not used in the
analysis.

3 Right-click on an Excluded Peak in the Graph view and select
Include Peak to include the peak in the data analysis.
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Splitting a Peak

If two poorly resolved peaks have been identified as a single peak,
you can split the single peak into two separate peaks.

1 In the Graph View, zoom in as necessary to view the single
peak. See Zoom In and Zoom Out on page 85.

2 Position the cursor inside the peak at the horizontal location
where you want to split the peak. (The Split Peak option is not
available if the cursor is an up arrow. Move the cursor until the
peak is not selected.)

2780
EP2780

\

N

Unzoom

Unzoom All

Set Scale ..

Scale To Sample Peaks

18 EA[.}I - Manual Baseline or <SHIFT> + LEUTTON
igned Time (s Merge Peaks or <ALT> + LBUTTON

ﬁ Copy

il Split Peak

< lm - o = & Analysis Settings...

F]gure 37. Splitting a Peak

3 Right-click on the graph and select Split Peak on the shortcut
menu. A new Manual Peak is created abutting the original peak.

Merging Two or More Peaks

If the analysis has split a single peak into multiple peaks due to
undulations in the shoulders or craters in the peak, these adjacent
peaks can be merged into a single peak. The tallest of the selected
peaks becomes the identified peak with its extends expanded to
encompass the merged peaks. The tallest peak has the area,
concentration, and %purity of the merged collective. The other
peaks appear as excluded peaks in the peak table and no longer
contribute to %purity.

To merge two or more adjacent peaks:

1 In the Graph View, zoom in as necessary to view the peaks to
be merged. See Zoom In and Zoom Out on page 85.
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Merging Two or More Peaks (Continued)

2 Hold down the ALT key + Left Mouse button while performing
the bullet steps below:

OR

Right-click on the graph and select Merge Peaks from the drop-
down menu, and perform the bullet steps below:

* Click the Mouse inside the peak furthest to the left to be
merged.

» Drag the Mouse to the peak further to the right to be merged.
A green line displays on the graph tracking the start and end

points.
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Figure 38. Start and End Points of Peak Merge
* Release the Mouse. All peaks within the start and end points
are merged into a single peak. An X displays above the

smaller peak indicating it has been excluded to allow the
main peak to extend across it.
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Figure 39. Resulting Merged Peak

NOTE
|

°

If Merge Peaks from the drop-down was used to merge the peaks,
right-click on the graph and select Merge Peaks to exit Merge Peak
mode. This step is not necessary if the ALT key + Left Mouse button
was used to merge the peaks.
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Removing a Peak Merge

To remove a peak merge:

1 Right-click on the baseline of the merged peak.

2 Select Reset to Analyzed Base from the shortcut menu.
Excluded peaks inside the extended baseline of the merged
peak will be included. Baseline adjustments made prior to the
merge will also be undone.

NOTES

If multiple electropherograms overlaid in the graph view were
merged, removing these merges requires the undo function on each
electropherogram.

Adjusting the Peak Baseline

The Peak Baseline can be manually adjusted in the Graph View.

1

In the Graph View, zoom in on the peak baseline as described in
Zoom In and Zoom Out on page 85. (If the peak baselines are
not displayed, select Show Peak Baselines in the Graph View
Properties to display the baseline for each peak.)

Click the triangle at one end of the peak baseline and drag to
the desired location.

To reset the baseline to the original position, right-click near the
baseline end point and choose Reset to Defaults.

Moving the Baseline in only the X-Direction or Y-Direction

1
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Press and hold the X key on the keyboard, click on the baseline
endpoint that requires editing, and then drag left or right to move
the baseline endpoint. The baseline endpoint moves only on the
X-axis (left/right).

Press and hold the Y key on the keyboard, click on the baseline
endpoint that requires editing, and then drag up or down to
move the baseline endpoint. The baseline endpoint moves only
on the Y-axis (up/down).
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Setting the Baseline for a Range of Peaks

A straight line can be drawn under multiple peaks to create a single
baseline for all peaks above the straight line.

To draw a single baseline:

1 Inthe Graph View, zoom in on the peaks s described in Zoom In
and Zoom Out on page 85. (If the peak baselines are not
displayed, select Show Peak Baselines in the Graph View
Properties to display the baseline for each peak.)

2 Holding the SHIFT key, click at the point where the baseline will
begin and drag to the desired end point of the baseline.

3 Release the mouse at the end of the baseline. The baselines for
peaks that are entirely contained within the baseline span are
adjusted to the new baseline.

To draw multiple baselines using Manual Baseline mode:

1 In the Graph View, zoom in on the peaks as described in Zoom
In and Zoom Out on page 85. (If the peak baselines are not
displayed, select Show Peak Baselines in the Graph View
Properties to display the baseline for each peak.)

2 Right-click on the graph, away from a peak, and select Manual
Baseline on the shortcut menu.

3 Click and drag in the graph to draw manual baselines.

Note: Clicking and dragging in the graph does not zoom in while
Manual Baseline mode is on. Clicking and dragging in the Gel
View still zooms in when Manual Baseline mode is on.

4 To turn off Manual Baseline mode, right-click on the graph, away
from a peak, and select Manual Baseline again.

Removing a Manual Baseline

To reset a manual baseline back to the original analyzed baseline:

1 Right-click on one end of the manual baseline and select Reset
to Analyzed Base from the shortcut menu.

To reset all manual baselines:

1 Right-click on one end of a manual baseline and select Reset
All Peak Bases.

2 Click OK in the Reset All Peak Bases window.
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Selecting a Default Ladder

For DNA, gDNA, and RNA assays, a ladder in an assay can be
defined as the default ladder. The default ladder can be used as the
ladder for wells on the plate, can be applied to all of the plates in
the open collection, or can be saved as the default ladder in a new
assay.

To set a specific ladder on a plate as the default ladder for the plate:

1 With the plate data file open, select Analysis > Analysis
Settings to open the Assay Analysis Window, and then click the
Peak Find Tab.

2 Under Well Peak Find Settings, in the Well drop-down list,
select the ladder that will be defined as the default ladder.

3 Click the Save as Default Ladder button. (The Save as Default
Ladder button only displays when a ladder is selected.)

4 Click the Apply button to save the default ladder settings. The
Analysis Tab displays the ladder data in the Default Ladder table
and the Markers table (see Figure 40).

Assay Info  Alignment  Analysis  Peak Find Expected Fragments Excluded Fragments  Smear &nalysis  Titer Replicates  Advanced

| Ladder Sizes Ladder Concentration Standard Curve Dilution Cormection
| | Size [BF] © Foint to Point X 100
Ladder 1.00 ngdul T
: 100 : £ Log Buffer/Sample Dilution
| 2 ) Polynomial Fit No Dilution
| 500
Markers Data Range
4 m Conc.ng/ul  Size [BP] B
e Bassline 150 sec
| | Lower 5.00 15 -
1500 [ ——— Wel End 650 sec

Upper
2500

4500
7000
10000
20000

Figure 40. Default Ladder Settings

5 The Ladder Peak Time and Area settings can be changed in the
Default Ladder table, but default ladder peaks cannot be added
or deleted and the ladder peak sizes cannot be changed.

6 The Marker Time, Height and Area can be changed in the
Markers table.
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Selecting a Default Ladder (Continued)

7 Click the Apply button at the bottom of the window to save the

changes to the active plate. Click the Apply Global button to
apply the default ladder settings to all open data files in the
collection. (This allows you to import the default ladder into a
plate that does not include any good ladders on the plate.)

See Using the Default Ladder for Alignment on page 72 to align
wells in the plate using the default ladder.

Using the Default Ladder for Alignment

For DNA, gDNA, and RNA assays, after the default ladder is
selected for a data file, the default ladder must be assigned to the
desired wells in the plate.

1

With the plate data file open, select Analysis - Analysis
Settings to open the Assay Analysis Window, and then click the
Alignment Tab.

Select the Align Well Groups to Specified Ladder option.

For each group of wells under Align Well Group, select Default
Ladder in the To Ladder column.

Click the Apply button to apply the changes to the active data
file or click the Apply Global button to apply the changes to all
data files in the current collection.

Exporting the Default Ladder in an Assay
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The default ladder in a data file is included in the analysis settings
for a new assay when the settings are exported as an assay.
Exporting the assay enables you to use the default ladder in future
runs.

1

After clicking the Apply or Apply Global button in the Assay
Analysis Window, the Export as Assay button displays.

Click the Export as Assay button. The Export Assay Settings
from Plate to Assay File window opens.

Select the desired location for the assay file, type the desired
name for the assay file, and click the Save button.

Select the new assay in the Run Tab on the Start Run Window
when starting the next run. The new data file will include the
default ladder.
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Clearing the Default Ladder in a Plate

To delete the default ladder for a plate and return the alignment to
the ladder settings for the assay type:

1

With the plate data file open, select Analysis 2> Analysis
Settings to open the Assay Analysis Window, and then click the
Analysis Tab.

Click the Clear Default Ladder button at the bottom of the
Default Ladder table.

Changing the Time Window for Analysis
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The Start Time and End Time parameters in the Peak Find tab
define the time window within which peaks are found.

To change the Start Time and End Time parameters for all wells in
the open assay:

1

Select Analysis > Analysis Settings to open the Assay
Analysis Window, and then click the Peak Find Tab.

Change the parameters as necessary.

Click the OK button to save the setting, reanalyze the data, and
close the window.

Click the Apply button to apply the changes and reanalyze the
data, but keep the Assay Analysis window open.
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Marker Peaks

This section contains the following sections:

« Aligning or Unaligning the Marker Peaks on page 74

» Upper and Lower Marker Peaks for DNA Assays on page 75
* Lower Marker Peaks in Protein or RNA Assays on page 76

* Lower Marker Peaks in Glycan Assays on page 77

Aligning or Unaligning the Marker Peaks
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To perform data analysis for DNA, Protein, RNA, and Glycan
assays, the LabChip GX Reviewer software aligns marker peaks
included in the sample wells with markers from the ladder.

* To view the unaligned data (spike rejected, filtered and baseline
corrected), choose Analysis — Turn Off Analysis.

* To re-enable analysis, choose Analysis — Turn On Analysis.

The default setting for this function is enabled. Turning off the
analysis displays the data without aligning the markers in the wells
and the ladders.

Figure 41. Data Before and After Alignment
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Upper and Lower Marker Peaks for DNA Assays

For each DNA sample, the upper and lower marker peaks are
assigned first and then the data is aligned so that the well markers
match the ladder markers in time, allowing the size and
concentration of the sample peaks to be determined.

For DNA assays, the first peak is assigned to be the lower marker
and is then offset to match the lower marker in the ladder. The
upper marker is then assigned to the last peak in the sample well or
to the peak nearest the ladder’s upper marker. The Upper Marker
and Lower Marker are aligned to the ladder markers by resampling
the well data in a linear stretch or compression using a point-to-
point fit.

If the sample marker peaks are either more than twice as far apart
or less than half as far apart as the ladder markers, they are
assumed to be the wrong peaks, and analysis of the well stops,
producing the error Marker peaks not detected.

In DNA assays, the height of marker peaks is assay dependent.
Ladder peaks are analyzed to calculate a marker peak threshold
that is used to locate the marker peaks in the sample wells. If the
marker peaks found using this calculated method fail to align with
those of a sample, the LabChip GX Reviewer software will use the
minimum peak height threshold setting instead (if this value is lower
than the value for the marker peak). For example, the calculated
threshold might be too high to find the sample's markers if they
happen to be very small for some reason. Either no markers will be
found or the wrong peaks will be assumed to be markers and these
may not align with the ladder markers. Consequently, the software
attempts to use the minimum peak height threshold that, if it is set
low enough, will catch the real markers, allowing the sample to
align.

If you get unexpected peaks in the ladder analysis or the markers
have been set incorrectly, you can manually exclude peaks or set a
peak to be used as a marker.

NOTES
|

* Excluding a peak or manually setting a peak to be an upper or
lower marker for a DNA assay can cause errors with analysis.

*  You can move the boundary between the Peak Table and the
Graph view up or down to increase or decrease the size of the
Peak Table, making it possible to see all of the results at once.
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Upper and Lower Marker Peaks for DNA Assays (Continued)

Right-clicking in the Peak Table View of a well of a DNA assay
opens a shortcut menu with the following commands:

* Include Peak (only for peak type “?”)
* Exclude Peak

* Force Lower Marker

* Force Upper Marker

* Add Expected Peak

NOTE
|

You can also right-click on a peak in the Graph View to view the
same menu.

Lower Marker Peaks in Protein or RNA Assays
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For each protein or RNA sample, the first peak in the sample is
designated as the Lower Marker. After all lower markers are
assigned, the data is aligned so that the well markers match the
ladder markers in time, allowing the size and concentration of the
sample peaks to be determined.

If there are unexpected peaks in the ladder analysis or if the marker
has been set incorrectly, you can manually exclude peaks or set a
peak to be used as a marker.

NOTES
|

* Excluding a peak or manually setting a peak to be the lower
marker can cause analysis errors.

* You can move the boundary between the Peak Table and the
Graph view up or down to increase or decrease the size of the
Peak Table, making it possible to see all of the results at once.

Right-clicking in the Peak Table View of a well of a Protein or RNA
assay opens a shortcut menu with the following commands:

* Include Peak (only for peak type “Xsys” or “?”)

+ Exclude Peak

* Force Lower Marker

* Force Expected Peak
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Lower Marker Peaks in Glycan Assays

For each Glycan sample, the lower marker is added to the samples
and ladders. The lower marker is identified because the
concentration is much higher than the sample or ladder. After all
lower markers are assigned, the data is aligned so that the well
markers match the ladder markers in time, allowing the size and
corrected area of the sample peaks to be determined.

If there are unexpected peaks in the ladder analysis or if the marker
has been set incorrectly, you can manually exclude peaks or set a
peak to be used as a marker.

NOTES
|

* Excluding a peak or manually setting a peak to be the lower
marker can cause analysis errors.

*  You can move the boundary between the Peak Table and the
Graph view up or down to increase or decrease the size of the
Peak Table, making it possible to see all of the results at once.

Right-clicking in the Peak Table View of a well of a Glycan assay
opens a shortcut menu with the following commands:

* Include Peak (only for peak type “Xsys” or “?”)

» Exclude Peak

» Force Lower Marker

* Force Expected Peak
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Saving and Exporting Assays
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Assays are created by Revvity and are included with the LabChip
GX or GX Touch software. The instrument and software settings
used to run each plate and to analyze the plate are contained in an
assay (.asy or .asyx) file. If the default analysis settings often need
to be modified for more optimal analysis, a new assay file can be
created with the modified settings to be used on subsequent runs.

To save a modified assay:

1 Right-click on the plate title in the Plate View or Plate List, select

Export Assay, specify a name and location for the assay file,
and click the Save button.

- OR --

On the Assay Analysis Window, click the Export as Assay
button, specify a name and location for the assay file, and click
the Save button.

The procedure above can also be used to automatically include a
set of expected peaks in the assay.

If the LabChip GxP option is installed, data files are saved in the
Central Data Repository (CDR). The CDR is a secure folder that
can only be accessed by the LabChip GX Touch software and the
LabChip GX Reviewer software. The CDR can be located on the
LabChip GX Touch instrument, the LabChip Reviewer computer, or
a network server.

If the LabChip GxP option is installed and Require Signature on File
Update is selected in the Set Policies tab on the User
Administration Window, the user must have signature rights to save
an updated data file. If the data file is locked, a user with Unlock
rights must unlock the data file before changes can be saved.

To save the data file when the LabChip GxP option is installed and
Require Signature on File Update is selected:

1 The Perform Electronic Signature Window opens when you
save a data file.

2 Select the name of the user who is signing the data file in the
Username drop-down list.

3 Type a Comment that meets the requirements of the
compliance policies.

4 If appropriate, select the desired Approval State.
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Saving and Exporting Assays (Continued)

5 If desired, select the Lock check box to lock the data file and
prevent it from being changed.

6 Type the User Password for the signing user.

7 Click the Sign button. The Signature Performed window
confirms that the signature has been performed.

8 Click the OK button. The signature is recorded in the data file.

NOTE
|

Changing the analysis settings and saving the plate data file does
not change the raw data from the run. Only the display of the data is
changed.

If you change the analysis settings without saving the new settings,
and then try to close the workspace, exit the software, or acquire
new data, you are prompted to save the changes. Selecting Yes
opens the Save Workspace As Window.

Viewing AAV Empty/Full Assay Results
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The AAV Empty/Full Assay requires two assays are run on the
same samples: one AAV DN DNA assay and one AAV Pico
Protein assay. The AAV Pico Protein assay analyzes samples
concentration less than 1E12 VP/mL.

To view the AAV Empty/Full data:
1 Run the AAV DN DNA assay on the samples.

2 Run the AAV Pico Protein assay on the samples.

3 Open one of the two AAV Empty/Full data files in a new
workspace (see Opening a Data File on page 36). It does not
matter if you select the DNA or Protein data file first.

4 Right-click the plate name in the Plates list and select Set Plate
for AAV Analysis.

5 Open a new workspace (see Opening a New Workspace on
page 35).
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Viewing AAV Empty/Full Assay Results
(Continued)

6 Open the second AAV Empty/Full data file. The two data files
must have the same samples in the same order.

7 Right-click the plate name of the second plate in the Plates list
and select Set Plate for AAV Analysis.

Note: You must select one AAV DN DNA and one AAV Pico
Protein assay.

8 Click Analysis > AAV Analysis. The AAV Analysis Window
opens. The names of the selected AAV Empty/Full Protein/Pico
Protein and DNA assays display in the text boxes at the top of
the AAV Analysis Tab.

9 If either of the assays is not the desired assay, click the Clear
button at the bottom of the window, close the window, and
reselect the plates for AAV Analysis.

10 When the desired assays are selected, type the Percent Full of
the AAV Standard (from the AAV Standard vial label) in the AAV
Standard % Full text box.

11 Click the Calculate button. The software calculates the ssDNA
Time, Corrected Size, ssDNA Aligned Area, and % DNA
Impurities in the AAV DN DNA assay and the VP3, VP2, and
VP1 Corrected Area, VP3/VP1 Area Ratio, and the
VP2/\VP1 Area Ratio in the AAV Pico Protein Assay. The
software uses these values to calculate the % AAV Full, % AAV

Full (Partial), and % Empty Capsids values for each sample
and displays the values in the AAV Analysis Tab.

12 To change the Protein or DNA analysis settings, click the
Protein Settings Tab or DNA Settings Tab, change the settings
as desired and then click the Calculate button on the AAV
Analysis tab. After changing any settings, you must click the
Calculate button to recalculate the values.

13 If desired, click the Export button to export the AAV Analysis
data for the Protein assay, DNA assay, and Empty/Full analysis,
depending on the selected check boxes. The selected data is
exported to a CSV file.
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Changing the View of the Data

PN CLS151165 Rev H

The views in the LabChip GX Reviewer Main Window can be
customized to display data according to the preferences of the user.
These options do not change the raw data but provide different
means of displaying the data.

To change the view in the main window, see:

* Viewing Gels on page 82

» Viewing Zero Baselines on page 83

* Adjust Pane Widths on page 84

» Change Plate Order on page 84

* Show or Hide Views on page 85

» Zoom In and Zoom Out on page 85

* Viewing Graphs in the Overlay Electropherograms Tab on
page 86

* Viewing Graphs in the Electropherograms Tab on page 88

» Viewing Graphs in the Fluorescence Intensity Tab on page 90
* Viewing Analysis Errors and Warnings on page 91

» Viewing Multiple Properties in the Well Table View on page 92
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Viewing Gels

To compare the gels generated by the instrument, view the gels in
the Gel View. (Not supported for NAQuant NGS assays.)

i |
Figure 42. Gel View

The color, width, and contrast of the gels can be changed using the
Gel View Properties.

To rearrange gels, click on the column header (well name) and drag
the well to the desired location. To hide a well, select the well and
then click the (X) button on the column header, or right-click on the
well in the Plate View or Plate List and select Remove Well.
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Viewing Zero Baselines
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All electropherograms produced with the instrument show some
amount of background fluorescence. By default, the LabChip GX
Reviewer software enables the zero baseline function. To remove
the zeroing, select Analysis > Analysis Settings to open the
Assay Analysis Window, click the Peak Find Tab, and select the

none check box under Baseline Algorithm.
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Adjust Pane Widths

The LabChip GX Reviewer Main Window displays several different
views of the data files open in the workspace. You can change the
height and width of the views to make the views smaller or larger.

To adjust panes:

1

Place the cursor over the edge of the pane that you want to
adjust. The cursor changes to a line with arrows on each end.

Click and drag up, down, left, or right. The pane is resized after
you release the mouse button. The layout setting is saved as
part of the collection.

To save the setting, save the workspace. To create new
collections with the same settings, the collection can be saved
as a collection template (see Collection Menu on page 148).

Change Plate Order
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The Plate View or Plate List displays the plates in the order they are
imported into a collection. If desired, you can change the plate
order.

To change the plate order:

1
2
3

Select the List tab at the bottom of the Workspace pane.
Place the cursor over the plate to be moved.

Click and drag up or down to the desired location. The new plate
order displays on the Plate View or Plate List when you release
the mouse button.
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Show or Hide Views

The views displayed in the LabChip GX Reviewer Main Window can
be hidden to maximize other views in the main window. (Not
supported for NAQuant NGS assays.)

To hide a view:

1 Select Collection > Layout on the LabChip GX Reviewer Main
window. The Layout Options Window opens.

2 Click on the location selected for the view to clear the selection.
The view does not display if there is no selected location.

3 If alocation (Left, Right, or Bottom) does not contain any views,
the pane closes and the remaining panes enlarge to fill the
space.

Note: The Gel View cannot be hidden for assays other than

NAQuant NGS.

To display a hidden view:

1 Select Collection > Layout on the LabChip GX Reviewer Main
window. The Layout Options Window opens.

2 Click on a desired location for the hidden view (Left, Right, or
Bottom). If multiple views are displayed in the same location,
use the tabs at the top of the location to switch between views.

Zoom In and Zoom Out
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You can zoom in and out on data displayed in the Gel View and the
Graph View. The Graph View and the Gel view both zoom to the
same levels when either view is zoomed in.

To zoom in:

* Click and drag to enclose the region of interest. When you
release the mouse button, the selected area enlarges to fill the
view. In the Gel view, all lanes in the collection zoom to the
same level.

* You can continue zooming in until you reach the maximum
magnification (the graph will not zoom in any closer).

* Use the horizontal scroll bar under the graph to pan from left to
right.
To zoom out:

* Right-click in the Graph view or Gel view and select Unzoom to
go to the previous zoom setting or select Unzoom All to zoom
out to the default view.
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Viewing Graphs in the Overlay Electropherograms Tab

If the Overlay Electropherograms Tab is not open, select Collection
- Layout on the Menu Bar, select the location where you want to
display the Overlay Electropherograms tab, and click the Apply
button. The Overlay Electropherograms tab opens.
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Figure 45. Overlay Electropherograms Tab with Multiple
Graphs

Data from multiple wells can be overlaid in the same graph for
visual comparison. Click on one well, then hold down the CTRL key
and click on the additional wells to view in the graph. Each peak
graph is shown in a different color and line style with a legend at the
top of the window. You can remove wells from the overlay by CTRL
+ clicking the corresponding wells (the bounding box disappears).

Use the Overlay Offset text box on the Graph View Properties to
offset each of the graphs by the RFU value specified.
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Viewing Graphs in the Overlay Electropherograms Tab

(Continued)
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To add samples to the Overlay Electropherograms Tab, Ctrl +
click on the sample that you want to add in the Plate View or Plate
List, Gel View, Well Table View, or Peak Table View. Selected wells
are identified by: dashed outlines around the selected gel lanes in
the Gel view, light blue wells in the Plate view, and dark gray rows in
the Well Table view and Peak Table view.

To remove a specific sample from the graph, Ctrl + click on the
sample that you want to remove in the Plate View or Plate List, Gel
View, Well Table View, or Peak Table View.

To display only one sample in the Overlay Electropherograms tab,
click on one sample in the Plate View or Plate List, Gel View, Well
Table View, or Peak Table View.

To view the point coordinates and size of the position of the
cursor, hold down the CTRL or Shift key and move the cursor over
the graph.

To view the point coordinates and slope of a point on the trace,
hold down the ALT key and the CTRL key and move the cursor over
the trace.

To view the standards and samples for NAQuant assays, the
Standards display either along the top of the Plate View or Plate
List, similar to Ladders. Clicking a Standards icon selects the eight
Standards that are sipped together. To view the graphs of all eight
standards on the Overlay Fluorescence Intensity tab, right-click on
the graph and click Set Scale. Set the Minimum Y Axis and
Maximum Y Axis values to show all of the standards and samples
and then click OK. (Minimum = 100 and Maximum = 5000 usually
shows all of the standards and samples.)

To see which standards are used to generate a standard curve
for a specific sample in an NAQuant data file, select a single
sample in the Plate View or Plate List and then click Analysis >
Standard Curve. The Standard Numbers display at the top of the
standard Curve window.
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Viewing Graphs in the Electropherograms Tab

If the Electropherograms Tab is not open, select Collection >
Layout on the Menu Bar, select the location where you want to
display the Electropherograms tab, and click the Apply button. The
Electropherograms tab opens.
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Figure 47. Electropherograms Tab with Multiple Graphs

Data from multiple wells can be displayed in the same tab for visual
comparison. A separate graph for each well in the collection is
displayed in the Electropherograms tab. The data file name and
well name display at the top of each graph. If all of the wells are not
visible, use the scroll bar on the tab to scroll through the wells in the
collection.

Zooming in or out on one graph zooms all of the graphs in the tab
to the same zoom level when Synchronize Zoom is selected on
the right-click menu. Double-click on the graph to zoom out to the
original view.

To zoom in or out on one graph but keep all graphs at their
current zoom level, right-click in the graph and clear the
Synchronize Zoom check mark.

To only display the wells selected in the Gel View or Well Table
View, select the Graph Selected Gels Only check box in the Graph
View Properties.

To move the graphs in the tab, in the Gel View click and drag the
well to the desired position.
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Viewing Graphs in the Electropherograms Tab (Continued)
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To change the number of graphs displayed in the tab, select the
desired number of Rows and Columns of graphs to display in the
Graph View Properties. Selecting 8 Rows by 12 Columns displays
an entire 96-well plate.

To view the point coordinates and size of the position of the
cursor, hold down the CTRL or Shift key and move the cursor over
the graph.

To view the point coordinates and slope of a point on the trace,
hold down the ALT key and the CTRL key and move the cursor over
the trace.
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Viewing Graphs in the Fluorescence Intensity Tab

For NAQuant NGS assays, the view of the data cannot be changed.
The Fluorescence Intensity tab always displays on the top right side
of the Collection Pane.
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Figure 48. Fluorescence Intensity Tab

The Fluorescence Intensity tab displays the graphs for all wells
selected in the Plate View or Plate List. Only one graph can be
viewed in the Fluorescence Intensity tab at one time. Multiple
graphs cannot be viewed at the same time. Scroll up and down in
the tab to view each of the selected wells. The NAQuant NGS
graphs display data from 33 to 37 seconds.

Zooming in or out on one graph zooms all of the graphs in the tab
to the same zoom level when Synchronize Zoom is selected on
the right-click menu. Double-click on the graph to zoom out to the
original view.

To zoom in or out on one graph but keep all graphs at their
current zoom level, right-click in the graph and clear the
Synchronize Zoom check mark.

To view the point coordinates of the position of the cursor, hold
down the CTRL key and move the cursor over the graph.

To view the point coordinates of a point on the trace, hold down
the CTRL and ALT keys and move the cursor over the trace.
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Viewing Analysis Errors and Warnings

Analysis errors and warnings are indicated by red or yellow
exclamation points in the wells in the Plate View or below the
headers in the Gel View. The details of the error or warning can be
displayed in the Well Table View. After the Analysis Error column is
added to the Well Table, the analysis error text can be displayed in
the Electropherograms Tab or the Overlay Electropherograms Tab.

The following analysis errors and warnings are discussed in this
section:

Viewing Analysis Errors and Warnings in the Well Table
Viewing Analysis Errors and Warnings on the Graphs

Viewing Analysis Errors and Warnings in the Well Table
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To view the details of an analysis error or warning, display the
Analysis Error in the Well Table View.

1
2

Click the Well Table tab.

Right-click in the table header. The Select Well Table Columns
Window opens.

In the Available Columns list, select Analysis Error.

Click the Right Arrow button to move Analysis Error to the
Selected Columns list.

If desired, click and drag Analysis Error to the desired column
location. (The top column in the list is the first column in the
table.)

Click the Save button.
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Viewing Analysis Errors and Warnings on the Graphs

The text of analysis errors and warnings can be displayed on the
graphs in the Electropherograms Tab or the Overlay
Electropherograms Tab. The Analysis Error columns must be
displayed in the Well Table to be available for selection in the Graph
View Properties.

1 Click the Electropherograms Tab or the Overlay
Electropherograms Tab.

2 Click the Properties tab on the right side of the graph. The
Graph View Properties tab opens.

3 Select Analysis Error in the Well Annotation drop-down list.

4 |If desired, click the Well Annotation Location button to change
the location.

5 Click off of the Graph View Properties tab to close the tab.

Viewing Multiple Properties in the Well Table View
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Properties for Expected Peaks and Smears display in the Well
Table View. When entering the settings in the Expected
Fragments/Proteins/Glycans Tab or the Smear Analysis Tab on the
Assay Analysis Window, the property to display in the well table is
specified in the Property Displayed in Well Table column.

To display multiple properties for the same Expected Peak or
Smear in the Well Table:

1 In the Expected Fragments/Proteins/Glycans tab, or the Smear
Analysis tab, enter the properties for the expected peak or
smear, selecting one of the desired properties in the Property
Displayed in Well Table column.

2 Click in the next row and type the same name as an existing EP
or smear in the name field of the table. The row will
automatically update with the same entries as the original row.
The only field that can be changed is the Property Displayed in
Well Table column.

3 Change the Property to the desired selection.
4 Repeat until all desired properties have been added to the table.

5 Click the Apply button to display the new columns in the Well
Table. Duplicate properties in the table will be removed when
the settings are applied to the plate.
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Copying Information

The Edit menu and some of the right-click pop-up menus offer the
following choices for copying information from the LabChip GX
Reviewer software for use with other applications, depending on the

selection:
 Copy Gel
« Copy Lane

e Copy Graph
« Copy Rows to Clipboard
* Copy Column to Clipboard

Choosing any of these commands places a copy of the selected
item on the computer's clipboard. You can then paste the item into a
word processing, graphics, or other program.

Choosing Copy Gel copies all of the wells displayed in the Gel View
with the labels as part of the graphic. To copy a gel, right-click in the
Gel View and choose Copy Gel.

Choosing Copy Lane copies the selected well in the Gel View with
the labels as part of the graphic. To copy a gel, right-click in the Gel
View and choose Copy Lane.

Choosing Copy Graph copies the graph displayed in the Graph
View. The size of the image that is placed on the clipboard when
copying a graph is the same size as the graph displayed in the
software.

Copying rows from the Peak Table View or the Well Table View
places ASCII information from the selected row or rows on the
clipboard. To copy a row or multiple rows, select the desired rows in
the table, right-click on one of the selected rows, and select Copy
Rows to Clipboard.

Copying columns from the Well Table View is only available for
certain columns in the table. To copy a column, select a single cell
in the column, right-click on the cell, and select Copy Column to
Clipboard.
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Reanalyzing a Data File

Occasionally you may need to open and view or reanalyze a data
file that was run and saved previously. The raw data values are
saved in the plate data file, along with the original analysis settings
that were chosen for the run and any changed analysis settings.
This enables you to reanalyze the data with new settings or to view
previously saved settings.

The following analysis parameters can be changed:

Plate peak find settings and Well peak find settings (see
Changing the Peak Find Parameters on page 65)

Sample names and comments (see Using Sample Names Files
on page 39)

Add a Peak (see Adding a Peak on page 66)

Exclude peaks from analysis (see Manually Excluding a Peak
on page 66)

Reassign upper/lower markers (see Upper and Lower Marker
Peaks for DNA Assays on page 75, Lower Marker Peaks in

Protein or RNA Assays on page 76, or Lower Marker Peaks in
Glycan Assays on page 77)

Alignment or no alignment with ladder peaks (see Aligning or
Unaligning the Marker Peaks on page 74)

Assay - you can save the changed settings under a new assay
name, if desired (see Saving and Exporting Assays on page 78)

To reanalyze a data file:

1
2
3
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Open the workspace that contains the plate data (see page 35).
Change the analysis parameters (see list above) as needed.

When you click the Apply, Apply Global, or OK buttons in the
Assay Analysis Window, the data is automatically re-analyzed
and the updated information is displayed.

To view previous analysis settings, click the Restore Plate
button at the bottom of the Assay Analysis window and select
the version to view.
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Printing Workspace Information
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Choosing File & Print opens the Print Window to select the
information to print from the open workspace. The selected
information can be printed to a printer or to a PDF file. If the
workspace contains multiple collections, information from the active
(selected) collection is printed.

The header of each printout contains the workspace name, the
collection name, and the page number. The footer of each printout
contains information about the LabChip GX Reviewer software,
data file, assay, and instrument. If the LabChip GxP option is
installed, the footer also includes the data file version, signed state,
and lock state.

The following information can be printed for the open workspace:
+  PrintAll

* Gel on page 96

» Electropherogram on page 96

* Fluorescence Intensity on page 97

* Overlay Electropherogram on page 97

+  Well Table on page 98

+ Peak Table on page 99

* Multiple Electropherogram on page 100

* Multiple Fluorescence Intensity on page 100

* Print Replicate Report on page 101

See below for descriptions of each option.
Print All

This option prints the results of the assay in all of the available
formats. The page layout depends on the options selected in Print
Settings.
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Gel
This option prints a gel image with the lanes marked by the sample
name.
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Figure 49. Printed Gel

Electropherogram

Choosing this option prints an individual electropherogram of each
of the selected wells.
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Figure 50. Printed Electropherogram
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Fluorescence Intensity

Choosing this option prints one Fluorescence Intensity graph for
each selected well.
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Figure 51. Printed Fluorescence Intensity

Overlay Electropherogram

Choosing this option prints one graph with the electropherograms
for all of the selected wells overlaid onto a single graph.
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Figure 52. Printed Overlay Electropherogram
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Well Table

Choosing this option prints the columns displayed in the Well Table

View. To change the columns that are printed or the order of the

columns, change the columns in the Well Table View.

* Selecting the Add Border check box prints the table with a

border around each cell in the table.

* Selecting the Add Well Name as Header check box prints the
well name, well label, and sample name at the top of the page.

» Selecting both the Well Table and the Peak Table prints each

well on a separate page with the Well Table row at the top of the

page and the Peak Table for the well below it.
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Figure 53. Printed Well Table
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Peak Table

Choosing this option prints the columns displayed in the Peak Table
View. To change the columns that are printed or the order of the
columns, change the columns in the Peak Table View.

» Selecting the Exclude Marker check box removes all markers
from the printout.

» Selecting the Add Border check box prints the table with a
border around each cell in the table.

» Selecting the Add Well Name as Header check box prints a
well header (plate name, well name, and sample name) before
the peaks in each well.

» Selecting the Per Page or Per Well option for the Column
Header specifies whether the Peak Table column headers are
printed only at the top of each page (default), or if the headers
are also printed at the beginning of each new well table.

» Selecting both the Well Table and the Peak Table prints each
well on a separate page with the Well Table row at the top of the
page and the Peak Table for the well below it.
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Figure 54. Printed Peak Table

LabChip GX Reviewer User Manual

VWV



Data Analysis 100

Multiple Electropherogram

Choosing this option prints the selected electropherograms or the
entire collection of electropherograms, in the specified number of
rows and columns per page.
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Figure 55. Printed Multiple Electropherograms

Multiple Fluorescence Intensity

Choosing this option prints graphs of the selected wells or the entire
collection of wells, in the specified number of rows and columns per

page.
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Figure 56. Printed Multiple Fluorescence Intensity
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Print Replicate Report

Choosing this option opens the Replicate Report Generator Window
to setup and print report(s) of selected replicates by name,
statistical mean, standard deviation, coefficient of variance (cv) for
chosen well property/properties, and any desired custom settings.
To set the properties of the Print Replicate Report, see Printing
Replicate Reports on page 60.
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Figure 57. Printed Replicate Report
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Exporting Data
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Data from a Peak Table, Well Table, Gel, or Graph can be exported
automatically and/or manually.

Peak Tables and Well Tables are exported to CSV files. CSV files
can be imported into a spreadsheet program such as Microsoft®
Excel.

Raw Data can be exported to a CSV file or to an AlA file format
(i.e., a CDF file) which is used by some graphical analysis software
tools.

Gel and Graph data is exported to the selected image format (i.e.,
BMP, GIF, JPEG, PNG, TIFF, WMF, or EMF).

This section includes the following information for using the GX
Reviewer software to export Peak Tables, Well Tables, Gels,
Graphs, or raw data:

» Export Examples on page 103
» Exporting Data Manually on page 106

* Exporting Data in AIA Format for Use in Third-Party Analysis
Software on page 107
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Export Examples

This section shows export examples for the following:

* Peak Table
+ Raw Data
+  Gel

Peak Table

ASCII text file that contains the data in all columns in the Peak
Table. Figure 58 is an example of part of a Peak Table file exported
from a DNA assay (data truncated for this example):

B D e - i) B e SR i) e Sl ol e S LI e B L
1 |Plate Name |Sample Mame Size [BP] |Conc, (ng/ % Funty Expected IType Molarity {nmolf)
-2 |DHATK_LPS_F 1XLad ?

3 |DHATK LPS F1diad 15 5 15 LM 505.05

4 |DHATK LPS F1¥Lad 2514505 1.048493 9919342 25/ L0025 B3 16838

5 IDNATK LPS F 14Lad 50.50482 0967021 9337781 50 L0050 29.61074
B |DHATK_LPS_F 1xLad 1000837 0980348 9274644 100 L0100 1484132

7 |DHATK LPS F1¥Lad 150,4032) 0.968136 9159115 1580/L0150 9.752927

B |DHAK_LPS_F 1xLad 200.0971| 0.960094 9083032 200/ L0200 7269301

8 [DHATK_LPS F1¥Lad 300.4445| 0.953961 9025008 300/ L0300 4 810843

A0 [DHATK_LPS_F 1¥Lad 4003406 0940726 8899738 00 L0400 3.56032

11 | DHAIK_LPS F 1¥Lad 5004173 0847864 B 967327 500 L0500 2869916

12 [DRATK_LPS_F 14Lad 6996255 0933113 8827TE 700/ LOT00 2 020805

13 | DHAK_LPS_F 1¥Lad 249921 0.528357 B.732785 850/ LOBSO 1654978

14 [DHATK_LPS_F 1xLad 1004 273| 0922079 6723367 1000 L1000 1.391143

15 [DHATK_LPS F1¥Lad 1500 5 1500 UM 50505

Figure 58. Exported Peak Table

Peaks that are excluded are not exported and are missing in the
exported file. For example, if peaks 3, 5, and 7 are excluded, when
the data is exported into Microsoft® Excel, peaks 3, 5, and 7 are not
included.
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Raw Data

ASCII text file that contains the signal data from the run as one file
per well or multiple wells in the same file. Note that data that is
exported has been smoothed using the polynomial filter.

In addition to exporting time and value information, you can choose
to export Size information. This information is determined based on
aligned data and is used to correlate the peaks across different runs
or from one row to another.

When Include Size Data is not checked and only time and values
are exported, the state of the analysis function (peaks aligned or
not aligned with the ladder data) determines whether or not data
that is exported is or is not aligned. The same is true for the Zero
Baseline function: if enabled, data that is exported is also zeroed to
the baseline.

Below is an example of part of a raw data file exported from a DNA
assay (header not included and data truncated in this example):

DATA

Time, Size, Value
0.000,-158.365,0.80
0.017,-158.269,0.86
0.033,-158.173,0.53
0.050,-158.077,0.63
0.067,-157.981,0.45
0.083,-157.885,0.28
0.100,-157.788,0.24
0.117,-157.692,-0.05
0.133,-157.596,-0.38
0.150,-157.500,-0.66
0.167,-157.404,-1.06
0.183,-157.308,-1.45
0.200,-157.212,-1.70

Raw data can also be exported in a Chromatography Data
Interchange Format (formerly AIA format), which is used by some
graphical analysis software tools (see Exporting Data in AIA Format
for Use in Third-Party Analysis Software on page 107). The Include
Size Data and Export Single Table options are not available with
Chromatography Data Interchange Format.
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Gel

Exports the selected gel(s) in the selected image format. Options
are available to export the entire collection or only the selected
gels. Gels can be exported into the same image file or into separate
files for each gel.

Figure 59 shows multiple selected gels exported to the same image
file.
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Figure 59. Exported Gel
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Exporting Data Manually

PN CLS151165 Rev H

If the workspace contains multiple collections, the data exported is
from the active/selected collection.

1
2
3

Open the data file from which you want to export.
Select Export from the File menu. The Export Window opens.

Specify the desired name for the exported data files in the File
Naming Template text box. Include %DATA%, % TYPE%, and at
least one of %W NAME% or %LABEL% in the template to ensure file
names are unique across export types. The template displays in
red if it does not meet the minimum requirements, and the data
files will not be saved.

Select the check boxes next to the views to export. Selecting
Export All selects all check boxes.

For each selected view, to change the location for the files, click
the Browse (...) button and select the desired location. If the
path is the default path, the path displays in blue. If the path is
not the default path, the path displays in purple. The default path
is the location of the data file for the first well in the collection. To
reset the path to the default, right-click on the path and select
Reset to Default. (Changing the first well in the collection
changes the default path to the location of the appropriate data
file.)

If Raw Data is selected, choose the desired export options:

» Select the AIA Format check box to export in
Chromatography Data Interchange Format, which is used by
some graphical analysis software tools (see Exporting Data
in AIA Format for Use in Third-Party Analysis Software on
page 107). The Include Size Data and Export Single Table
options are not available with AIA Format.

+ Select the Include Size Data check box to align the data to
the well's ladder (for one file per well) or to the first well (for
a single data file) and include the size data in the exported
data.

+ Select the Export Single Table check box to export the data
for all wells in the plate to one CSV file. If not selected, the
data from each well is exported to a separate CSV file.

Note: Raw Data for NAQuant NGS assays is only exported in
CSV format.

LabChip GX Reviewer User Manual
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Exporting Data

7

10

Exporting Data
Software
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Manually (Continued)

If Electropherogram or Fluorescence Intensity is selected,
select either Entire Collection to export a separate graph for
each well in the collection or select Selected Wells to export a
separate graph for only the selected wells.

If Gel is selected, choose the desired export options:

» Select either Entire Collection to export all of the wells in
the collection or select Selected Wells to export only the
wells that are selected in the Gel view.

« Select either Single File to include gels for all wells in the
same image file, or select Separate Files to export each gel
to a separate image file.

+ If desired, change the height of the exported graphic in the
Height text box.

If Electropherogram, Fluorescence Intensity, Overlay
Electropherogram, or Gel is selected, choose the desired
format for the image files.

Click OK to export the data to the specified location.

in AIA Format for Use in Third-Party Analysis

Open the file that you want to export the data from.
Select Export from the File menu. The Export Window opens.

Specify the desired name for the exported data files in the File
Naming Template text box.

Select the Raw Data check box.

To change the location for the files, click the Browse (...) button
and select the desired location. If the path is the default path,
the path displays in blue. If the path is not the default path, the
path displays in purple. The default path is the location of the
data file for the first well in the collection. To reset the path to the
default, right-click on the path and select Reset to Default.
(Changing the first well in the collection changes the default
path to the location of the appropriate data file.)

Select the AlA Format check box to export in Chromatography
Data Interchange Format.

Select the OK button.
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Understanding Peak Finding

Peak finding is the complex data analysis process of converting the
raw data signal into a list of meaningful peaks. It involves smoothing
the data signal, applying the selected baseline algorithm, identifying
the peak baseline, detecting peaks within the smoothed signal, and
discarding peaks failing to meet user specified thresholds. This
process is controlled by the Peak Find analysis parameters
selected in the Assay Analysis Window on the Peak Find Tab.

This section contains the following information:

+ Data Smoothing

» Peak Detection - Slope Threshold

* Peak Splitting - Inflection ThresholdPeak Identification

* Peak Identification
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Data Smoothing

The raw data signal is initially smoothed using the Filter Width and
Polynomial Order parameters. This filter removes high frequency
noise from the data by performing a local weighted averaging of the
data using a Savitzky-Golay convolution kernel. The filter width
defines the range over which the averaging takes place; a 0.3 sec
filter width averages over 0.3 seconds of data or more precisely, the
data is convolved with a weight array that is 0.3 seconds wide. At
the typical sampling rate of 60 HZ, this kernelis 0.3 *60 =18+ 1 =
19 points wide (forced to be odd by algorithm requirements).

Using a very large filter width to try and reduce signal noise will
have an adverse effect on sharp peaks. Typically, the over-filtering
of sharp peaks causes side-lode artifacts to appear. The sample
shown below has both sharp peaks and signal noise, particularly
near the end of the trace. Removing the noise in the broad tail of
the upper marker by setting the filter width to 1.0 sec causes the
early sharp peaks to lose height and become distorted.

oA 1294 el g LA, 1 000 il

Filter Width = 0.1 sec FilterWidth = 1.0 sec

e

Figure 60. Filtering Examples
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Data Smoothing (Continued)

Because peaks tend to broaden as time progresses, use a short
filter width initially and then switch to a wider filter near the end of
the signal for this type of signal. The High Size filter on the Peak
Find Tab can be used to smooth the tail of the upper marker without
affecting the earlier peaks. Ultimately, some noise may have to be
tolerated to avoid distorting the peak shape.

I | Filterwidth = 0.5 sec
High Size Filtering:
Width = 1.2 sec.
Transifion, z 45 sec.

Figure 61. High Size Filtering

Peak Detection - Slope Threshold

PN CLS151165 Rev H

Peak baseline and Peak detection are controlled primarily through
the Slope Threshold property on the Peak Find Tab. The signal
slope increases rapidly at the start of the peak, becomes negative
after crossing the peak apex, and then returns to a small value at
the end of the peak. The slope threshold is the slope value used to
identify the start and end of the peak. The regions outside the zone
where the absolute value of the slope exceeds the slope threshold
are deemed baseline.

The slope threshold determines the peak start point and end point:

* The first point with local derivative above the slope threshold
indicates the Start Point of a peak.

* The first point where the negative slope on the falling edge of
the peak s below the slope threshold indicates the End Point of
a peak.

A baseline is drawn under each peak region using a signal average
in the baseline regions on each side of the peak.
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Peak Detection - Slope Threshold (Continued)

The Baseline Plateau property defines the minimum length of
baseline region needed for computation of this average. Often, the
region between peaks may not be long enough to qualify as
baseline, in which case the baseline is drawn from the nearest
qualifying baseline region on each side of the peaks.

In Figure 62, the orange trace shows the signal slope superimposed
over the data. The light blue traces are the peak baseline. The
scale for the slope is the same as for the data but with units of /sec.
For these well defined peaks, a threshold of 15 /sec clearly extracts
the full peak signal.
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Figure 62. Slope Threshold

The Slope Threshold is used to distinguish between baseline and
peak regions, so it should be set with care. A common mistake is to
set the threshold too low, making it difficult for the analysis to find
the baseline. On the same data signal, near the lower marker there
is sufficient noise to create variation in the slope values as shown in
Figure 63 on page 112.
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Peak Detection - Slope Threshold (Continued)
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Figure 63. Slope Values

Although the region before 23 sec is baseline, the slope ranges
between 15 /sec. Setting the slope threshold much below 15/sec
causes the analysis to detect these noise bumps as peaks. The
bumps will not be identified as peaks because they do not meet the
Minimum Height and/or Minimum Width thresholds, but the analysis
runs much slower as it carefully explores each bump. Also, the
analysis will have difficulty finding baseline regions of qualifying

width.
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Peak Splitting - Inflection Threshold

In situations where peaks overlap, the signal does not return to the
baseline and the slope may or may not change sign, depending on
the how close the peaks are to each other. Two peaks with a valley
in the middle is normally split into two peaks, but if a peak appears
as a shoulder on another peak, splitting does not normally occur. A
shoulder is recognized in the analysis as an inflection point. The
slope reverses direction but does not change sign. The slope trace
shows peaks and valleys - the valleys being the location of the
inflection points. The peak in Figure 64 is normally identified as a
single peak although the orange slope trace shows three distinct
inflection points.

1 % Inflecbon points in signal
=walley in slope

Figure 64. Single Peak

Setting the inflection threshold above the value of the valleys in the
slope splits the peak shoulders into separate peaks. The higher the
inflection threshold, the more peak splitting occurs. In this example,
a value of 150/sec splits off both shoulders. A value of 110/sec only
splits off the left shoulder. (See Figure 65 on page 114.)
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Peak Splitting - Inflection Threshold (Continued)

Figure 65. Inflection Threshold

Peak Identification

Peak identification involves generation of a peak baseline using the
Slope Threshold and Baseline Plateau, detection of each peak
using Slope and Inflection Thresholds, and then discarding peaks
using the Minimum Height and Minimum Width thresholds. This
process only occurs between the Start Time and End Time peak find
properties. The Minimum Height threshold sets the minimum peak
baseline-to-peak apex value needed for a peak to be identified by
the analysis. The Minimum Width is the minimum left edge-to-right
edge value needed for a peak to be identified.
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LabChip GxP Option

A LabChip GxP option is available for the LabChip GX Reviewer
software. This option ensures that assays, output data, analysis
settings, event data, and backup data files are not available for
editing or tampering. Data is stored in a secure folder on either the
LabChip GX Touch computer, the LabChip Reviewer computer, or a
network server.

The LabChip GxP option utilizes two main components, the Central
Data Repository (CDR) and the CFR database. The CDR is a
secure folder that contains assay files and data files. The CFR
database is a secure database that contains the GX Touch user
accounts, Audit Trail, and data folder information. To create and

maintain the CFR database, Microsoft® SQL Server® 2019 Express
is provided with the LabChip GxP option.

Using the LabChip GxP option alone does not ensure 21 CFR Part
11 compliance. Laboratory processes and procedures must comply
with 21 CFR Part 11 regulations.

NOTE
|

To perform the procedures in this section, log in to the LabChip GX
Reviewer software as an administrator as described in Opening the
LabChip GX Reviewer Software on page 15.

The following procedures are included in this section:
* Locking and Unlocking the Software on page 117
* Managing User Accounts on page 118
— Adding New Users on page 119
— Changing User Information on page 120
— Printing User Information on page 121
— Activating and Deactivating User Accounts on page 121
— Changing Access Rights on page 122
— Printing Access Rights on page 123
— Setting Policies for User Accounts on page 124
— Printing User Policies on page 125

Electronic Signatures on page 126

Reverting to a Specific Data File Revision on page 127
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* Audit Trail on page 128

Viewing the Audit Trail on page 129
Exporting the Audit Trail on page 130

+ Central Data Repository (CDR) on page 131

CDR Security Suggestions on page 132
Remapping the CDR Server on page 133
Creating New Data Folders on page 133
Moving Data Files into Folders on page 133
Deleting Data Folders on page 134

Hiding Data Files in the CDR Manager Window on
page 134

Showing Hidden Data Files in the CDR Manager Window
on page 135

Setting CDR and Assay Folder Permissions on page 136

Loading Installable Assays into the CDR Folder on
page 137

Deleting Installable Assays from the CDR on page 137

* Backing Up and Restoring Data on page 138

Backing Up the CDR Folder and CFR Database
Manually on page 138

Setting Up the CFR Database for Automatic Backup on
page 139

Restoring the CDR Folder and CFR Database on
page 143
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Locking and Unlocking the Software

The LabChip GX Reviewer software with the LabChip GxP option
installed allows you to lock the LabChip GX Reviewer software.
This prevents unauthorized users from accessing the software while
you are away from the computer. After the software is locked, only
the logged in user or a LabChip GX Touch Administrator can unlock
the software.

To lock the LabChip GX Reviewer software:

1 On the LabChip GX Reviewer Main Window, click Security —
Lock Application. The Unlock Application Window opens on
top of the LabChip GX Reviewer Main Window and displays the
user name of the current user.

LabChip GX has been locked. Only
‘administrator’ or an Administrator can
this application.

Username: |admini51rator |

Password: | |

Figure 66. Unlock Application Window
To unlock the LabChip GX Reviewer software:

1 On the Unlock Application Window, type the user password for
the logged in user in the Password text box and click the OK
button.

2 If the password for the current user is not available, type a
LabChip GX Touch Administrator Username and Password in
the Unlock Application Window and click the OK button. The
Administrator is logged into the LabChip GX Reviewer software.

3 To change the user to a non-administrator user, close and
restart the LabChip GX Reviewer software and then log in as the
desired user.
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Managing User Accounts
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Access to the LabChip GX Reviewer software is controlled by user
names when the LabChip GxP option is installed. Each user must
sign into the LabChip GX Reviewer software. The user’s Access
Level controls which options are available for each user name.

The following procedures are included in this section:

Adding New Users on page 119

Changing User Information on page 120

Printing User Information on page 121

Activating and Deactivating User Accounts on page 121
Changing Access Rights on page 122

Printing Access Rights on page 123

Setting Policies for User Accounts on page 124
Printing User Policies on page 125
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Adding New Users

Each person who uses the LabChip GX, LabChip GX Touch, or GX
Reviewer software should have a unique LabChip GX Touch user
account.

To add a new user:

1

N o a A~

8
9
10
11
12
13

Log into the LabChip GX Reviewer software using an account
with Administrator access rights.

On the LabChip GX Reviewer Main Window, select Security —
User and System Administration. The User Administration
Window opens.

Click the Create User button.

Type the desired Username.

Type the First, Middle, and Last name for user.
Type the user’s Position if desired.

Select the Access Level for the user. The Access Level
controls which rights the user has. The following access levels
are available:

* Restricted User
* Operator

» Supervisor

* Administrator

» Service

Type the desired User Password*.

Type the User Password again.

Select whether the user can perform a signature.

Select whether the user can Accept/Reject/Lock data files.
Select whether the user can Unlock data files.

Click the Save button.

* Passwords must be at least 5 characters long and must contain at
least one uppercase letter and at least one number (or one special
character).
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Changing User Information
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After a user account is created, the user details can be edited.

To change the user information:

1 On the LabChip GX Reviewer Main Window, select Security —
User and System Administration. The User Administration
Window opens.

2 Click the Edit Users button.

3 Select the user to edit from the User drop-down list.

4 Change the User Information as necessary:

First name

Middle name

Last name

Position

Access Level

User Can Perform Signature
Accept/Reject/Lock Data File
Unlock Data File

User Password

5 Click the Save button to save the updated user information.

NOTE

If changing the default administrator password, make sure to keep a
copy of the password in a safe place. The default administrator
password cannot be reset if forgotten.
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Printing User Information

After editing a user account, the user details can be printed for
record-keeping purposes.

To print the user information:

1 On the LabChip GX Reviewer Main Window, select Security —
User and System Administration. The User Administration
Window opens.

2 Click the Show User Info button.

3 To print the information for a single user, select the user name in
the Select User to Display list box.

4 To print the information for all users, select the Print All Users
check box.

5 To preview the printout, click the Print Preview button.

6 To print the selected information, click the Print button.
Activating and Deactivating User Accounts

If a user name is not going to be used, the user account can be
deactivated. The user name is not removed from the system, but
cannot be used to log into the LabChip GX Touch software or
LabChip GX Reviewer software. User names cannot be deleted. A
deactivated user name can be activated to continue to be used.

1 On the LabChip GX Reviewer Main Window, select Security —
User and System Administration. The User Administration
Window opens.

2 Click the De/Activate User button.
3 Select the user name in the Select User drop-down list.
4 Click the Deactivate button.

To reactivate a user name, select the deactivated user and click the
Activate button to return the user to active status. The user name
can now log into the LabChip GX Reviewer software.
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Changing Access Rights
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The rights assigned to each Access Level control the actions that a
user is allowed to perform in the LabChip GX Touch software or
LabChip GX Reviewer software. The rights apply to any user name
assigned to the access level. Rights cannot be assigned to an
individual user name.

To change the rights for an Access level:

1 On the LabChip GX Reviewer Main Window, select Security —
User and System Administration. The User Administration
Window opens.

2 Click the Define Access button.

3 Select or clear the check boxes for the desired rights for each
Access Level:

User Administration - Allows users to create, edit, activate
and deactivate users, or to change policies.

Run Assay - Allows users to run assays and save the new
data files that are created by the run. Users are not
permitted to save changes to existing data files.

Save Existing Data File - Allows users to save changes to
existing data files.

Save Workspace - Allows users to save new and existing
workspaces. If Save Existing Data Files is not selected,
users can only save workspaces where the data files have
not changed.

Plate Editor - Allows users to add or edit plate dimensions
in the Plate database.

Hide/Show in CDR - Allows users to hide and show data
files in the CDR.

Manage CDR Folders - Allows users to create, rename, and
delete folders in the CDR Manager window. This permission
is not required for automatically creating daily subdirectories
or to move data files in the CDR.

Perform Validation - Allows users to perform 1Q
(Installation Qualifications), OQ (Operation Qualifications),
Teaching the robot, and Optics Calibration.

Print/Export Analysis Results - Allows users to print or
export analysis results.

Audit Trail Access - Allows users to view the Audit Trail in
the Audit Trail Window.

Assay Editor - Allows users to edit and save assays.

4 Click the Save button.
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Printing Access Rights
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After changing the user rights, the access rights can be printed for
record-keeping purposes.

To print the access rights:

1 On the LabChip GX Reviewer Main Window, select Security —
User and System Administration. The User Administration
Window opens.

2 Click the Define Access button.
3 To preview the printout, click the Print Preview button.

4 To print the selected information, click the Print button.
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Setting Policies for User Accounts
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User Account Policies specify properties such as password options
and whether to require a signature when updating data files.

1

On the LabChip GX Reviewer Main Window, select Security —
User and System Administration. The User Administration
Window opens.

Click the Set Policies button.

Set the options as desired:

Password Expires After - The number of days until each
password expires. Range is 1 to 1000 days.

Number of Retired Passwords to Remember - User
cannot reuse the specified number of old passwords. Range
is from O to 5.

Minimum Password Length - The minimum length of each
password. Range is from 5 to 30 characters.

Maximum Login Attempts - The maximum number of times
the user can attempt to log in before being locked out of the
LabChip GX Touch software or LabChip GX Reviewer
software. Range is from 3 to 20. This option can be disabled
to allow unlimited retries without locking the user out.

Minutes to Automatic Lock - The number of minutes that
the software is inactive until the LabChip GX Touch software
or LabChip GX Reviewer software locks automatically.
Range is from 5 to 4320 minutes (3 days). To disable this
option, clear the check box. To unlock the software, see
Locking and Unlocking the Software on page 117.

Require Signature on File Update - If selected, an
electronic signature is required to save modified data files.
Signatures can be performed by any user who has the
Perform Signature option selected in the User Administration
Window.

Click the Save button.
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Printing User Policies
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After changing the user policies, the user policies can be printed for
record-keeping purposes.

To print the user policies:

1 On the LabChip GX Reviewer Main Window, select Security —
User and System Administration. The User Administration
Window opens.

2 Click the Set Policies button.
3 To preview the printout, click the Print Preview button.

4 To print the selected information, click the Print button.
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Electronic Signatures
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Based on a company’s procedural requirements, creating and
saving data files may require a superior’s signature. To sign a data
file, a user with signature permissions must enter a valid user
name, password, and comment to explain the purpose of the
signature. When signing a data file, options are also available to set
the file's approval state to Unreviewed, Accepted, or Rejected, and
to lock or unlock the data file. (These options are only available if
the signing user has the appropriate permissions.) A signature can
be added to the data file any time, except while the assay is
running.

NOTE
|

To change user signature permissions, see Changing User
Information on page 120.

To electronically sign a data file:

1 On the LabChip GX Reviewer Main Window, click Security —
Perform Signature. The Perform Electronic Signature Window
opens on top of the LabChip GX Reviewer Main Window.

2 Select the user name of the user that is signing the data file in
the Username drop-down list.

3 Type a comment describing the reason for the signature,
approval state, or lock state in the Enter Comment text box.

4 As required, set the Approval State by selecting the
Unreviewed, Accept, or Reject option.

5 To lock the data file, select the Lock check box. Locking a data
file prevents the data file from being saved until after it is
unlocked.

6 Type the User Password for the signing user in the User
Password text box.

7 Click the Sign button. The Signature Performed window opens
to confirm the signature was performed.

8 Click the OK button in the Signature Performed window. The
Perform Signature window closes. Signature information is
embedded in the data file and the signature is logged in the
Audit Trail.
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Reverting to a Specific Data File Revision

Each time a data file is changed, a new version of the data file is
created and saved. The LabChip GX Reviewer software enables
you to revert to a previous version of a data file.
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To revert to a previous data file version:

1

On the LabChip GX Reviewer Main Window, select Analysis >
Analysis Settings on the main menu. The Assay Analysis
Window opens.

Click the Plate button at the bottom of the window. The Restore
Plate Settings to Version window opens.

Select the data file version that you want to restore to.

Click the OK button. The Assay Analysis Window displays the
settings for the selected data file version.

Click the OK button to display the data file with the selected
settings.
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Audit Trail
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LabChip GX Reviewer software uses secured, computer-generated,
time-stamped audit trails to independently record the date and time
of operator entries and actions that create, modify, or delete
electronic records. The audit trails can be printed out for
documentation purpose. The audit trail documents can be made
available for agency review and copying.

The audit trail is a log of all of the following events that have
occurred in the LabChip GX Reviewer software:

* Administration and user management (create/ edit / deactivate
user, policy settings, access level modifications, login and lock
events)

+ Data file run events (prime, run started, run finished, run
stopped, run aborted, wash started, wash finished)

+ Data file signing events

« Data file hide/show events

* Instrument error events

» Data file version changes

* IQevents

* Application errors related to main database failures

In Windows 7 and 10, the “Computer User Role” records either User
or Administrator, depending on how the LabChip GX software is
started. If the LabChip GX software is started by right-clicking on
the icon and selecting Run as Administrator, the Computer User
Role is Administrator. If the software is started by double-clicking on
the icon, the Computer User Role is User. The Computer User Role
reflects the privilege that was used to start the LabChip GX
software.

This section includes the following Audit Trail procedures:

* Viewing the Audit Trail

+ Exporting the Audit Trail
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Viewing the Audit Trail
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To view events in the Audit Trail Log:

1

On the LabChip GX Reviewer Main Window, select Security —
Audit Trail Log. The Audit Trail Window opens.

Select the desired data range:

» Select whether to view most recent entries, entries between
specific dates, or the entire database.

» Select the number of entries or dates to search if Entire
Database is not selected.

If desired, select a user name to view only events performed by
a specific user.

To view events for a specific data file, select the name of the
data file.

To search only specific types of events select the desired Event
Category in the Event Category drop-down list. Default shows
all events.

To change the columns that are displayed, click the green arrow
button next to Event Category and select or hide the desired
columns.

Click the Search button to search the database.
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Exporting the Audit Trail
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The events displayed in the Audit Trail Window can be exported to a
file. The following formats are available:

e Text
« XML
< Excel

To export the events:

1 On the LabChip GX Reviewer Main Window, select Security —
Audit Trail Log. The Audit Trail Window opens.

2 Click the Export button in the Audit Trail Window. The Audit
Trail Export Window opens.

3 Select the desired export file format.
4 Click the Export button. The Save As window opens.

5 Choose the desired location for the file, type the desired file
name, and click the Save button.

By default, the file name is ATexport_<date>_ <time>, where <date>
and <time> are the current date and time.
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Central Data Repository (CDR)

The Central Data Repository (CDR) is a protected folder located on
either the LabChip GX Touch computer, the LabChip Reviewer
computer, or a network server. The CDR is only used when the
LabChip GxP option is installed.
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The CDR contains assay files and data files. The folders and files in
the CDR are protected from changes by unauthorized users.

The data files in the CDR can be organized into virtual folders. The
folders are not actually created in the CDR folder, but are displayed
in the CDR Manager Window to organize the data files.

The following procedures are included in this section:

CDR Security Suggestions on page 132

Remapping the CDR Server on page 133

Creating New Data Folders on page 133

Moving Data Files into Folders on page 133

Deleting Data Folders on page 134

Hiding Data Files in the CDR Manager Window on page 134

Showing Hidden Data Files in the CDR Manager Window on
page 135

Setting CDR and Assay Folder Permissions on page 136
Loading Installable Assays into the CDR Folder on page 137
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CDR Security Suggestions
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To ensure proper security of data files, the LabChip GX Touch
Administrator should change the Administrator password.

To change the administrator password:

1 Log into the LabChip GX Reviewer software as the
administrator.

2 Select Security —» Change Password.
3 Type the current password.

4 Type the new password in both the New Password and
Confirm Password text boxes.

NOTE
|

Make sure to keep a copy of the password in a safe place. The
administrator password cannot be reset if forgotten.

5 Click the OK button.

The LabChip GX Reviewer software contains an option to copy the
data files to an unsecured location on the local hard drive or on a
mapped network drive. These data files do not meet 21 CFR Part
11 security requirements after they are copied out of the CDR. To
copy data files to a non-secure location, use the Copy button on the
CDR Manager Window.
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Remapping the CDR Server

If desired, the administrator can reconfigure an existing CDR server
with a new one.

To remap the server:

1
2
3

5
6

Log into the LabChip GX Reviewer software as the administrator.
Do NOT open a workspace or import data files.

Click the Server Status button at the top right of the LabChip
GX Reviewer Main Window. The CDR / Database Server
Mapping Window opens.

Type the new server location into the Server name/IP Address
text box.

Click the Apply button. The server connects to the new location.

Click the Done button.

Creating New Data Folders

To create a new CDR data folder:

1

5

Select File — Import Data File. The CDR Manager Window
opens.

Click on the upper-level CDR folder.

Click the New Folder button on the left side of the window. A
new folder named New Folder is created and the name is
selected for update.

Type the desired name for the folder and then press the Enter
key.

Close the CDR Manager Window.

Moving Data Files into Folders

To move a data file into a CDR data folder:

1
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Select File — Import Data File. The CDR Manager Window
opens.

Click on the name of the data file.
Drag and drop the file into the desired folder.
Close the CDR Manager Window.
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Deleting Data Folders

To delete a CDR data folder:

1

5

Select File — Import Data File. The CDR Manager Window
opens.

Verify the folder is empty.
Click on the folder name.

Click the Delete button on the left side of the window or at the
top of the window.

Close the CDR Manager Window.

Hiding Data Files in the CDR Manager Window

The CDR Manager window enables users to hide or show specific
data files or folders in the CDR Manager window. This functionality
can be used to reduce the number of data files displayed in the
CDR Manager window when certain files or folders are not used.
The user must have Hide/Show in CDR rights in the Define Access
tab in the User Administration Window.

Hiding data files or folders does not change the data file or folder,
they are just not displayed in the CDR Manager Window.

To hide data files or folders:

1

PN CLS151165 Rev H

Select File — Import Data File. The CDR Manager Window
opens.

Select the name of the data file or folder that you want to hide. If
you select a folder name, all data files and folders in the
selected folder will also be hidden.

Click the Hide button on the left side of the CDR Manager
Window.

Close the CDR Manager Window.
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Showing Hidden Data Files in the CDR Manager Window
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To set hidden data files back to unhidden (show):

1 Click the Show Hidden Files button at the top right of the CDR
Manager Window. All hidden files and folders show in the CDR
Manager window. The file or folder icon indicates if the file or
folder is hidden.

2 Click the name of the file or folder that you want to show and
click the Show button on the left side of the CDR Manager
Window.

NOTE
|

Files and folders in a hidden folder do not show in the CDR
Manager Window, even if the files are not set to hidden. To show
files, the folder cannot be set to hidden.

3 Click the Hide Hidden Files button at the top right of the CDR
Manager Window.

4 Close the CDR Manager Window.
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Setting CDR and Assay Folder Permissions
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To set permissions to the CDR and Assay folder:

1
2

10

Log into the LabChip GX Reviewer software as an administrator.

Select Security — Folder Permission. The Folder Permissions
Window opens.

Click the Assay radio button and select the user name for which
permissions are being set from the Select User drop-down list.

Select the CDR radio button to set permissions for the CDR
folder or its subfolders.

Select the Assay radio button to set permissions for the Assay
folder or its subfolders.

Select the CDR, Assay, or sub-folder to set permissions for.

Select the Full Control check box to give the user read/write
access to the selected folder.

Select the Read check box to give the user read-only access to
the selected folder.

Select the Write check box to give the user write-only access to
the selected folder.

Select the Apply permissions to subfolders check box and
click the Save button to implement the permissions.
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Loading Installable Assays into the CDR Folder

If desired, installable assays (*.iasyx) from Revvity can be
loaded into the CDR folder.

To load the installable assay into the CDR folder:

1
2

Verify the LabChip GX Touch software is closed.

In the LabChip GX Reviewer software, click Tools > Load
Assay into CDR on the LabChip GX Reviewer Main Window.
The Load Assay into CDR Window opens.

Click the Browse button next to the Select CDR Assay Folder
text box. The CDR Browser Window opens.

Navigate to the Assay CDR folder, select the folder and click
the OK button.

Click the Browse button next to the Select Assay File to Load
text box.

Navigate to the folder containing the desired installable assay
file, select the installable assay file (*.iasyx) and click the OK
button.

If desired, type a comment to explain the change in the CDR
change log in the Comment text box.

If desired, type the source of the assay (e.g., Revvity or
Revwvity Installable Assay) in the External Source box.

Click the Load Assay button. The installable assay is added to
the CDR folder.

Deleting Installable Assays from the CDR
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1

Verify that the LabChip GX Touch software is closed.Click Tools
> Load Assay into CDR. The Load Assay into CDR Window
opens.

Select the assay you want to delete in the New Assay list box.

If desired, type a comment for the log file in the Comment text
box.

Click the Delete button to remove the installable assay from the
CDR. The change is logged in the log file.
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Backing Up and Restoring Data

The CDR folder and the CFR database can be backed up manually
to a secure location. The CFR database can be set to back up
automatically. The backup copies can be stored on another
computer or on a removable storage drive. Backup completely
replaces the previous backup files with new backup files. The CDR
folder and CFR database can only be restored to the point when the
files were backed up.

This section contains:

» Backing Up the CDR Folder and CFR Database Manually on
page 138

» Setting Up the CFR Database for Automatic Backup on
page 139

* Restoring the CDR Folder and CFR Database on page 143

Backing Up the CDR Folder and CFR Database Manually
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Admin rights to the CFR database are required to use
BackupDB.exe. A new administrator account may need to be added
to the database. To back up the CDR Folder and CFR Database
manually:

1 Log into the computer where the CDR is installed. The user
account must have Administrator rights to the CFR database.

2 Open the application folder:
32-Bit Operating System:
C:\Program Files\Revvity\LabChip GX Reviewer
64-Bit Operating System:
C:\Program Files (x86)\Revvity\LabChip GX Reviewer

3 Right-click the BackupDB.exe file and select Run as
Administrator. The Backup LabChip GX server CDR and
Database window opens.

4 Click the Backup button. The backup script creates two files:
DBBack.bak and LabChipGXServerData.zip in the \Backup
folder in the application folder.

5 Click the Close button when the progress bar completes.

6 Move the two files to a backup or archive location or to a parallel
folder on another Server PC to move the server instance.

NOTE: The BackUp DB function is also available on the Tools menu
on the LabChip GX Reviewer main window.
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Setting Up the CFR Database for Automatic Backup

If desired, the CFR database be set for automatic backup by using
Windows Task Scheduler.

To set the CFR database for automatic backup:

1 Open the Task Scheduler using either of the following methods:

+ Click the Windows key + R, type taskschd.msc into the
Open text box, and click the OK button.
OR

* Go to Control Panel —» System and Security —
Administrative Tools — Schedule Tasks.

The Task Scheduler Window opens. See Figure 67.

(@ Task Scheduler - X
File Action View Help
&< m B

Task Scheduler (Local) Actions.

 Task Scheduler Library — i

[ Overview of Task Scheduler

Connect to Another Computer..
T, You can use Task Scheduler to create and manage common tasks that your computer will carry out automatically at the times you specify. To begin, click a command in the Action 3] Create Basic Task..
menu
% Create Task.
Tasks are stored in folders in the Task Scheduler Library. To view or perform an operation on an individual task, select the task n the Task Scheduler Library and click on a command —
: 3
Display All Running Tasks

&] Disable All Tasks History

Task Status
AT Service Account Configuration
Status of tasks that have started in the following time period: Last 24 hours View »
Summary: 128 total - 4 running, 117 succeeded, 0 stopped, 7 failed i Refresh
H Help

RunResult  Run Start Run End Triggered By

Active Tasks.

Active tasks are tasks that are currently enabled and have not expired.

Summary: 89 total

Task Name Next Run Time Triggers

9/23/2023 75107 AM Multiple triggers defined
9/23/2023 11:16:16 AM Multiple triggers defined  \Mi indoy
9/23/2023 120000 PM At 1200 AM on 1/2/2004 .. \Microsoft\Windows\Cus..

Last refreshed at 9/23/2023 7:38:44 AM Refresh

Figure 67. Task Scheduler Window
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Setting Up the CFR Database for Automatic Backup
(Continued)

2 Click Create Basic Task on the Actions panel on the right side

of the Task Scheduler window. The Create Basic Task Wizard
window opens. See Figure 68.

™
Creste Bass Tack Wizard gt Zimm
|
J| Create a Basic Task

Croate a Bass Tazk Use this wizard to quickly schedule a comemon tasi. For mone advanced options or settings
Trigger such 25 multiple task acticns or tnggers, use the Creste Task command in the Actions pane.
Acteon Mame:

Panih Detonphion:

Cancel
J
Figure 68. Crate Basic Task Window

3 Type a name of for the backup into the name text box.
4

If desired, type a description into the Description text box and
click the Next button.
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Setting Up the CFR Database for Automatic Backup
(Continued)

5 Select one of the radio buttons to indicate the desired frequency
of the backup and click the Next button. See Figure 69.

Create Basic Task Wizard i

ey

2| Task Trigger

Create s Basic Task When do you want the task to start?

N - .
Weekhy

dactian

Finish Menthly

& Weeldy

One time
When the computer stafs
When | log on

When a specific event is logged

< Back | HNext> E Cancel

Figure 69. Task Trigger

NOTE
|

°

Weekly or monthly is the recommended frequency of the backup.

6 Specify the starting/timing parameters of the selected backup
frequency and click the Next button.

7 Select the Start a program radio button and click the Next
button.

8 Click the Browse button and navigate to the BackupDB.exe file
(C:\Program Files\Revvity\LabChip GX
Reviewer\BackupDB.exe).
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Setting Up the CFR Database for Automatic Backup
(Continued)

9 Type /auto into the Add arguments text box and click the Next
button. See Figure 70.

Creste Bagic Task Wizard E
—

J| Starta Program

Create » Basic Task

Trigger Bragrarm/seript
Ll o Pro gram Files\PerkinElmer' LabChip GX Reviewer BEpckupD8.exe Browie
Gctian

m £dd arguments (optional i

Feikish Start in (opticnal)

< Back | BHest = Cancel

Figure 70. Add Arguments

10 Verify that the backup parameters displayed on the summary
window are correct. If changes are needed, click the Back
button until reaching the desired parameter to change and apply
the changes.

11 Select the Open the Properties dialog for this task when |
click Finish check box and click the Finish button. The backup
task is added to the Windows schedule and the CFR database is
set for automatic backup.

12 Periodically review the result (passed/failed) of backups by
viewing the CFR.log file (C:\Program
Files\Revvity\LabChip GX Reviewer\Log).
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Restoring the CDR Folder and CFR Database
NOTES
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If restoring the CDR folder and CFR database to a new
computer, install the LabChip GX Reviewer software with the
LabChip GxP option and then restore the CDR folder and CFR
database.

The CDR folder and CFR database can only be restored to the
point when the files were backed up.

To restore the CDR folder and CFR database from a manual backup

point:

1 Log into the computer where the CDR is installed.

2 Copy the two backup files DBBack.bak and
LabChipGXServerData.zip to the \Backup folder in the
application folder.

3 Return to the application folder:
32-Bit Operating System:

C:\Program Files\Revvity\LabChip GX Reviewer
64-Bit Operating System:
C:\Program Files (x86)\Revvity\LabChip GX Reviewer

4 Right-click the RestoreDB.exe file and select Run as
Administrator. The Restore LabChip GX server CDR and
Database window opens.

5 Click the Restore button. A pop-up window opens prompting
you to make sure you are restoring to the software version that
the back-up was taken. Click Yes to proceed. Click No if you are
not restoring to the correct software version and then locate the
correct version.

6 Touch the Close button when the progress bar completes. The
CDR folder and CFR database are restored.

NOTE

When the LabChip GX Touch or GX Reviewer software is restarted,
a “Mapped Server is different. Do you want to remap?” message
displays on a dialog box. Verify the server name/IP is correct on the
dialog box and click the Apply button.
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Software Reference

This section describes the windows in the LabChip GX Reviewer
software. Each topic describes the options and buttons on the
window, and how to open the window. This section includes:

» LabChip GX Reviewer Main Window on page 145
* AAV Analysis Window on page 180

* About LabChip GX Reviewer Window on page 186
* Add New Expected Peak Window on page 187

* Assay Analysis Window on page 188

* Audit Trail Export Window on page 215

* Audit Trail Manage Columns Window on page 216
* Audit Trail Window on page 217

+ CDR/ Database Server Mapping Window on page 219
+ CDR Manager Window on page 220

* Change Password Window on page 222

+ Data File Version Window on page 223

» Display Format Editor Window on page 224

* Export Window on page 225

* Folder Permissions Window on page 228

* Layout Options Window on page 230

* Load Assay into CDR Window on page 232

* Login Window on page 233

* New Collection Window on page 234

* Perform Electronic Signature Window on page 235
* Print Validation Reports Window on page 237

*  Print Window on page 238

* Rename Collection Window on page 244

* Run Info Window on page 245

+ Sample Name Editor Window on page 247

» Save Workspace As Window on page 250

+ Select a Data File Window on page 251

+ Software Installation Qualification Window on page 252
* Unlock Application Window on page 254

* Unlock Data File Window on page 255

* User Administration Window on page 256
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LabChip GX Reviewer Main Window
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Figure 71. LabChip GX Reviewer Main Window
The main window of the LabChip GX Reviewer software includes:
* Menu Bar on page 146
* Plate View or Plate List on page 152
* Collection Pane on page 155
* Graph View on page 156
* Graph View Properties on page 162
* Gel View on page 165
* Gel View Properties on page 168
*  Well Table View on page 170
* Peak Table View on page 172
* Peak Table Properties on page 177
* Filter View on page 178
Clicking and dragging the borders between the views changes the
size of the views in the collection. To change the location of the
views, see Changing the View of the Data on page 81.
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Menu Bar
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The menu bar is directly below the title bar on the LabChip GX
Reviewer Main Window. Clicking a menu name displays a list of
commands to access software functions.

The LabChip GX Reviewer software contains the following menus:

File Menu on page 147
Workspace Menu on page 148
Collection Menu on page 148
Analysis Menu on page 149
Tools Menu on page 150

Security Menu on page 150 (Only displays if the LabChip GxP
option is installed)

View Menu on page 151
Validation Menu on page 151
Window Menu on page 151
Help Menu on page 151
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File Menu
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The File menu contains the following commands:
New Workspace - Creates a new, blank workspace.

Open Workspace - Opens a saved workspace.

NOTE
|

You can open multiple data files, but you cannot mix data files from
different Assay Classes in the same workspace.

Import Data File - Opens a saved data file in the current
workspace. If the LabChip GxP option is installed, opens the CDR
Manager Window. If the LabChip GxP option is not installed, opens
the Select a Data File Window. A graphical representation of the
microplate displays in the workspace. Data files can be .GXD
(LabChip GX or GX Touch) or .CLA (LabChip HT software).

Export - Opens the Export Window to choose the type of data to
export. Exports a Peak Table, Well Table, Gel, Single Graph, or all
open graphs in the current Collection to a file, depending on the
options selected.

Print - Opens the Print Window to choose the data to print.
Save Workspace - Saves the current workspace.

Save Workspace As - Saves the current workspace with a new
filename.

Exit - Closes the LabChip GX Reviewer software.
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Workspace Menu

The Workspace menu contains the following commands:

Remove Plate - Removes the selected plate data file from the
workspace.

Save Plate - Saves the plate data file (*.gxd). Changes to the
analysis settings (in the Assay Analysis Window) are saved at the
end of the plate data file. Previous analysis settings are not
overwritten, enabling you to use the Restore Plate button on the
Assay Analysis Window to go back to any previously saved
settings. Plate data files are automatically saved when the
Workspace is saved.

Collection Menu

The Collection menu contains the following commands:

Undo - Undoes changes to the collection view settings and filter
settings. Changes made in pop-up windows, such as analysis
settings, export settings, etc, are not affected by this Undo.

New Collection - Opens the New Collection Window where you
choose whether to create a New Collection from a saved Collection
Template, a Blank Collection, or the Current Collection.

Rename Collection - Opens the Rename Collection Window to
rename the currently selected Collection.

Delete Collection - Deletes the current Collection.

Save As Template - Opens the Save Template As window to save
the display and filter settings currently displayed in the Collection
tab as a collection template.

Apply Template - Opens the Apply Template window to open a
saved collection template and apply it to the current Collection.

Layout - Opens the Layout Options Window to change where tabs
are displayed by default on the main window. (Not available for
NAQuant NGS assays.)
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Analysis Menu
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The Analysis menu contains the following commands:

Turn On/Off Analysis - Toggles analysis on and off. When analysis
is on, the data displayed in the main window uses the analysis
settings in the Assay Analysis Window. When analysis is off, the
unaligned data (spike rejected, filtered, and baseline corrected)
displays. (Not available for NAQuant NGS assays.)

Scale to Sample Peaks - Scales the view to the minimum and
maximum X values of the current sample peaks. Marker and/or

system peaks are ignored. (Not available for NAQuant NGS
assays.)

Scale to All Peaks - Scales the view to the minimum and maximum
X values of the all peaks, including marker peaks and system
peaks. (Not available for NAQuant NGS assays.)

Analysis Settings - Opens the Assay Analysis Window to choose
analysis parameters for the selected plate. These settings apply to
all wells in the microplate. Use these settings to change the
analysis and peak finding parameters to help resolve hard-to-
decipher data. (Not available for NAQuant NGS assays. Not used
for AAV Empty/Full assays.)

AAV Analysis - Opens the AAV Analysis Window to view the AAV
Empty/Full Analysis results and to specify the analysis settings for

the DNA and Protein/Pico Protein assays. Both an AAV DN DNA
and an AAV Pico Protein assay must be selected to calculate the
Empty/Full results.

Standard Curve - Opens the Standard Curve to view the ladder as
a curve with a point-to-point fit. NAQuant displays the calibration
curve from the eight standards. (Not available for Protein Charge
Variant assays. Not used for AAV Empty/Full assays.)
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Tools Menu

Security Menu
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The Tools menu contains the following commands:

Sample Name Editor - Opens the Sample Name Editor Window to
change, import, or export the sample names assigned to the wells
of the plate.

Assay Editor - Opens the Select Assay To Edit window or the CDR
Manager window if the LabChip GxP option is installed. Selecting
an assay opens the Assay Analysis Window to make changes to
the selected assay.

Load Assay into CDR - Opens the Load Assay into CDR Window
to add installable assays into the CDR assay folder from an external
folder. This command only displays if the LabChip GxP option is
installed.

Modify Data Presentation - Opens the Display Format Editor
Window to specify the number of decimal places to show for each
numeric data type.

BackUp DB - Backs up the CDR folder and CFR Database. Only
displays if the LabChip GxP option is installed.

The Security menu only displays if the LabChip GxP option is
installed with the LabChip GX Reviewer software.

User and System Administration - Opens the User Administration
Window to create, edit, and view user login information, activate or
deactivate users, define user access, and set user policies.

CDR Folder Permission - Opens the Folder Permissions Window
to set Full Control/Read/Write permissions for CDR folders for
specific user accounts.

Change Password - Opens the Change Password Window to
change the Login Password for the current user.

Perform Signature - Opens the Perform Electronic Signature
Window to sign a data file.

Unlock Data File - Opens the Unlock Data File Window to unlock a
locked data file.

Audit Trail Log - Opens the Audit Trail Window to view, search,
export, and print the audit trail.

Lock Application - Opens the Unlock Application Window to lock
the LabChip GX Reviewer software and prevent other users from
using the software until the software is unlocked by the current user
or an Administrator.
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View Menu

The View menu contains the following commands:

Run Info - Opens the Run Info Window to view information about
the run.

Version Change Details - Displays the Data File Version Change
Details window to view changed versions of the selected open data
file.

Validation Menu

Window Menu

Help Menu
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The Validation menu contains the following commands:

Software 1Q - Opens the Software Installation Qualification Window
to perform the 1Q.

Reports - Opens the Rename Collection Window to view or print 1Q
results.

The Window menu contains the following commands:

Cascade - Displays each Collection in a separate, cascading
window in the Collection Pane.

Tile Vertical - Displays each Collection in separate side by side
windows in the Collection Pane.

Tile Horizontal - Displays each Collection in separate top to bottom
windows in the Collection Pane.

Tabbed - Displays each Collection in a separate tab in the
Collection Pane.

The Help menu contains the following commands:

LabChip GX Reviewer Help
Opens the Contents/Index page for the LabChip GX Reviewer Help
file.

About LabChip GX Reviewer
Opens the About LabChip GX Reviewer Window, showing the
software version number and firmware version number.
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Plate View or Plate List

Plate View
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[1] (READ ONLY) Demo DNA 5K 96 wells

The Plate View or Plate List View displays on the left side of the
LabChip GX Reviewer Main Window.

The Plate View or List View displays the data files in the open
collection and enables you to select specific wells of microplate
data. Click the tabs at the bottom of the view to switch between
Plate View and List View.

The Plate View displays a graphical representation of the
microplates in the collection and indicates selected wells and
ladders, filtered wells, and wells with errors. Wells included in the
collection are colored blue. Ladder wells display on the left side of
the plate if the sip order was row-wise, or along the top of the plate
if the sip order was column-wise. The wells selected to view in the
Gel View and Well Table View are outlined in black. Select the
Plates tab at the bottom of the Workspace pane to see the Plates
view.

[11(READ ONLY) Demo DNA 5K 96 wells
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Figure 72. Plate View, Row-wise and Column-wise

To select the wells to view in the Collection Pane, see Selecting the
Wells in a Collection on page 38.

Plate View Right-Click Menu

Right-click on the plate name in the Plate view to display the
following options in the shortcut menu:

+ Keep Gel in Sip Order - Displays the gels in the sipped order.

+ Keep Well Table in Sip Order - Displays the rows in the Well
table in the sipped order for NAQuant NGS assays only.

« Save Plate - Saves the current data file.

+ Set Plate for AAV Analysis - Sets one AAV DN DNA assay or
one AAV Pico Protein assay for AAV Analysis.
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* Copy Plate - Saves a copy of the plate data file (.gxd) to the
selected folder.

* Export Plate Datafile - Displays the Export Plate as new Data
File Window to save a copy of the plate data file (.gxd) without
user specific names to the selected folder. Options to remove
include Sample Names, Comments, EP Table, EP names,
Smear Table, and Smear names.

+ Export Assay - Saves a copy of the assay settings for the plate
to an assay file (.asy for GX or .asyx for GX Touch) in the
selected folder.

* Rename Plate - Renames the plate in the workspace. If
desired, the original data file can be renamed by selecting the
Rename File to Match check box.

* Remove Plate - Removes the plate data file from the
workspace. The data file is not deleted, only the workspace view
changes.

* Analysis Settings - Displays the Assay Analysis Window to
change the analysis settings for the data file. (Not available for
NAQuant NGS assays.)

* Version Change Details - Displays the Data File Version
Window to view a different version of the data file in the
workspace.

* Run Info - Displays the Run Info Window to view the run
information and Event Log.

Plate Well Color Code

[1]PlateA_LABCHIPGX-POST1_TRAINING _LK_KY Q..

(Hojelelellelalelolela]e
_|123456?8910111J|_”J

Bt
) (]

> 650000060000 -

E '!l!ill'l'l! E

*  White - Wells are not included in the open collection.

* Gray - Wells were not read.

* Blue -Wells are included in the open collection.

* Any Other Color - Wells are selected by a Filter. See the Filter
View to determine which color represents each filter. If a well is
selected by multiple filters, the colors are combined in the well.
(In the figure above, light green wells are selected by a filter.)

B

« Black Outline - Wells are selected in the Gel View and Well
Table View.
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List View
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Red Exclamation Point in Well - An analysis error has
occurred in the well, such as no lower marker detected (well C1
above).

Yellow Exclamation Point in Well - An analysis warning has
occurred in the well (see well C7 above).

The List View displays a list of all the wells in the currently open
data files. Select the List tab at the bottom of the Workspace pane
to see the List view.

List

Dark Blue well names are included in the open collection.
Black well names are not included in the open collection.

Light Blue well names are selected in the Gel View and Well
Table View.

Well names outlined in Yellow have an analysis warning.
Well names outlined in Red have an analysis error.

a

El- [1] 12k DNA Demo 4_2008-08-28_01-36-43

(Ladderl) Ladderl

(A2) 1/2 Ladder

(A3) 1/4 Ladder

(Ad) Blank

(A5) PhiX174 BsuRl ~25 ngiul
(A6) PhiX174 BsuRl ~2.5 ngiul
(AT) PhiX174 BsuRl ~0.25 ng/ul
(A8) Blank

(AS) 10.000 bp

(A10) 5000 bp

(A11) 2500 bp

(A12) 850 bp

(LadderZ) Ladder2

(B1) Blank

(B2) BstEll ~25 nglul

(B3) BstEll ~12.5 nglul

(B4) BstEll ~6.25 nglul

(B5) Ladder

(B6) 1/2 Ladder

(B7) 1/4 Ladder

(B8) Blank

(B9) PhiX174 BsuRl ~25 ngiul

'ﬁ'ahe's' List

Figure 73. List View

LabChip GX Reviewer User Manual

VWV



Software Reference 155

Collection Pane
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The Collection Pane in the LabChip GX Reviewer Main Window
displays a tab for each collection in the workspace. Each collection
displays the information from the data files that are open in the
Plate View or Plate List.

The Collection Tabs each contain the following views:

Graph View

Gel View (Not available for NAQuant NGS assays)

Well Table View

Peak Table View (Not available for NAQuant NGS assays)
Filter View

The views in the Collection pane are synchronized with each other.

Selecting a graph on the Graph tab automatically selects the
same well on the Gel tab.

Selecting a peak in the Peak Table automatically selects the
same peak in the Graph tab and the Gel tab.

Closing a gel on the Gel tab closes the graph for the well and
removes the well data from the Peak Table and Well Table tabs.

For NAQuant NGS assays, selecting a well in the Well Table
automatically displays the same well in the Fluorescence
Intensity tab.
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Graph View
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The Graph view in the Collection Pane is a visual representation of
the data from each well as an electropherogram.

Use the Overlay Electropherograms Tab and the
Electropherograms Tab to view data from completed wells. To
change the view in the Overlay Electropherograms tab, see Viewing
Graphs in the Overlay Electropherograms Tab on page 86. To
change the view in the Electropherograms tab, see Viewing Graphs
in the Electropherograms Tab on page 88.

For NAQuant NGS assays, use the Fluorescence Intensity Tab to
view data from the completed wells. See Viewing Graphs in the
Fluorescence Intensity Tab on page 90 for more information.
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Figure 74. Graph View

If Type is selected as an annotation, the lower (and upper for DNA)
markers are displayed in the graph view with large green arrows
labeled LM and UM respectively. The currently selected peak in the
Gel view or Peak Table displays a small blue arrow above the peak.
(Not supported for NAQuant NGS assays.)

You can zoom in and zoom out the Graph View of the wells. Zoom
in by clicking and dragging over a region of an electropherogram.
Zoom out by right clicking on a graph, and selecting either Unzoom
or Unzoom All from the shortcut menu. Double-clicking in the graph
will zoom out to the previous zoom level.
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Graph View (Continued)
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Graph data can be exported to a graphic file by choosing Export on
the File menu. (See Exporting Data on page 102 for details.) If the
workspace contains multiple collections, the data exported is from

the active/selected collection.

To show or change the labels on the peaks in the graph, show the
data points on the graph, show peak baselines, show smears, or
change the graph colors, see Graph View Properties on page 162.

To select a peak on the graph, move the cursor near the peak and
click. A blue arrow above the peak shows that the peak is selected,
and the cursor changes to an up arrow. The Gel View and Peak
Table View also select the corresponding entry.

To adjust the peak baselines from the graph view, see Adjusting the
Peak Baseline on page 69.

Graph View Shortcut Menus

Right-Click Menu (not near a peak)
Right-click away from a peak in the graph to display a shortcut
menu containing the following commands:

Synchronize Zoom - When selected, the zoom level of all peaks
are the same. When cleared, zooming in on one peak will not
change the zoom level of the other peaks.

Unzoom - Zooms out to the previous zoom level.
Unzoom All - Zooms out and returns to the standard view.

Set Scale - Opens the Set Graph Scales window to specify the X
and Y ranges to show on the graph.

Scale to Sample Peaks - Scales the view to the minimum and
maximum X values of the current sample peaks. Marker and/or
system peaks are ignored.

Scale to All Peaks - Scales the view to the minimum and maximum
X values of the all peaks, including marker peaks and system
peaks.

Manual Baseline or <SHIFT> + LBUTTON - Turns Manual
Baseline mode on or off. If selected, click and drag the mouse on
the graph to creates a new manual baseline for the peaks.

Merge Peaks or <ALT> + LBUTTON - Turns Peak Merge mode on
or off. If selected, click and drag the mouse across two or more
peaks to merge the peaks into one.

Copy - Copies the selected graph to the clipboard in a BMP format.
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Graph View (Continued)
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Split Peak - Splits a single peak into two separate peaks.

Analysis Settings - Opens the Assay Analysis Window to change
the analysis settings.

Right-Click Menu (near a peak)

Right-click above or below a peak in the graph to display a shortcut
menu containing the following commands:

Exclude Peak - Excludes the peak from the analysis. (The Peak
Type label displays X.)

Include Peak - Includes an excluded peak in the analysis. Only
available when the selected peak is already excluded or is type
System Peak or “?”. Including the peak will compute the peak
properties, populate the peak table, and include the peak in the
area total used for the %Purity calculation.

Force Lower Marker - Defines the selected peak as the Lower
Marker. (The Peak Type label displays LM*.)

Clear Forced Lower Marker - Allows the analysis to determine the
lower marker. (The Peak Type label for the calculated lower marker
displays LM.) Only available when the selected peak is a Forced
Lower Marker.

Force Upper Marker - (DNA Assays only) Defines the selected
peak as the Upper Marker. (The Peak Type label displays UM*.)

Clear Forced Upper Marker - (DNA Assays only) Allows the
analysis to determine the upper marker. (The Peak Type label for
the calculated upper marker displays UM.) Only available when the
selected peak is a Forced Upper Marker.

Add Expected Peak - Opens the Add New Expected Peak Window
to add a new Expected Peak to the specified wells.

Force Expected Peak - Defines the selected peak as the specified
Expected Fragment or Protein. A list of all of the defined Expected
Peaks displays beside the shortcut menu. Select the desired
Expected Peak from the list.

Clear Forced EP - Clears the forced peak and allows the analysis
to determine the expected peak.

Right-Click Menu (at the bottom of an RNA peak)

Right-click near the bottom of a peak in the graph for an RNA assay
to display a shortcut menu containing the following commands:

Reset to Defaults - Sets the Peak Baseline endpoints back to the
default values.
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Overlay Electropherograms Tab
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Use the Overlay Electropherograms tab on the Graph View to view
a single graph or multiple graphs overlaid on top of each other. (Not
available for NAQuant NGS assays.)

If the Overlay Electropherograms Tab is not open, select the
Collection > Layout on the Menu Bar, select the location where
you want to display the Overlay Electropherograms tab, and click
the Apply button.

Overlay Electropherogram
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Figure 75. Overlay Electropherograms Tab

The sample list at the upper right displays the name of each sample
and the color assigned to the graph for each sample. If only one
graph is displayed, the Gel View, Well Table View, and Plate View
or Plate List all show the same selected well.

The gel lanes selected in the Gel View are synchronized with the
graphs displayed in the Overlay Electropherograms tab.

For information on changing the view in the Overlay
Electropherograms tab, see Viewing Graphs in the Overlay
Electropherograms Tab on page 86.

See Graph View Properties on page 162 for descriptions of the
properties that can be set for the Overlay Electropherograms tab.
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Fluorescence Intensity Tab
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Use the Fluorescence Intensity tab on the Graph View to view the
graph of a single well in an NAQuant NGS assay. NAQuant NGS
wells only display data from 33 seconds to 37 seconds for each
sample.

P Fluorescence Intensity N s B s s e o S B

[Demo NAQuant NGS/A2] NGS3 J -
3754
3704

I @
S 365

0
wr -
] -
5 ]
Z 3804
355 -
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33 335 34 M5 3 355 36 365 37
Time (sec) . ¢

Figure 76. Fluorescence Intensity Tab

Selecting a well in the Well Table View, Plate View or Plate List
displays the same well in the Fluorescence Intensity tab.

For information on viewing a data in the Fluorescence Intensity tab,
see Viewing Graphs in the Fluorescence Intensity Tab on page 90.
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Electropherograms Tab

Use the Electropherograms tab on the Graph View to view a single
graph or multiple graphs in the same tab. (Not available for
NAQuant NGS assays.)

If the Electropherograms Tab is not open, select the Collection >
Layout on the Menu Bar, select the location where you want to
display the Electropherograms tab, and click the Apply button.
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Figure 77. Electropherograms Tab

Each graph displays the data file name and well name at the top of
the graph.

For information on changing the view properties in the
Electropherograms tab, see Viewing Graphs in the
Electropherograms Tab on page 88.

See Graph View Properties on page 162 for descriptions of the
properties that can be set for the Electropherograms tab.

PN CLS151165 Rev H LabChip GX Reviewer User Manual



Software Reference 162

Graph View Properties

To view the Properties for the Electropherograms Tab or the
Overlay Electropherograms Tab, click the Properties tab on the
right side of the Graph View. (Not available for NAQuant NGS
assays.)
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Figure 78. Electropherograms Properties and Overlay
Electropherograms Properties

This window contains the following options:

Option

Function

Layout

Specifies the number of rows and columns of graphs displayed
on the Electropherograms Tab. (Only displayed when the
Electropherograms tab is selected.)

PN CLS151165 Rev H

Annotation 1

Labels each peak in the graph with the peak property selected
from the drop-down list. Default is Type.

The Annotations available depend on the columns selected in
the Peak Table View.
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Option

Function

Text Orientation
(A) button

Specifies the orientation of the text for the annotation: horizontal,
vertical up, or vertical down.

Set Font button

Opens the Font window to choose the font, style, and size of the
text for all annotations.

Annotation 2

Labels each peak in the graph with a peak property selected
from the drop-down list. Default is none.

Peak Annotation
Legend

If selected, the types of the annotations display in the upper left
corner of the graph.

Well Annotation

Displays the selected well property outside the graph. Only the
columns displayed in the Well Table View are available for
selection.

Well Annotation
Location Button
(arrow)

The location of the well annotation. Click the button to change
the location: upper right, upper left, lower left, or lower right.

Show Data Points

If selected, displays a dot on the graph at the location of each
data point.

Show Peak
Baselines

If selected, displays the baseline for each peak on the graph.

Show Smears

If selected, displays smears as a colored line on the trace and
displays the smear baseline. This option only displays if smears
are defined in the Assay Analysis Window.

Only Annotate
Expected Peaks

If selected, only the peaks that are labeled as Expected
Fragments, Expected Proteins or Expected Glycans display the
annotations. If not selected, all peaks display the annotations.

Graph Selected

If selected, only the wells selected in the Gel View or Well Table

Gels Only View are displayed in the Electropherograms tab. If not selected,
all wells in the collection are displayed. (Only displayed when
the Electropherograms tab is selected.)

Sample Displays the names of the samples (well names) on the graph

Name/Color and the color associated with each sample (well). Click on the

Table color to choose a different color for a sample.

X Axis Scale Specifies the units displayed on the X Axis, either Time, Size, or
Log Size. Log Size displays the size on a logarithmic scale.

Grid Style Displays grid lines on the graph: vertical, horizontal, both, or

none. Click the button to cycle through the grid options.

Data Legend
Location

If multiple wells are displayed in the Overlay Electropherograms
tab, specifies the location where the legend displays on the
graph. The legend shows the color used for each well. (Only for
the Overlay Electropherograms Tab.)
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Option

Function

Overlay Offset

Offsets each of the graphs by the RFU value specified.

Title Font

Opens the Font window to select the Font, Font Style, Font Size,
and Effects for the title above the graphs in the
Electropherograms tab or the Overlay Electropherograms tab.
The selected font is also used when exporting the graphs.

Pin icon

In the top right corner, this is used to lock in place or unlock the
Properties tab. If locked in place, the Graph is resized to
accommodate the tab.
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Gel View
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The Gel view in the Collection Pane is a visual representation of the
data formatted to look like the Gel slabs that were originally used to
provide DNA, Protein, or RNA data. The data is shown in Time vs.
Fluorescence (or digital form). (Not available for NAQuant NGS
assays.)

Click on a gel lane (well) to select the well. Ctrl + click to select
multiple wells. Selected wells are outlined with a dotted gray line.
Wells selected in the Gel view are also selected in the Well Table
View and are displayed in the Overlay Electropherograms Tab.
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Figure 79. Gel View

Moving the cursor over a band in the Gel view displays a tool tip
that includes the same information about the peak as the Peak
Table View. (Changing the columns displayed in the Peak Table will
change the contents of the tool tip in the Gel view.)

For DNA assays, the upper and lower markers of all wells are
aligned to the upper and lower markers of the first well in the gel
view. For Protein and RNA assays, the lower markers of all wells
are aligned to the markers of the first well in the gel view.
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Figure 80. Gel Headers
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Gel View (Continued)
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A colored column header indicates that the well is selected by a
filter. Click the Filter View to view the color of each filter. A red
exclamation point under the header indicates an analysis error
occurred in the well. A yellow exclamation point under the header
indicates an analysis warning occurred in the well. A gray header
indicates a normal well. To change the size of the gel header, click
on the border between the header and the well and drag the header
to the desired size.

Expected Peaks are indicated on the gel by colored horizontal
lines.

The graphs displayed in the Graph View are synchronized with the
lanes selected in the Gel tab.

You can drag-and-drop the gel lanes to change the order of the
wells for comparing two or more gel wells. To drag-and-drop a gel
lane, click in the header of the lane to be moved and drag the gel
lane to the desired location.

Double-click in the Gel view to zoom out to the previous zoom level.

Gel data can be exported to a graphic file by choosing Export on
the File Menu (see Exporting Data on page 102 for details). If the
workspace contains multiple collections, data is exported from the
active/selected collection.

To change the Lane Width or Gel Contrast Range, see Gel View
Properties.

Right-Click Menu

Right-click anywhere in a gel to display a shortcut menu containing
the following commands:

Unzoom - Zooms out to the previous zoom level.

Unzoom All - Zooms out completely and returns to the standard
view.

Scale Gel Contrast to this Lane - If selected for a lane, the
minimum and maximum RFU values for all lanes in the collection
are set to the minimum and maximum RFU values in the selected
lane.

Scale Gel Contrast to Collection - Restores the minimum and
maximum RFU values for all lanes in the collection to the default
values. (Only available when Scale Gel Contrast to This Lane has
been selected for a lane.)
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Gel View (Continued)
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Remove - Removes the sample from the collection.

Copy Gel - Copies all of the open lanes (wells) to the clipboard in a
.bmp format.

Copy Lane - Copies the selected lane (well) to the clipboard in a
.bmp format.

Analysis Settings - Opens the Assay Analysis Window to change
the analysis settings.

Edit Sample Name - Opens the Sample Name Editor Window to
change the well name or add a comment to the well. The comment
displays in the Well Table View and in printed reports.

Rename Plate - Opens the Rename Plate window to specify a new
name for the plate.
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Gel View Properties

To view the Gel View Properties, click the Properties tab on the
right side of the Gel View. (Not available for NAQuant NGS assays.)

Properties ~ R
~Lane Width
o futo fit

—

~Gel Contrast Range——,

]
EI
Min. Max.
(|

~Gel Color———————

Foreground
Background

(" Set Lane Label Fort )

W Show Peak Information
W Show Expected Peaks

|| Show Expected Peaks Legend
|| Show Fitter Legend

Figure 81. Gel View Properties

The following properties can be set for the Gel view:

Option

Function

Lane Width

Sets the width of the Collection column. Select Auto Fit to have the
software automatically fit all the data, or use the slider to manually
set the width.

Gel Contrast
Range

Sets the minimum and maximum Gel Band Contrast for the bands
in each well. Use the sliders to change the min and max values.

Gel Color

Click on the Foreground color or the Background color to open the
Color window to choose the desired colors for the gel.

Set Lane Label
Font button

Opens the Font window to change the font or size of the labels in
the gel headers.

Show Peak
Information

If selected, displays peak information in a tool tip when the cursor
moves over a peak. If not selected, the tool tip does not display
when the cursor is over a peak.

Show EPs and

If selected, expected peaks are indicated in the gel by colored

Smears horizontal lines and smears are indicated by bands of translucent
color.
Show EP/ Displays a legend of the band colors and expected peak sizes or

Smear Legend

smear sizes in the Gel view. Click and drag to move the legend.
Only displays if Expected Peaks or Smears are defined in the
Assay Analysis Window.
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Option

Function

Show Filter
Legend

Displays a legend of the colors assigned to each filter. Click and
drag to move the legend. Only displays if at least one filter is
defined in the Filter View.

Pin icon

In the top right corner, this is used to lock in place or unlock the
Properties tab. If locked in place, the Gel display panel is resized to
accommodate the tab.
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Well Table View

The Well Table view in the Collection Pane contains a summary of
analysis results for the wells selected from the plates in the
collection.
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Figure 82. Well Table View

To change the order of columns in the table, click on a column
header and drag the column to the desired position in the table.
Click a column header to sort the table in ascending/ descending/
original order.

Click to select a single well, Shift + click to select multiple wells.

Double-click on a Plate Name to open the Rename Plate window to
rename the plate. Double-click on a Sample Name to edit the well
name. Double-click on a User Comment to add or edit the User
Comment (if applicable).

For gDNA assays, the Total gDNA Concentration in the Well Table
is the concentration of the entire smear region from 0.175kb to
300kb. Use the Smear Analysis Tab to change settings or display
columns in the Well Table.

For Protein Clear HR assays, the Total Conc. (ng/ul) column will
not display.

The output of an exported Well Table includes the columns in the
order displayed in the Well Table at export time. A Well Table is
exported to a CSV format, which can be opened in a program such
as Microsoft® Excel. If the workspace contains multiple collections,
the data is exported from the active/selected collection.
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Select Well Table Columns Window

Use the Select Well Table Columns window to show or hide
columns in the Well Table View. To open the Select Well Table
window, right-click on a column header in the Well Table.

The Select Well Table Columns window displays all available
columns with the current selections in the Selected Columns list.
The columns available depend on the type of data file that is open
and the selected analysis settings.

Selected Columns: Available Columns:

Plate Name Analysis Error

Well Label Barcode

Sample Name Chip D

Peak Count Date_Time

Total Conc. {nglul) Expected Peak Count

EP72 Filter Match

L100 Filtered Peak Count

EP118 Instrument Name

EP1584 Ladder Quality Score

EPZ234 L Lower Marker Height

EP271 Lower Marker Time(sec)

EP281 Plate File

L300 Plate Number

EP310 Signal Moise

L500 Upper Marker Height

EPG03 Upper Marker Time(zec)
EET

Figure 83. Select Well Table Columns Window

Show or hide columns in the well table by moving the column
names between the Available Columns list and the Selected
Columns list.

To change the order of the columns displayed in the Well Table,
drag and drop the column names in the Selected Columns list. The
columns display on the order listed in the Selected Columns list.
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Peak Table View
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The Peak Table view in the Collection Pane is a text-based
representation of all the information about each peak. The Peak
Table View is hidden by default for gDNA assays. (Not available for
NAQuant NGS assays.)
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Figure 84. Peak Table View

Change the order of columns in the table by clicking on a column
header and dragging the column to the desired position in the table.
Click a column header to sort the table in ascending/ descending/
original order.

To view or hide columns in the Peak Table view, right-click on the
column headers in the table. The Select Peak Table Columns
window displays all available columns in the Selected Columns list.
Show or hide columns in the Peak Table by moving the column
names between the Available Columns list and the Selected
Columns list in the Select Peak Table Columns window. Drag and
drop the column names in the Selected Columns list to change the
order of the columns displayed in the Peak Table.

The analysis normally labels the upper marker (UM) (DNA Assays
only) and lower marker (LM) in each sample and in the ladder. The
labels display in the Type column of the table. If the analysis has
misidentified the markers, the correct marker can be selected
manually by right-clicking on the peak row to open a shortcut menu
of possible peak types for the peak. This can also be used to label a
peak as Excluded (X). The concentration of an excluded peak is
forced to zero so that it does not affect the total well concentration
and the %Purity calculation.

Expected Peaks are indicated by the Expected Peak Name in the
Type column.
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Peak Table View (Continued)

The output of an exported Peak Table includes the columns in the
order displayed in the Peak Table at export time. A Peak Table is
exported to a CSV format, which can be imported into a program
such as Microsoft® Excel®. If the workspace contains multiple
collections, the data is exported from the active/selected collection.

To show only filtered peaks, sort within each well, or hide excluded
peaks, see Peak Table Properties.

Peak Table Columns
The Peak Table can display the following columns:

%Area - (Glycan assay only) The peak's area as a percentage of
the total area of peaks within the sample range (> 6.6 CGU).

% of Total Area - (RNA assays only) The area of the RNA fragment
divided by the total area. The total RNA area is computed using
trapezoidal integration of the electropherogram from the end of the
lower marker to the baseline end time. The baseline for the total
area is a straight line drawn from the baseline start time to the
baseline end time. The height of the baseline at these points is the
average signal value over a 5 second region around these points.

% Purity - (Protein assay only) The quantity of protein, expressed
as a percentage of the total protein, found in a particular peak.

Aligned Area - If the sample has been aligned, the area of the
aligned peaks is reported.

Area - The peak area is calculated as the sum of the parallelograms
of a point-to-point fit down to absolute zero minus the parallelogram
of the local baseline down to absolute zero. Data points are 0.05
seconds apart.

Barcode - The barcode on the plate used in the run (if your
instrument is equipped with a barcode reader).

Baseline - The center average height of the peak baseline,
measured in RFUs.

Chip ID - The ID number of the Chip used to run the plate.
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Peak Table View (Continued)
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Comment - Displays any comments associated with the well, either
from the Sample Name File specified during the run or from the
Sample Name Editor Window.

Conc. (ng/uL) - (DNA and Protein assays except for Protein Clear
HR assay) - The concentration calculated relative to the ladder and
marker peak concentrations. The ladder concentration is displayed
in the Analysis Tab of the Assay Analysis Window.

Corr. Area (Glycan assays) and Time Corr. Area (Protein assays) -
Displays the mobility corrected area. The area of a peak should
represent the total area of the compound responsible for the
fluorescence. In the LabChip instruments, the fluorescence of the
compound moving past the detector is sampled at constant time
intervals unlike the conventional slab gel where the compound is
spread out spatially and imaged at a single time. To convert from a
peak area integrated in the time dimension to one integrated in the
space dimension, we use the fact that x is proportional to pt so Ax
a PAt and the mobility p is proportional to 1/T where T is the
migration time of the peak. So the Time Corr Area = 100 * Area/T.
The 100 is an arbitrary constant designed to keep the corrected
area in a range similar to the original area computed from the time
series data.

Date_Time - The date and time that the plate data file was created.

Expected Fragment (BP or kb)/ Expected Protein (kDa)/
Expected Glycan (CGU) - Displays the size of the Expected
Fragments, Expected Proteins, or Expected Glycan.

Fragment Area - (RNA assays only) The sum of the trapezoids
between the fragment start and end times. The trapezoid base is a
line drawn across the fragment base from the start point to the end
point.

Fragment End (sec) - (RNA assays only) Amount of time from
injection to the falling edge of the fragment in seconds.

Fragment Start (sec) - (RNA assays only) Amount of time from
injection to the leading edge of the fragment in seconds.

FWHM - The width of the peak (Full Width at Half Maximum),
measured in seconds.

Height - The value at the apex of the peak minus the local baseline
start value.

Instrument Name - The name of the instrument that was used to
run the plate and create the data file.
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Peak Table View (Continued)
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Molarity (nmol/l) - (DNA and gDNA assays only) Displays the
molarity of the peak.

Migration Time (sec) - Start - The time from injection to the start of
the peak in seconds.

Migration Time (sec)- End - The time from injection to the end of
the peak in seconds.

Migration Time - Center - The time from injection to the peak apex
in seconds.

Peak Index - The index number of the peaks in the sample. Marker
peaks, peaks before the lower marker, and peaks after the upper
marker are not numbered.

Peak Number - The order in which the peaks were detected for
each well. All peaks in each well are numbered, starting at 1.

Plate File - The name of the original plate data file. This name
cannot be changed.

Plate Name - The name of the plate defined in the workspace.

Plate Number - The number of the plate in the same order as the
plates are displayed in the Plate View or Plate List.

RNA Fragment - (RNA assays only) The name of the fragment
based on its size falling within a certain range set in the assay
definition. (These definitions are visible only to assay developers).

Sample Name - The Sample Name defined in the Sample Name
File specified during the run. The Sample Name can also be
changed in the Well Table View or the Gel View.

Signal noise - The statistical standard deviation of 1 second of
data just before the Peak Find Start Time.

Size (BP for DNA assays, kb for gDNA assays, KDa for Protein
assays, nt for RNA assays, CGU for Glycan assays) - The size
of the peak based on the ladder sizes specified in the assay.

Type - Displays the type of peak for markers or expected peaks.

Well Label - The row letter and column number of the well (A1 -
H12 for 96-well plates, or A1 - P24 for 384-well plates).

Well Number - The number of the well in the same order as the
wells were selected in the collection. See Selecting the Wells in a
Collection.
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Peak Table View Shortcut Menus
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Right-click on a peak in the peak table to display a shortcut menu
containing the following commands:

 Exclude Peak

* Include Peak (for excluded peaks, peaks of type "?", or System
Peaks in Protein assays)

» Force Lower Marker
* Force Upper Marker (DNA assays only)

* Force Expected Peak

NOTE: Excluding a peak or manually setting a peak to be an upper
or lower marker can cause analysis errors.
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Peak Table Properties

To view the Peak Table Properties, click the Properties tab on the
right side of the Peak Table View. (Not available for NAQuant NGS
assays.)

Properties - =

=adold

B Sort within each well
[ Hide excluded peaks

Peaks Displayed
() Expected Peaks Only
() Fittered Peaks Only
© Show Al Peaks

Wells Displayed
(O Selected in Gel

© Entire collection

Figure 85. Peak Table Properties

This window contains the following options:

Option Function
Sort within If selected (default), sorting occurs only within each well rather
each well than across the entire table. Click a column header to sort the

table rows by the column value. If cleared, uses conventional
sorting, which mixes together peaks from all wells. Clicking the
column header sorts in ascending/descending/original order.

Hide excluded
peaks

If selected, excluded peaks and unknown peaks are hidden in the
Peak Table view. In protein assays, the analysis excludes system
peaks, which are compounds that are artifacts of the assay
chemistry and not generally of interest.

Expected
Peaks only

If selected, only peaks identified as Expected Peaks display in the
Peak Table.

Filtered peaks
only

If selected, the Peak Table displays only peaks that match the filter
criteria. Useful when generating a collection based on a filter
whose selection criteria are peak specific, such as Area,
Concentration, %Purity, Expected Peaks, and Size.

Selected in Gel

If selected, only the gel lanes selected in the Gel View display. To
select multiple wells, Ctrl + click on the lanes in the Gel view.

PN CLS151165 Rev H

Entire If selected, all wells in all plates that are included in the collection
Collection are displayed.
Pin icon In the top right corner, used to lock in place or unlock the

Properties tab. If locked in place, the Peak Table display panel is
resized to accommodate the tab.
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Filter View
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The Filter view in the Collection Pane is used to define criteria to
select wells for a collection automatically. The filter types available
depend on the type of assay that was used to create the data. Each
filter can be assigned a different color to determine which filter
applies to each well.
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Figure 86. Filter View

Quadrant check boxes - The selected quadrants of all plates in the
collection will have the specified filters applied to them. Selecting a
quadrant check box applies the selected filters to that quadrant.
Clearing a quadrant check box excludes that quadrant from all
filters.

Ladder(s) check boxes - If selected, ladder wells are filtered. If
cleared, ladders are not filtered.

Filter Plate Diagram - Only the wells selected in blue have the filter
applied. Wells that are not selected (white) will not be selected by a
filter.

Filter Options - determines how multiple filters are logically
combined. The options available are OR, AND(Peak), and
AND(Well).

*+ OR - Selects any well that contains a peak that matches any of
the filters selected in the Available Filters list.

* AND(Peak) - Selects any well that contains a single peak that
matches all of the filters selected in the Available Filters list.
(Not available for NAQuant NGS assays.)
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* AND(Well) - Selects any well that contains peaks that match all
of the filters selected in the Available Filters list. Different peaks
in the same well can match different filters, as long as all filter
conditions are met in the same well.

Available Filters list box - Displays all of the filters that are part of
the current workspace. The check box next to each filter in the list is
used to include or exclude that filter from the analysis in the
collection.

Filter Type drop-down list - Specifies the Type of each filter.
Available options depend on the assay used to create the data.

Color button - Displays the color selected for the filter. To select a
different color, click the Color button to open the Color window.

Filter Criteria - The appropriate filter criteria options display based
on the type of filter selected. Numeric value operators are Equal To
(with percent threshold), Between, Less Than, or Greater Than.
Text expressions can contain wild cards. Expected Peaks criteria
specify expected peaks in a well.

Add button - Creates a new filter with the specified filter criteria
and adds the new filter to the Available Filters list.

Remove button - Deletes the filter selected in the Available Filters
list from the workspace.

Search Data Files button - Opens the Search for Plate Matching
Filter window to search a specified folder for any plates that include
wells matching the selected filters. See Searching Data Files Using
a Filter on page 53 for more information.

Update button - Updates the filter selected in the Available Filters
list with the specified filter criteria. Only available if the filter criteria
has changed.
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AAV Analysis Window

Use the AAV Assay Analysis window to view the results of AAV
Empty/Full assays and to set the Assay Analysis settings for the
AAV DN DNA and AAV Pico Protein assays. To open the AAV
Analysis window, select Analysis > AAV Analysis on the LabChip
GX Reviewer Main Window after selecting the AAV DNA and AAV
Protein assays (see Viewing AAV Empty/Full Assay Results on
page 79).

AAV Analysis — u] X
AAV Analysis  Protein Settings  DNA Settings
AAV DNA [
AAV Standard % Full Protein [Z] DNA [ Empty/Full

Wel Label
Protein o

v ssDNA ssDNA
Dyl L2 Sample Name DNA AMSec) ComSze  PeakTipe  Agned ol
nt] Area

< >

N T
Figure 87. AAV Analysis Window

The AAV Analysis Window contains the following tabs:
* AAV Analysis Tab on page 181

* Protein Settings Tab on page 184

* DNA Settings Tab on page 185

The AAV Analysis Window contains the following buttons:

Clear button - Clears the selected AAV Dn DNA assay and AAV
Pico Protein assay. See Viewing AAV Empty/Full Assay Results on
page 79 to set new AAV DN DNA and AAV Pico Protein plates for
AAV Analysis after clearing the data files.

Export button - Exports the data shown on the AAV Analysis Tab to
a CSV file.

Close button - Saves the settings and closes the AAV Analysis
window.
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AAV Analysis Tab

Use the AAV Analysis Tab on the AAV Analysis Window to view the
DNA, Protein, and Empty/Full data. Empty/Full data is only available
after the AAV DN DNA and AAV Pico Protein data files are selected
and you click the Calculate button. (See Viewing AAV Empty/Full
Assay Results on page 79 for instructions.) To open the AAV
Analysis tab, select Analysis > AAV Analysis on the LabChip GX
Reviewer Main Window to open the AAV Analysis Window, and then
click the AAV Analysis tab.
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Figure 88. AAV Analysis Tab
The AAV Analysis tab contains the following parameters:

AAV Protein text box - Displays the name of the AAV Pico Protein
assay used for analysis. (Read only.)

AAV DN DNA text box - Displays the name of the AAV DN DNA
assay used for analysis. (Read only.)

AAV Standard % Full text box - Specifies the percent full of the
AAV Standard for analysis. (Specified on the AAV Standard label.)

Calculate button - After selecting the AAV DN DNA assay and AAV
Pico Protein assay, finds the peaks using the settings on the Protein

Settings and DNA Settings tabs, calculates the % AAV Full, %
Empty Capsids, and % DNA Impurities for each sample, and
displays the data in the data table.
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AAV Analysis Tab (Continued)
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Protein check box - If selected, the Protein data displays in the
data table (Well Label Protein, Sample Name Protein, VP3 Time,
VP3 Corr Area, VP2 Corr Area, VP1 Corr Area, VP3/VP1 Area
Ratio, and VP2/VP1 Area Ratio).

DNA check box - If selected, the DNA data displays in the data
table (Well Label DNA, Sample Name DNA, ssDNA Time, ssDNA
Corr. Size, Peak Type, ssDNA Aligned Area, % DNA Impurities).

Empty/Full check box - If selected, the Empty/Full data displays in
the data table (Well Label DNA, Sample Name DNA, Well Label
Protein, Sample Name Protein, % AAV Full, % Empty Capsids).

Data table columns:
Well Label DNA - Displays the well label of the DNA sample.

Sample Name DNA - Displays the sample name of the DNA
sample assigned using either a Sample Names File or using the
well name.

ssDNA Time - Displays the time at which the ssDNA peak was
detected using the analysis criteria in the DNA Settings Tab.

ssDNA Corr. Size - Displays the corrected size of the ssDNA
fragment, using the ladder to size the fragments.

Peak Type - Displays the type of peak, either ssDNA or Partial
Peak. To specify the peak type, right click on the peak in the

Electropherogram tab, select Force Expected Fragment, and then
choose ssDNA or Partial.

ssDNA Aligned Area - Displays the area under the ssDNA curve,
aligned using the ladder.

Well Label Protein - Displays the well label of the protein sample.

Sample Name Protein - Displays the sample name of the protein
sample assigned using either a Sample Names File or using the
well name.

VP3 Time - Displays the time for the VP3 peak in the AAV Pico
Protein assay.

VP3 Corr Area - Displays the area under the VP3 curve divided by
the peak migration time.

VP2 Corr Area - Displays the area under the VP2 curve divided by
the peak migration time.
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AAV Analysis Tab (Continued)
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VP1 Corr Area - Displays the area under the VP1 curve divided by
the peak migration time.

VP3/VP1 Area Ratio - Displays the area under VP3 divided by the
area under VP1.

VP2/VP1 Area Ratio - Displays the area under VP2 divided by the
area under VP1.

% AAV Full - Displays the percent of AAV capsids containing
ssDNA. Displays “NA” if there is no data for the sample in either the
AAV Empty/Full DNA or AAV Empty/Full Protein Assay.

% Empty Capsids - Displays the percent of AAV capsids that do
not contain ssDNA, ssDNA Partial capsids, or DNA Impurities.

% Empty Capsids = 100% - % AAV Full - % AAV Full (Partial).
Partial Peaks occur earlier than the ssDNA Peak and contain
fractions of the ssDNA with a lower molecular weight.)

Displays “NA” if there is no data for the sample in either the AAV
Empty/Full DNA or AAV Empty/Full Protein Assay.

% DNA Impurities - Displays the percent of high or low molecular
weight nucleic acid impurities.

%DNA Impurities = Aligned Area of DNA Impurities/(Aligned Area of
DNA Impurities + Aligned Area of ssDNA Full+ Aligned Area of
ssDNA Partial)*100.

Displays “NA” if there is no data for the sample in either the AAV DN
DNA or AAV Pico Protein Assay
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Protein Settings Tab
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Use the Protein Settings tab on the AAV Analysis Window to
specify the Peak Find settings for the AAV Pico Protein assay. To
open the Protein Settings tab, select Analysis > AAV Analysis on
the LabChip GX Reviewer Main Window to open the AAV Analysis
Window, and then click the Protein Settings tab.

AAV Analysis 5~ m] X

AAV Analysis Protein Seftings  DNA Settings
VP31 Peak Finding

@ Size Based Peak Findng (O Time Based Peak Finding

Peak Size (KDa): Migration Time (Sec):
80 2]+~ 10 & % Window 2% 2] - [10 2] % Window

VP2and VP 1 Peak Finding
Time Window(Sec): [3

Search for VP2 and VP 1 peaks in the above time window after VP3 peak

Apply

T B

Figure 89. Protein Settings Tab

The Protein Settings tab contains the following settings:
VP3 Peak Finding
Size Based Peak Finding - If selected, the VP3 peak is identified

based on the peak size rather than by the migration time.

» Peak Size text box - Specifies the peak size, in KDa, to look for
the VP3 peak.

* % Window text box - Specifies the percent of size above or
below the specified peak size to identify the VP3 peak.

Time Based Peak Finding - If selected, the VP3 peak is identified

based on the migration time rather than the peak size.

* Migration Time text box - Specifies the migration time at which
to look for the VP3 peak.

* % Window text box - Specifies the percent of time above or
below the specified migration time to identify the VP3 peak.

VP2 and VP1 Peak Finding

Time Window (Sec) text box - Specifies the time in seconds within
which to find the VP2 and VP1 peaks after the VP3 peak.
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DNA Settings Tab

Use the DNA Settings tab on the AAV Analysis Window to specify
the Peak Find settings for the AAV DN DNA assay. To open the
DNA Settings tab, select Analysis > AAV Analysis on the LabChip
GX Reviewer Main Window to open the AAV Analysis Window, and
then click the DNA Settings tab.

AAV Analysis — O X
AAV Analysis Protein Settings DNA Settings
Sizing Ladder Settings
ssDNA Peak Size (Knt)in Standard: ® Ladderl
33 i O Ladder2
ssDNA Peak Finding
Migration Time (Sec):
50 =+~ 20 S % Window
Foply

Figure 90. DNA Settings Tab

Sizing

+ ssDNA Peak Size (kb) in Standard - Specifies the peak size of
the ssDNA peak in the AAV Standard.

ssDNA Peak Finding

* Migration Time (Sec) - Specifies the expected migration time,
in seconds, of the ssDNA peak in the samples, within the
specified window as a percent of the migration time.

Ladder Settings

Apply button - Click to apply changes to Sizing and ssDNA Peak
Finding.
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About LabChip GX Reviewer Window

The About LabChip GX Reviewer window displays the software
versions. Selecting About LabChip GX on the Help Menu opens
this window.

About LabChip GX >~

LabChip G Reviewer

W Sollware Version 5.13.636.0

Copyright = 2024, Revvity, Inc.

All ights rezerved. Mo part of this software may be reproduced in any form, or
incorporated in any system, without the written permission of the copyright
oWnNEr,

Figure 91. About LabChip GX Reviewer Window
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Add New Expected Peak Window

Use the Add New Expected Peak Window to add an expected peak
to specific wells. To open this window, right-click near a peak in the
Graph View and select Add Expected Peak. (Not available for
NAQuant NGS assays.)

#5 Add New Expected Peak 55 m} X

Size [BP]

»

Color Name Property Displayed in Well Table  For Aligning Apply to Wells

s [ s v O Al

Window

Figure 92. Add New Expected Peak Window

Column Function

Size Specifies the expected size of the peak in BP for DNA assays, kb for
gDNA assays, kDa for Protein assays, and CGU for Glycan assays.
The default size is the size of the peak that was selected.

Time Specifies the expected time of the peak in seconds. The default is the

time of the peak that was selected. (Only for CZE assays.)

Window (%)

Specifies the tolerance window as a percent of the expected size for
the fragment/protein/glycan to allow for small variations in expected
peak size.

Color Displays the color to use to mark the peak in the Graph View or the
Gel View.

Name Specifies a name to display in the Type description for the peak.

Property Specifies the content of a column added to the well table for each

Displayed in | expected peak.

Well Table

For Aligning | If selected, the data signal is realigned so the selected expected
peaks match their aligned size. Note that incorrect alignment settings
can cause analysis errors.

Apply to Specifies the wells that the expected peak is applied to. <All>

Wells specifies that the expected peak applies to all wells. Clicking on the

column opens the Select Wells window to choose the specific wells to
apply the expected peak to.
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Assay Analysis Window

The Assay Analysis window specifies the analysis parameters to
use when analyzing the data from a completed run. Analysis
parameters include alignment, peak find, expected/excluded peaks,
smears, titers, and replicates. To open the Assay Analysis window,
select Analysis > Analysis Settings on the main menu. (Not
available for NAQuant NGS assays.)

The Assay Editor window is used to create or edit assays that will
be used to run the samples on the LabChip instruments and
contains all of the same tabs except the Alignment tab. Alignment
can only be performed after the data has been acquired.

The Assay Analysis window contains the following tabs:

* Assay Info Tab

+ Alignment Tab

* Analysis Tab

*+ Peak Find Tab

* Expected Fragments/Proteins/Glycans Tab

* Excluded Peaks Tab

* Smear Analysis Tab

+ Titer Tab

* Replicates Tab

* Advanced Tab

The Assay Analysis window contains the following buttons at the
bottom of the window:

Button Function

Apply Apply setting changes and re-analyze the plate but keep the Assay
Analysis window open.

Apply Applies the selected analysis settings to all plates in the open

Global workspace.

Export As | Opens the Export Assay Settings from Plate to Assay file window to

Assay specify a name and location for a new assay file (*.asy or *.asyx).
Clicking Save creates a new assay file with the settings in the Assay
Analysis Window.

Restore Opens the Restore Plate Settings To Version window to restore the data

Plate file to the selected version.

OK Apply changes in the Assay Analysis window and re-analyze the plate

with these new settings.
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Button

Function

Print
Preview

Opens the Print Preview window to view the analysis settings before
printing.

Print

Opens the Print window to print the analysis settings.

Cancel

Restores the settings that were selected when the window was opened
or when the last Apply was performed. No re-analysis is performed
because the settings were used for the last analysis performed.

The Assay Editor window contains the following buttons at the
bottom of the window:

Button

Function

Save
Assay

Opens the Select Assay To Edit window or the CDR Manager window
(LabChip GxP option) to specify the name and location of the saved
assay file.

Restore
Assay

Discards all changes to the assay and resets the window to the saved
assay settings.

Close

Closes the Assay Editor window without saving changes to the assay. If
there are unsaved changes, you are prompted to discard the changes.
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Assay Info Tab

The Assay Info tab on the Assay Analysis Window displays the
header information for the current plate. The information displayed
was specified when the assay was run and cannot be changed. To
open the Assay Info window for NAQuant NGS assays, select
Analysis 2> Assay Info on the main menu.

gl
Assay Info  Mlignment  Analysis Peak Find Expected Fragments Excluded Fragments Smear Analysis  Ther  Replicates  Advanced
Assay Class: DNA1

Mame: HT DNA 12K E

Title: HT DNA 12K Extended Time

Comments:  Copynight 20072009 Caliper Le

Wersion: 1.0 Format: 1.0

Compatibility: 1.0«

Figure 93. Assay Analysis Window - Assay Info Tab

The following read-only information displays:

Option

Function

Assay Class

Displays the assay class assigned to the assay.

Name

The name of the assay.

Title

The title of the assay.

Comments

Comments from the assay that was run.

Version

The version of the assay that was run. A new version of the assay
is saved whenever changes are made to the assay.

Format

The format of the data file.

Compatibility

The version of LabChip GX or GX Touch software that supports
the assay. LabChip GX Reviewer analyzes all assay versions
including LabChip GX Touch assays (5.0+).

Plate

The name of the plate in the workspace. Usually the same as the
name of the data file that was created when the plate was run,
unless the name is changed after it is added to the workspace.
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Alignment Tab
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The Alignment tab on the Assay Analysis Window is used to assign
alternate ladders to a specified group of wells in the event of a
faulty ladder result. The default assignment for full rows uses the
ladder adjacent to the row where the sample is located. If this
ladder cannot be analyzed, the software automatically looks for
another nearby ladder to perform the analysis. The actual ladder
used for the analysis is shown in the Well Peak Find Settings panel
of the Peak Find Tab. It can be changed by selecting the “Align
Well Groups to Specified Ladder” option and then selecting a
different ladder in the “To Ladder” column corresponding to the row
to be changed. (Not available for NAQuant NGS assays.)

For Protein, Glycan, and gDNA assays, which do not use an upper
marker, alignment is normally performed with ladders on each end
of the row to compensate for drift between start and end of each
row. This feature can be disabled by selecting “Align Well Groups
to Previous Ladder” or “Align Well Groups to Specified
Ladder” instead of “Align Well Groups to Bracketed Ladder”.

Protein Charge Variant assays do not use ladders to align the data.
The Alignment tab is not shown for Protein Charge Variant assays.

The Alignment tab is not displayed in the Assay Editor window.
Alignment can only be changed after the data file is created.

@ LabChip GX Assay : HT DNA SK(READ ONLY) ] X

Assay Info  Alignment  Analysis Peak Find Expected Fragments Excluded Fragments Smear Analysis Titer  Replicates Advanced
Ladders
(® Aiign Well Groups to Previous Ladder

Align Well Groups to Bracketed Ladders
(O Miign Well Groups to Specified Ladder(s)
Markers

Align to Upper Marker

Align to Lower Marker

Ladder Rejection Threshold 9201:

Plate: | Demo DNA 5K 96 wells

| T en Reso Pt

Figure 94. Assay Analysis Window - Alignment Tab
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Alignment Tab (Continued)
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The Alignment tab contains the following settings:

* Align Well Groups to Previous Ladder - If selected, each row
is aligned to the ladder at the beginning of the row.

» Align Well Groups to Bracketing Ladders - (Protein, Glycan,
and gDNA assays only.) If selected, each row is aligned with the
ladder at the beginning of the row and a ladder at the end of the
row.

+ Align Well Groups to Specified Ladders - If selected, each
row is aligned with the ladder selected in the table.

Markers - Displays the markers that are used for alignment. This
setting is determined by the assay type and cannot be modified.

Ladder Rejection Threshold - Specifies the minimum Ladder
Quality Score required to accept a ladder. If a ladder is below this
threshold, the ladder is flagged as an error well and is not used for
sizing or quantization. Set the value to 0 to turn off this feature.

To view the unaligned data (spike rejected, filtered, and baseline
corrected), select Turn Off Analysis from the Analysis menu.
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Analysis Tab

Use the Analysis tab on the Assay Analysis Window to view the
Upper and/or Lower marker peak designation (this setting cannot
be changed) or to view or change the Ladder Sizes, Ladder
Concentration, Standard Curve (not available for CZE or AAV
Empty/Full assays), Data Range, Marker Concentration (DNA)
Dilution Ratio (Protein), Dilution Correction (DNA and gDNA
assays), and System Peak Exclusion (Protein). Protein Charge
Variant assays only show the Data Range. (Not available for
NAQuant NGS assays.)

a!
Assay Info  Alignment Analysis Peak Find Expscted Fragments Excluded Fragments Smear Analysis Ter  Replicates  Advanced
Ladder Sizes Ladder Concentration Standard Curve Dilution Correction
Sor. [AF] © Foirtto Foirt X 100

4 Ladies J rofd Log Buﬂer/Sam_p\-e_D;Imion
30 () Polynomial Fit No Dilution
500
700
00| Lower

01 | e 500 o000 || WellEnd

Markers Data Range
CDnC.”Q’/\VJlV S'ZE[BP} Baselne 150 sec

2300
4300
7000
10000
20000

Figure 95. Assay Analysis Window - Analysis Tab

Ladder Sizes

A table showing the sizes of the ladder peaks in bp (base pairs) for
DNA, kDa (kiloDaltons) for protein, nt (nucleotides) for RNA, or kb
(kilo base pairs) for gDNA assays. Click in the Size column and type
the desired size to change the ladder size. (not available for Protein
Charge Variant assays.)

Clear Default Ladder button

Displays at the bottom of the Ladder Sizes if a default ladder is
defined for the plate. (Not available for Protein Charge Variant
assays.)

Ladder Concentration
The concentration (in ng/ulL) for the ladder peaks. (Not available for
Glycan or Protein Charge Variant assays.)
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Analysis Tab (Continued)

Standard Curve

Determines whether the fit for the standard curve used to calibrate
migration time to size will be done on a point-to-point, logarithmic,
or Polynomial fit of the ladder. DNA, gDNA, and Glycan assays are
set to point-to-point curve fits but can be changed to Polynomial.
RNA assays are set to point-to-point curve fits but can be changed
to Logarithmic. Protein assays are set to Log and cannot be
changed. (Not available for Protein Charge Variant or AAV
Empty/Full assays.)

Dilution Correction (DNA and gDNA assays only)
Modifies the measured concentration/molarity reported in the peak
table by compensating for sample dilution.

* X - Type the desired correction. The measured
concentration/Molarity is multiplied by this number when
reported.

« Buffer/Sample Dilution - Displays the dilution ratio that
corresponds to the multiplier (X). For example, if X=1, the
Buffer/Sample Dilution=No Dilution, and if X=2, the
Buffer/Sample Dilution=1:1.

Dilution Ratio (Protein assays only)
Used to compensate for differences between sample and ladder
dilutions in the computation of the sample peak concentrations.

* Ladder - Reflects a dilution of ladder in a total volume of ladder
and sample buffer according to the LabChip GX Touch/GXII
Touch Assay User Guide.

* Sample - Reflects a dilution of sample in a total volume of
sample, water, and sample buffer according to the LabChip GX
Touch/GXIl Touch Assay User Guide.

Data Range

+ Baseline - Specifies the time in seconds after the start of the
run after which data is plotted and used for analysis. The data
generated one second before the Baseline value is used to
compute the initial baseline value and baseline noise.

* Well End - Specifies the time when analysis and data plotting
ends.
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Analysis Tab (Continued)
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System Peak Exclusion (Protein and Glycan assays only)
Used to specify the region where System peaks are to be tagged
and excluded from the analysis.

L]

Ladder Ratio - Time at which ladder peaks are detected as
ladder peaks rather than system peaks. For example, if the
ladder ratio is set to 1.5, the software multiplies the lower
marker migration time x 1.5 and then begins ladder peak
identification. In this example, if the lower marker elutes at six
seconds, the ladder peak detection starts at 6x1.5 or 9 seconds.

Min. Sample Size (kDa or CGU) - Size at which peaks are

identified as sample peaks rather than system peaks (except
the Lower Marker).

Markers (DNA, gDNA, and Glycan assays only)

DNA and gDNA assays: The concentration (ng/uL) and size for
the upper and lower markers for the assay.

Glycan assays: The size of the lower marker.

If a default Ladder is defined for the plate, the Marker Migration
Time, Height, and Area are available for editing.
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Peak Find Tab

Use the Peak Find tab on the Assay Analysis Window to adjust
parameters to detect peaks for individual wells, rows, columns, a
single plate, or the entire plate specified in the Plate field. (Not
available for NAQuant NGS assays.)

g LahChip

| Assay Ifo  Mignment Analysis Peak Find  Expected Fragments Excluded Fragments  Smear Analysis Titer  Replicates  Advanced
| Plate Peak Find Settings

| Parameter i Sample i Ladder Baseline Algorithm
Minimum Peak Height 10.0 100 ©) None
Minimum Peak Width {sec) 0.20 0.20 el
{
Slope Threshold (/ssc) 10.00 10.00 @ HAEE
Inflection Threshold (/sec) -10.0 -10.0 © Baseline Subtraction
Start Time (sec) 15.0 15.0 Baseline Curve -
End Time fsec) 200 go O Sdine O Roling Bal
Filter Width (sec) 0.50 0.50
Baseline Plateau (sec) 1.00 0.50 Threshold 20
Polynomial Order [ [
@ High Size Fitering
Fitter Width (gec) 0.30
Transition Time (sec) 450
Minimum Peak Height Minimum Peak Width  Slope Threshold
<lses Plate value> <lses Plate value> <Uses Plate value> _ |
i |
Plate: 12k DNA Demo 4_2009-08-28_01-36-49 !
|
|
. - |
o Pt e |
1]

Figure 96. Assay Analysis Window - Peak Find Tab

Initial individual plate and well selections are made by right-clicking
on a well in the Gel View or the graph in the Graph View and
selecting the Analysis Settings option. The corresponding well
settings are displayed in the Well Peak Find Settings fields.
Subsequent well selections in a plate can be made using the Well
down-down list. The well list includes all the wells on the current
plate that are selected. The Plate and Well Name fields are read
only, and cannot be changed from the Peak Find Tab.
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Peak Find Tab (Continued)

The Peak Find tab contains the following options:
Table 1. Plate Peak Find Settings

Plate

Settings Function

Minimum Specifies the height limit below which a peak is not detected. For

Peak Height |each peak, the difference between the peak start time and the peak
apex must be greater than the Min Peak Height value.

Minimum Specifies the limit (in seconds) for the peak width. Peaks narrower in

Peak Width |time than this value are not detected.

Slope Represents the amount of change in absorbance units over time

Threshold required to indicate that a peak has occurred. This setting is used to
detect the start and end of a peak. Increasing this setting may cause
broad rolling bumps to be ignored or merge multiple bumps into a
single peak. Decreasing this setting will broaden the peaks’ width and
potentially pick up broad bumps as peaks. See Understanding Peak
Finding on page 108 for more information.

Inflection Represents the value that the slope minimum must be below to

Threshold trigger a splitting of the peak. As the threshold is increased, more
peak splitting occurs. See Understanding Peak Finding on page 108
for more information.

Start Time Specifies the time after the start of a run when the first peak will be
detected (any peaks appearing before this time are ignored). The Gel
and Graph views will not plot data earlier than this time.

End Time Specifies the time after which peak detection stops. The Gel and
Graph views will not plot data beyond this time.

Filter Width | Specifies the width, in seconds, of the low pass filter to be convolved
with the data. The width of this filter should be about 6 samples wide
(i.e. 0.1 sec for 60 Hz sampling). If this setting is too large, peaks will
develop spurious side lodes (ringing) due to over-filtering.

Baseline Specifies a baseline selection parameter for peak finding. The signal

Plateau is at baseline whenever the slope of the data is less than the slope
threshold setting (positive or negative) for longer than the Baseline
Plateau. This rejects brief, low slope areas such as in between non-
baseline-resolved peaks.

Polynomial | Afilter algorithm is used to filter the data, increasing the signal-to-

Order noise ratio. The data is convolved with a polynomial of this order to

produce filter data and a filter slope and decrease the background or
baseline noise and/or spikes in the signal. This value is read only.
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Table 1. Plate Peak Find Settings (Continued)

Plate
Settings

Function

Exclude
System
Peaks

(Protein and Glycan assays only) If selected, excludes the system
peak (peak due to buffer constituent) from any changes to the peak
find settings (the most recent custom ladder settings are used
instead).

Baseline
Curve

* none - No correction.

» Zero Baseline - Offsets all graphs to zero baseline but does not
affect analysis.

+ Baseline Subtraction - A dynamic subtraction of the baseline that
corrects for drifting Baseline. Select the desired method for
generating the baseline curve:

— Spline - Creates a smooth line fit to the baseline data
points and subtracts this smooth fit from the data. The
Threshold determines how much the baseline fit follows
changes in the data.

— Rolling Ball - Generates a smooth baseline curve by
mathematically rolling a ball under the sample signal,
keeping it in contact with the closest signal point without
crossing into the signal. Time Diameter and Signal
Diameter determine the smoothness of the curve in the
Time and Signal axes. (See Rolling Ball Baseline Curve
Example on page 293 for more information.)

High Size
Filtering

If selected, a second, larger filter is applied to the data after the
specified time. This is useful for assays where the peaks are narrow
at the start of the assay and become broad and noisy for larger sizes
of DNA, protein or Glycan. If not selected, the same size filter is used
for all data.

» Filter Width (sec) - The width of the second filter to be applied
after the specified transition time. Filter Width must be greater than
the Sample Well Filter width and less than or equal to 3.0 seconds.

» Transition Time (sec) - The time at which to transition to the
larger filter size. Transition time must be greater than the Baseline
Time on the Analysis tab and less than the Well End time.
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Table 2. Well Peak Find Settings

Well

Settings Function

Well Displays the well being edited. Select any well or ladder on the plate
belonging to the current collection.

Ladder Read only. Displays the ladder used for aligning this well. Use the
Alignment tab to edit. New value displays here after clicking Apply.
(not available for Protein Charge Variant assays.)

Bracket Read only. Displays the bracket ladder used for aligning this well.
Use the Alignment tab to edit. New selection displays here after
clicking Apply. (Only for gDNA and Protein assays if Align Well
Groups to Bracketed Ladders is selected on the Alignment tab.)

Minimum Specifies an override to the Peak Find Settings for Minimum Peak

Peak Height | Height for the entire plate. Specify a valid numeric value to override,
or clear the field to reset to the Global setting.

Minimum Specifies an override to the Peak Find Setting for Minimum Peak

Peak Width | Width for the entire plate. Specify a valid numeric value to override,
or clear the field to reset to the Global setting.

Slope Specifies an override to the Peak Find Setting for Slope threshold for

Threshold the entire plate. Specify a valid numeric value to override, or clear the
field to reset to the Global setting.

Use Plate Sets Min Peak Height, Min Peak Width, and Slope Threshold text

Value button

boxes to <Uses plate value> settings.

Save as Sets the selected ladder to the default ladder for the plate. Does not

Default align any wells to the default ladder. (Only available for DNA and

Ladder RNA assays.)

Apply Apply well-specific peak find settings only to the well or ladder

Well/Ladder |showing in the Well field.

Apply Row Apply well-specific peak find settings to all wells in the same row as
the selected well.

Apply Apply well-specific peak find settings to all wells in the same column

Column as the selected well.

Apply All (Displays only if a ladder is selected in the Well field.) Applies peak

Ladders find settings to all ladders in the plate.

Apply Plate | Apply well-specific peak find settings to all wells on the same plate.
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Expected Fragments/Proteins/Glycans Tab
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Use the Expected Fragments/ Proteins/Glycans tab on the Assay
Analysis Window to enter Expected Fragments for DNA or gDNA
assays, Expected Proteins for Protein assays, Expected Glycans
for Glycan assays, or Expected Peaks for Protein Charge Variant
assays. (See Using Expected Fragments/ Expected Proteins/
Expected Glycans on page 43 for more information.) After the data
is analyzed, any peaks matching the expected fragments, proteins,
or glycans are shown in the Peak Table View, Well Table View, Gel
View, and Graph View (if Type is selected as an Annotation in the
Graph View Properties). (Not available for NAQuant NGS assays.)

'Assay Info  Alignment Analysis Peak Find Expected Fragments Excluded Fragments Smear Analysis Titer  Replicates  Advanced
| Size [BP] Window (%) Color Name Property Displayed in Well Table For Aligning Apply to Wells

b 10 P72 0 A5A6.A7.89.87..

100 o L100 (] A1A2A3B5,BE....
118 10 EP118
194 10 EP154

A5 AGATBSBI.. |
A5.AGA7ESB..

24 10 EP2M v A5 A6AT BS.B1
27| 10 EP271 v A5 A6AT.B3.B1
231 10 EP281 v 0 A5 ABATBIBT..
a0 10 L300 ~ 0 A1,A2,A3,B5.86..
310 10 EP31D v ] A5 AGATBIET..
500 | 10 L500 v 0 A1A2A3B5BE...
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700 10 L700 | v 0 A1,A2,A2,B5.B6...
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872 10 EP8T2 o 0 A5AGA7BIBT...
Expected Fragments
Plate: 12 DNA Demo 4_2009-08-28_D1-36-49
o Eoie Rt
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Figure 97. Assay Analysis Window - Expected Fragments Tab

The Expected Fragments/Proteins/Glycan tab contains the
following options and buttons:

Expected Peak Table - Lists the expected peaks for the assay
analysis.

+ Size - Specifies the expected size of the peak in BP (DNA), kb
(gDNA), kDa (Protein), or CGU (Glycan).

+ Time - Specifies the expected time of the peak (Protein Charge
Variant only).

*  Window (%) - Specifies the tolerance window as a percent of
the expected size for the peak to allow for small variations in
expected peak size.
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Expected Fragments/Proteins/Glycans Tab (Continued)
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+ Color - Displays the color to use to mark the peak in the Graph
View or the Gel View.

* Name - Specifies a name to display in the Type description for
the peak.

* Property Displayed in Well Table - Specifies the content of a
column added to the well table for each expected peak.

* For Aligning check box - If selected, the data signal is
realigned so the selected expected peaks match the specified
size or time. Note that incorrect alignment settings can cause
analysis errors.

+ Apply to Wells - Specifies the wells that the expected peak is
applied to. <All> specifies that the expected peak applies to all
wells. Clicking on the column opens the Select Wells window to
choose the specific wells to apply the expected peak to.

Import button - Opens the Import Expected Fragments/ Proteins/
Glycan Table window to select an Expected Peak File (.gep) to
import. The .gep file is created by exporting expected peaks from
another assay.

Clear button - Deletes all Expected Peaks from the table.

Restore button - Restores the settings to the last saved settings
for expected peaks.

Export button - Opens the Export Expected Fragments/ Proteins/
Glycans window to create an Expected Peak File (.gep) from the
current settings in the tab. Import the .gep file into another assay to
use the same expected peaks in another assay.

Note: To delete a row, click to select the row and then press the
Delete button.
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Excluded Peaks Tab

Use the Excluded Peaks tab on the Assay Analysis Window to enter
Excluded Fragments for DNA or gDNA assays, Excluded Proteins
for Protein assays, Excluded Glycans for Glycan assays, or
Excluded Peaks for Protein Charge Variant assays. After the data is
analyzed, any peaks matching the excluded peaks are excluded
from the analysis. (Not available for NAQuant NGS assays.)

Bl LabChip GX Assay : HT DNA 12K Extend

Assay Info  Mlignment  Analysis Peak Find Expected Fragments Excluded Fragments  Smear Analysis  Tter  Replicates  Advanced
Size [BP] Window (%) Color Name: For Aligning Exclude All Apply to Wells

Excluded Fragments
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Figuré 98. Assay Analysis Window - Excluded Peaks Tab

The Excluded Peaks tab contains the following options and buttons:

Excluded Peak Table - Lists the excluded peaks for the assay
analysis.

PN CLS151165 Rev H

Size - Specifies the size of the excluded peaks in BP(DNA), kb
(gDNA), kDa (Protein), or CGU (Glycan).

Time - Specifies the expected time of the peak (Protein Charge
Variant only).

Window (%) - Specifies the tolerance window as a percent of
the size of the peak to allow for small variations in peak size.

Color - Displays the color to use to mark the peak in the Graph
View or the Gel View.

Name - Specifies a name to display in the Type description for
the peak.
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Excluded Peaks Tab (Continued)

* For Aligning check box - If selected, the data signal is
realigned so the selected excluded peaks match the specified
size or time. Note that incorrect alignment settings can cause
analysis errors.

* Exclude All - If selected, all peaks in the specified range are
excluded from analysis.

+ Apply to Wells - Specifies the wells that the excluded peak is
applied to. <All> specifies that the excluded peak applies to all
wells. Clicking on the column opens the Select Wells window to
choose the specific wells to apply the excluded peak to.

Exclude Peaks when Missing in Replicates options - Specifies
the desired option to automatically exclude a peak based on peaks
in defined replicate wells. Only displays if at least one replicate set
is defined on the Replicates Tab.

+ Disabled - No peaks will be excluded based on the replicates.

* Any - A peak is excluded if it is not found in ANY of the other
wells in the replicate set.

* All-Apeakis excluded if it is not found in ALL of the other wells
in the replicate set.

Automatically exclude peaks with area less than text box -
Specifies a peak area. Any peaks with an area (corrected or
aligned) below the specified threshold are automatically excluded.
Default value is 0.

Import button - Opens the Import Excluded Peaks window to
select an Excluded Peak File (.gep) to import. The .gep file is
created by exporting excluded peaks from another assay.

Clear button - Deletes all Excluded Peaks from the table.

Restore button - Restores the settings to the last saved settings
for excluded peaks.

Export button - Opens the Export Excluded Peaks window to
create an Excluded Peaks File (.gep) from the current settings in
the tab. Import the .gep file into another assay to use the same
excluded peaks in another assay.

Note: To delete a row, click to select the row and then press the
Delete button.
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Smear Analysis Tab

Use the Smear Analysis tab on the Assay Analysis Window to
define Smears. After the data is analyzed, the area matching the
smear is shown in the Well Table View, Gel View (if Show EPs and
Smears is selected in the Gel View Properties), and Graph View (if
Show Smears is selected in the Graph View Properties). (Not
available for NAQuant NGS assays.)

)P LabChip GX Assay : HT DNA 12K Extended Time (] ¥,
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Figure 99. Assay Analysis Window - Smear Tab
The Smear Analysis tab contains the following options and buttons:

Smear Table - Lists the smears for the assay analysis.

+ Start Size/Time - Specifies the starting size (time for Protein
Charge Variant) of the area to be included in the smear.

+ End Size/Time - Specifies the ending size (time for Protein
Charge Variant) of the area to be included in the smear.

+ Color - Displays the color to use to mark the smear in the Graph
View or the Gel View.

* Name - Specifies a name to display in the Well Table View.

* Property Displayed in Well Table - Specifies the content of a
column added to the Well Table for each smear.

For gDNA assays, the Total gDNA Concentration in the Well
Table is the concentration of the entire smear region from
0.175kb (or the specified smear start size) to 300kb.

PN CLS151165 Rev H LabChip GX Reviewer User Manual



Software Reference 205

Smear Analysis Tab (Continued)
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* Apply to Wells - Specifies the wells that the smear is applied to.
<All> specifies that the smear applies to all wells. Clicking on
the column opens the Select Wells window to choose the
specific wells to apply the smear to.

Import button - Opens the Import Smear Analysis Table window to
select an Smear Analysis Import File (.sma) to import. The .sma file
is created by exporting smears from another assay.

Clear button - Deletes all smears from the table.

Restore button - Restores the settings to the last saved settings
for smears.

Export button - Opens the Export Smear Analysis Table window to
create a Smear Analysis Export File (.sma) from the current settings
in the tab. Import the .sma file into another assay to use the same
smear in another assay.

Note: To delete a row, click to select the row and then press the
Delete button.
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Titer Tab

Use the Titer tab on the Assay Analysis Window to specify the wells
in the plate that contains the standard to be used as the calibration
standard. The Titer is used for calibration instead of the ladder.
(Titer is not available for Glycan, Protein Charge Variant, or
NAQuant NGS assays.)

B8l LabChip GX Assay : HT DNA 12K Extended Time () x
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Figure 100. Assay Analysis Window - Titer Tab
The Titer tab contains the following options and buttons:

Titer Table - Lists the size, well locations, and concentrations for
the titer on the plate.

» Standard Size - If Expected Peak is selected as the Titer
Source, specifies the size of the standard peak in BP for DNA
assays, kb for gDNA assays, nt for RNA assays, and kDa for
Protein assays.

+  Window (%) - If Expected Peak is selected as the Titer Source,
specifies the tolerance window as a percent of the size for the
standard peak to allow for small variations in size.

+ Start Size - If Smear is selected as the Titer Source, specifies
the start size of the standard smear in BP for DNA assays, kb
for gDNA assays, and nt for RNA assays.

* End Size - If Smear is selected as the Titer Source, specifies
the end size of the standard smear in BP for DNA assays, kb for
gDNA assays, and nt for RNA assays.
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Titer Tab (Continued)

*  Found in Well - Specifies the location of the standard in the
plate. Type the well number or double-click to select the well in
the plate diagram. (not displayed for imported titers.)

* Normalized Area - Specifies the titer peak normalized area for
imported titers. The table for imported titers is Read Only and
cannot be edited. (not displayed for manually entered titers.)

 Concentration - Specifies the concentration of the standard in
the specified well.

* Name - Specifies a name to display in the Type description for
the peak.

Import Titer from Another Plate - Selecting the check box opens
the Select Plate For Titer Import window to select the desired titer
from another plate. The plate must be open in the collection, the
titer curve must be analyzed, and the normalization peak must
match. The normalization peak is set in the Analysis tab: Lower
Marker, Upper Marker (DNA only), or Sample Peak. If the Sample
Peak option is used, the peak size specified must also match. If no
compatible plate is found in the workspace, a message displays and
the Import is canceled. Clearing the check box returns to the
manually entered titer.

Concentration to Favor in Fit - Adjusts the weight of the points in
the linear fit for the Titer Standard Curve. The points are weighted
by raising the concentration to a power depending on the slider
position. Each line on the slider represents a 2 power increment,
with the center position equal to 0. The left most position raises the
concentration to the power -2.5. The right most position raises the
concentration to the power of 2.5 to weight each point.

Force Fit through Origin check box - If selected, the Titer
Standard Curve is forced to include the origin (0,0). This prevents
very small peaks from generating negative concentrations.

Average Replicates check box - If selected, replicate points are
averaged before fitting the titer curve to the data points. If not
selected, each replicate point contributes equally when fitting the
titer curve to the data points. Used when multiple wells of the same
concentration are used to improve accuracy.

Fit Model - Choose Linear or Quadratic to fit the Standard Curve
to the Titer. Linear: y = a + bx. Quadratic:y =a + bx + ox2.
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Titer Tab (Continued)

Plot Titer Curve button - Plots the Titer Standard Curve using
linear regression to fit the data to a straight line and displays the
User Titer Window. Printing the Titer from the User Titer Window
prints a report that contains the Titer graph, the fit parameters (fit
model, concentration weight, origin option), fit coefficients, fit quality
(R*2), and the data table (normalized area vs concentration).

Titer Source - Choose Expected Peak or Smear as the titer
source (DNA, gDNA, and RNA assays only).

Select Titer Plate button - Opens the Select Plate For Titer Import
window to select a different plate from which to import a titer. The
plate must be open in the collection, the titer curve must be
analyzed, and the normalization peak must match. The
normalization peak is set in the Analysis tab: Lower Marker, Upper
Marker (DNA only), or Sample Peak. If the Sample Peak option is
used, the peak size specified must also match. Only displays after a
titer has been imported.

Import button - Opens the Import Titer Table window to select a
Titer Import File (.ttr) to import. The .ttr file is created by exporting a
titer from another assay.

Clear button - Deletes all entries from the table. Clear the entries
to use the default Standard Curve instead of the Titer Standard
Curve.

Restore button - Restores the settings to the last saved titer
settings.

Export button - Opens the Export Titer Table window to create a
Titer Export File (.ttr) from the current settings in the tab. The
exported titer contains the entries in the titer table, Concentration to
Favor in Fit, Force Fit through Origin, and Fit Model. Import the .ttr
file into another assay to use the same titer in another assay.

Note: To delete a row, click to select the row and then press the
Delete button.
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Replicates Tab
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Use the Replicates tab on the Assay Analysis Window to identify
wells that include the same samples. Each set of wells that contain
the same sample or titer are referred to as a replicate set.

Figure 101 shows two replicate sets. Replicate set 1 contains A1
and A12. Replicate set 2 contains B1 and B12. (Not available for

NAQuant NGS assays.)

If replicate wells are identified in the Replicates tab, use the
Exclude Peak when Missing in Replicates options on the Excluded
Peaks Tab to exclude peaks that are missing in any or all of the

replicate wells.
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Figure 101. Assay Analysis Window - Replicates Tab

The Replicates tab contains the following options and buttons:

Plate Diagram - Displays the replicates defined for the plate. Click
a well to select or deselect the well. Click a replicate well to select

the replicate set.

Copy Down button - The pattern of the selected replicate set is

repeated to the bottom of the plate.

Copy Across button - The pattern of the selected replicate set is

repeated across the plate.

Edit Names button - If selected, opens the Replicate Name Editor
window to change the name of the default replicate name.

Add button - Adds the selected wells to a replicate set. All wells in
the same set display the same replicate set number.

Delete button - Deletes the selected replicate set.
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Replicates Tab (Continued)
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Import button - Opens the Import Replicates Table window to
select a Replicates Import File (.rep) to import. The .rep file is
created by exporting a replicates file from another assay.

Clear button - Deletes all replicates from the plate diagram.

Restore button - Restores the settings to the last saved replicates
settings.

Export button - Opens the Export Replicates Table window to
create a Replicates Export File (.rep) from the current settings in
the tab. The exported Replicates file contains the entries in the
plate diagram. Import the .rep file into another assay to use the
same replicates in another assay.
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Advanced Tab
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Use the Advanced tab on the Assay Analysis Window to select the
Quantification, Peak Size Calibration point, Concentration Size
Correction, Peak Integration Mode, Marker Find, and Calibration
settings. (Not available for NAQuant NGS assays.)
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Figure 102. Assay Analysis Window - Advanced Tab

Quantification - Determines whether the upper marker, lower
marker, or a sample peak is used in the calculations to convert the
peak area to concentration. The selected peak is used to normalize
the signal response between the ladder and the sample. The
Sample Peak option is normally used with a user-supplied titer. The
DNA fragment or protein that generates the Sample Peak must be
included in both the titer and sample wells at the specified
concentration. Protein, RNA, and gDNA assays use the lower
marker. DNA assays use the upper marker. DNA and RNA settings
cannot be changed. For Protein and gDNA assays, selecting
Sample Peak uses the Peak Size and Concentration of the User
Standard instead of the default ladder settings. Not available for
Glycan or Protein Charge Variant assays.

Peak Size Calibration Point - Specifies which part of the peak is
used as the size calibration point.

+ Leading Edge - If selected, uses the start of the peak. (May be
better when sample peaks are broader than ladder peaks.)

+ Center - If selected, uses the top of the peak. (May be better
when the leading edge is not well-defined.)

LabChip GX Reviewer User Manual

VWV



Software Reference 212

Advanced Tab (Continued)

Concentration Size Correction (Protein assays only) - Protein
concentration is size-corrected to account for differences in the
amount of protein injected into the separation channel based on its
size. The correction is obtained using the formula:

» Conc(Size Corrected) = Conc(Time Corrected Area) * Amplitude
* (Size)*Power

The default values for the Concentration Size Correction were
determined empirically by measuring a wide range of proteins of
known size and concentration. This correction can be bypassed by
setting Amplitude = 1.0, Power = 0.0.

Peak Integration Mode - Specifies the mode for determining the
baseline.

* Peak Baseline - A global peak baseline is used as the baseline
for all peaks. This baseline is determined by stitching together
regions of low variance across the data signal.

* Valley to Valley - Each peak is assigned a baseline by drawing
a line under the peak joining the start and end of the peak at the
data signal values.

+ Peak Minimum - The peak baseline is extended to the bottom
of the peak instead of starting and stopping where the signal
slope crosses the slope threshold.

Smear Baseline - Specifies the method for determining the Smear
Baseline. This option only displays after a smear has been added in
the Smear Analysis tab. Not available for Protein Charge Variant
assays.

*  Two Point -The baseline is a single straight line between the flat
baseline areas at the beginning and end of the trace. This option
is preferred for very shallow smears where the signal slope
does not rise above the Peak Slope Threshold.

* Peak Baseline - The Smear baseline uses the local peak
baseline for the start and end points of the smear baseline. If the
signal slope is below the peak slope threshold, the local peak
baseline follows the signal.
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Advanced Tab (Continued)

High Conc Size Corr - Specifies the method of correction for the
ladder migration time when the sample concentration is significantly
higher than the ladder concentration. The ladder migration time is
corrected independently for each well to compensate for the
increased migration speed of high concentration samples. The
desired option can be selected in the when editing an assay before
the sample is run, and cannot be changed after the sample is run.

* Disabled - The ladder migration time is not corrected

* Linear - The ladder migration time correction is proportional to
the sample to ladder concentration ratio.

* nonlinear - The ladder migration time correction is a function of
the ratio of sample and ladder concentrations and saturates at
very high sample concentrations. (Default)

Smear Smoothing - Fits a smooth spline curve to the smear and
replaces the actual data signal with the spline curve. Smear
smoothing smooths out rough smears that can be generated by the
DNA High Sensitivity assay when evaluating very low concentration
samples. If the smear is very rough and a minor peak or noise spike
is significantly higher than the smear, the Size at Maximum property
may be the height of the spike, instead of the height of the smear.
Use Smear Smoothing and adjust the Threshold until the smear is
smooth.

+ Disabled - The actual data signal is used to calculate the smear
properties. (Default)

+ Spline - A spline curve is fit to the data and replaces the actual
data signal for analysis.

— Threshold - Specifies how closely the spline curve
follows the data signal in the smear. The higher the
Threshold, the more closely the curve follows the data.

Marker Find - The Migration Time Drift specifies a percent of
migration time to use when determining the correct marker peak.
See (Migration Time Drift on page 284) for details. Not available for
Protein Charge Variant assays.

PN CLS151165 Rev H LabChip GX Reviewer User Manual



Software Reference 214

Advanced Tab (Continued)
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Calibration Options (Protein Clear HR Assays only) - Specifies the
options needed for the calibration to pass correct.

* % Purity must be in range for Calibration to pass - If
selected, the calibration will pass only if the % Purity is in the
valid range of 9.00% - 11.00%. If cleared, and the % Purity is not
within the valid range, the calibration is considered “marginal.”
You are then prompted to declare the marginal calibration as
passed or you may rerun the calibration.

¢ Dips must be eliminated for Calibration to pass - If selected,
the calibration will pass only if dips from the Egrams are
eliminated. If cleared, and the dips are not eliminated, the
calibration is considered “marginal.” You are then prompted to
declare the marginal calibration as passed or you may rerun the
calibration.

Smear Molarity Integration - The Integration Step Size specifies
the time, in seconds at which to divide a smear into segments. The
size at the center of each segment and the concentration of each
segment is used to calculate the smear molarity.

GQS Smear Start Size (JDNA Assays only) - Specifies the start
size of the GQS Smear used to calculate Total gDNA Concentration
and Genomic Quality Score (GQS). Only editable when creating an
assay before a run. After the sample is run, edit the start time in the
Smear Analysis Tab on the Assay Analysis window or by dragging
the start of the smear in the Graph View.
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Audit Trail Export Window
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Use the Audit Trail Export Window to export the contents of the
Audit Trail Window to either an ASCII text file, and XML file, or a
Microsoft® Excel file. Only the events displayed in the Audit Trail
Window are exported. Events filtered out of the view are not
exported. This window is only available if the LabChip GxP option is
installed with the LabChip GX Reviewer software.

To open the Audit Trail Export Window, click the Export button in
the Audit Trail Window.

AuditTrail Export =

Select file format:

(D) ASClltext file
© XMLfle
() MS Excel

Mumber of events included: 100

Figure 103. Audit Trail Export Window
The Audit Trail Export Window contains the following options:

File Formats - Select the desired format for the exported file:
« ASCII Text File - If selected, the file is saved as a .txt file.
« XML File - If selected, the file is saved as an .xml file.
* MS Excel - If selected, the file is saved as an .xIs file.

Number of Events Included - Displays the number of events that
will be exported.
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Audit Trail Manage Columns Window

Use the Audit Trail Manage Columns Window to select the columns
to view at the bottom of the Audit Trail Window. This window is only
available if the LabChip GxP option is installed with the LabChip GX
Reviewer software.

To open the Audit Trail Manage Columns Window, click the Green
Arrow button next to the Event Category text box in the Audit Trail
Window.

(1 Show Al

@ Event Categary

@ Evert Detail

B Usemame

: Application Access Level
@ Date/Time Stamp

@ Source

(] Computer Name

(] ComputerlJser

(] Computer User-Role
B Data File Name

B Severity

i Comment

Figure 104. Audit Trail Manage Columns Window

The Audit Trail Manage Columns window contains the following
parts:

Option

Function

Show All check
box

Selecting the check box selects all of the listed columns to display
at the bottom of the Audit Trail window. Clearing the check box
clears all of the column check boxes.

Column list

Only the selected columns display at the bottom of the Audit Trail
window. Cleared (unselected) columns are hidden.

Green Up and
Down Arrows

Moves the selected column up or down in the list. The columns
display in the Audit Trail window in order from the top column on
the left to the bottom column on the right.

Save button

Saves the selections and applies the current column view to the
Audit Trails window.

Close button

Closes the window without saving changes to the selections.
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Audit Trail Window

The Audit Trail Window enables you to search the Audit Trail Log
for specific events, to export the events, or to print events. This
window is only available if the LabChip GxP option is installed with
the LabChip GX Reviewer software.

To open the Audit Trail window, select Security - Audit Trail Log
on the LabChip GX Reviewer Main Window.
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Figure 105. Audit Trail Window
The Audit Trail Window contains the following options:
Option Function
Search most If selected, the specified most recent number of entries is

recent entries searched for entries matching the selected criteria.
radio button

Number of Specifies the number of most recent entries to search.
entries text box

Search by dates | If selected, entries between the specified dates are searched for

radio button entries matching the selected criteria.

From and To Select the dates that contain the events that you want to view.
drop-down list

Search entire If selected, all entries in the database are searched.
database radio

button

Username text | Select a specific user name to view only events performed under
drop-down list | the specified user name. Select All Users to view events
performed by any user.

Filename text Clicking the Browse (...) button opens the CDR Browser Window
box to open the audit trail for a different data file.
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Option

Function

Event Category
drop-down list

Specifies the Event Category of events to search for. Default
selects all event categories.

Green Arrow
button

Displays the Audit Trail Manage Columns Window to select the
columns to view in the Audit Trail window.

Search button

Searches for events matching the search criteria specified.

Export button

Opens the Audit Trail Export Window to export a copy of the
selected events out of the audit trail log.

Print View
button

Displays a preview for printing the Audit Trail Report.

Close button

Closes the Audit Trail Window.
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CDR / Database Server Mapping Window

Use the CDR / Database Server Mapping Window to specify the
location of the CDR folder. This window is only available if the
LabChip GxP option is installed with the LabChip GX Reviewer
software.

szl CDR / Database Server Mapping

Application must be mapped to CDR/Database Server and available
before working in CFR Mode. Please enter a valid configured Server
Mame/IP Address:

Server Hame/IP Address: ||

Test Connection

Figure 106. CDR / Database Server Mapping Window

The CDR / Database Server Mapping window contains the following
options:

Server Name/IP Address text box - Specifies the name or IP
address of the server where the CDR folder is located.

Test Connection button- Opens the Server Diagnostics window to
test the connections to SQL, CDR, and Data File Service. The log
file generated during testing is located in

C:\Program Files (x86)\Revvity\LabChip GX Reviewer\Log\
ServerDiagnostics.log.

Cancel button - Closes the window without connecting to the
remote CDR Server. If the LabChip GX Reviewer software is not
connected to the CDR, data in the CDR is not accessible.

Apply button - Connects to the CDR on the specified computer or
server. If the CDR cannot be contacted due to network problems or
because the CDR is not installed yet, an error message displays.
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CDR Manager Window
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Use the CDR Manager Window to select a data file to open, to
create, rename, or delete CDR data folders, and to show or hide
data files from view in the CDR Manager Window.

To open the CDR Manager Window, select File > Import Data File
on the LabChip GX Reviewer Main Window. The CDR Manager
window only opens if the LabChip GxP option is installed. If the
LabChip GxP option is not installed, see Select a Data File Window
on page 251.

CDR Manager
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.
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‘LabChipGXDatafiEesl‘gxd: ,| m m
Figure 107. CDR Manager Window

The CDR Manager Window contains the following options

Left Side Buttons

Import Imports a CDR data file into the open workspace.
Button

Copy Button | Copies the selected data file to another location.
The copy of the data file will not be part of the CDR
and will not be change-controlled.

New Button | Creates a new folder in the CDR.

Rename Renames the selected folder in the CDR. (Data files
Button in the CDR cannot be renamed.)
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Delete Deletes an empty folder in the CDR. If the folder is

Button not empty, you cannot delete the folder.

Hide Button | Hides the selected folder or data files from view in
the CDR Manager window. If a folder is selected, all
files and subfolders in the selected folder are
hidden.

Show Displays all hidden data files and folders in the

Button selected folder.

Top Right Buttons

New Button | Creates a new folder in the CDR.

Delete Deletes an empty folder in the CDR. If the folder is
Button not empty, you cannot delete the folder.

Show/Hide | Shows or hides the filenames of all files that have
Hidden Files | been hidden in the CDR Manager window.

Button

Expand All | Expands all folders in the CDR to show all data files
Button and folders.

Collapse All | Closes all folders in the CDR folder.

Button

The icon next to the data file name indicates whether the data file is
Accepted/Rejected and Locked as shown in the table below:

File Status

Icon

Locked

Accepted

Accepted and
Locked

Rejected

Rejected and
Locked
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Change Password Window

Use the Change Password Window to change the password for the
current user. (To change passwords for other users, see User
Administration Window.) This window is only available if the
LabChip GxP option is installed with the LabChip GX Reviewer
software.

To open the Change Password Window, select Security > Change
Password on the LabChip GX Reviewer Main Window.

we Change Password 4

Usemame: administrator

Curmrent Password: || |

MNew Password: | |

Confirm Passwaond: | |

o< W cacd
Figure 108. Change Password Window

The Change Password Window contains the following options:

Option Function

Username Displays the user name for the current user.

Current Type the current password for the current user.
Password

New Type the new password for the current user.
Password

Confirm Retype the new password for the current user.
Password

OK button Saves the new password and closes the window.

Cancel Closes the window without saving changes to the
button password.
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Data File Version Window

Use the Data File Version Window to view the saved versions of the
data file. Also displays when the data file was signed.

PN CLS151165 Rev H

To open the Data File Version Window, select View - Version
Change Details on the main menu.

<

Data File Version Change Details - «DNA5K_2023-09-23_04-07-45_SimRun.gxd > [m] X

v.0: 2023\09\23 04:07:50 by Default Administrator
AR EEN YU T CORE | Plate Name: DNASK_2023-09-23_04-07-45_SimRun

Analysis And Peak Find Setting Changes
Analysis Parameter New Value Old Vale
Ladder Concentration 2 1

Print Options .

Figure 109. Data File Version Window

The Data File Version Window lists each version of the plate data
file and describes the changes that were performed for each
version change. Each time the data file is signed, the Data File
Version Window lists the details of the signature. (To open a
different version of the data file, click the Restore Plate button in
the Assay Analysis Window.)

The Data File Version Window contains the following options:

Option Function
List of Displays the list of all saved data file versions and
Versions electronic signatures.
Details Displays the details of the changes or signature.
Print All Versions: If selected, version information and
Options details for all data versions is printed.
Selected Version: If selected, version information
and details for only the selected version is printed.
Print Opens the Print Preview window to preview the
Preview printed version information.
Print Opens the Print window to print the data file version
information.
Close Closes the Data File Version window.
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Display Format Editor Window

Use the Display Format Editor Window to specify the number of
decimal places to display for each type of data. To open the Display
Format Editor window, select Tools > Modify Data Presentation.

Display Format Editor

Quantity Units Decimals

sec 2|
Size BP 0|wv
Fucrescence .HFU 0|~
Slope .HFUfs-ec 1 v
Purity 2|~
Area \RFU'sec | 2|~
Height RFU . 2|~
Baseiine RFU 2| v
Concentration .ng;‘ul 2| v
peak Molarity .nmom 2 -

Figure 110. Display Format Editor Window

Quantity Column - Lists the data types that are displayed in or
generated by the LabChip GX Reviewer software.

Units Column - Lists the units for each data type.

Decimals Column - Specifies the number of decimal places to
display for each data type. All calculations are performed with full
resolution double precision data. The decimal places properties are
only used for formatting the computed results for display.
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Export Window

Use the Export window to export data manually. To open the Export
window, select File > Export on the main Menu Bar.

Peak Tables and Well Tables are exported to CSV files, which can
be imported into a spreadsheet program such as Microsoft® Excel.
Raw Data can be exported to either a CSV file or to a
Chromatography Data Interchange Format file (formerly AlA), which
is used by some graphical analysis software tools.
Electropherogram and Gel data are exported to the selected image
format. See Exporting Data on page 102 for instructions.

LabChip GX - Export (S)
~ M ExportAll
’ =ty
File Naming Template: |%NAMES._%DATA%_%TYPE_%LLABELY. | Wid Cards 5‘} Insert

-
 Peak Tabl C:\Program Files (x86)\Perkinelmer\LabChip GX a
=) reak lable Reviewer\Data\2021-04-07_08-47-29_DNA_PeakTable.csv <
 Well Table = \Program Files (x86)\Perkinelmer\LabChip GX a
= Well 1abe  peviewer\Data)|2021-04-07_08-47-29_DNA_WellTable.csv <
# Raw Data C:\Program Files (x86)\Perkinelmer\LabChip GX a
=) Haw Lis Reviewer\Data\2021-04-07_08-47-29_DNA.csv <

~Raw Data Option

Export the data in CSV format, which can be imported
directly into spreadsheets. One file per Well

| AlA Format
_!Include Size Data | Export Single Table
W E C:\Program Files (x86)\Perkinelmer\LabChip GX F N
= SR peviewer|Data\2021-04-07_08-47-29_DNA.bmp -
~Egram Option
) Entire Collection O Selected Well(s)
o} Overlay C:\Program Files (x86)\Perkinelmer\LabChip GX [
= Electropherogram Reviewer\Data\2021-04-07_08-47-29_DNA.bmp ./
# Gel C:\Program Files (x86)\Perkinelmer\LabChip GX r N
™ Reviewer|\Data\2021-04-07_08-47-29_DNA.bmp A -
~Gel Options
® Entire Collection U Selected Well(s)
) Single File (_Separate Files Height

~Image Format For Egram. Gel and Overlay Electropherogram

@Bmp UG OJlpeg OPng OTHf OWmf OEmf

4 ~ 4 ¥
Ok Cancel
N ikl

Figure 111. Export Window

Option

Function

File Naming
Template

The template for naming the data files. All exported data files use
the same names. Type in the text box or add wildcard variables.
The %DATA%, % TYPE%, and at least one of %NAME% or
%LABEL% must be included in the template to ensure file names are
unique across export types. The template displays in red if it does not
meet the minimum requirements, and will not be saved.
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Option

Function

Wild Cards

Use the Wildcards drop-down list to select predefined variables to
add to the name of the data files: %DATA% = datafile name,
%LABEL% = well label, %NAME% = well name, %TYPE% =
export type (gel, egram, etc.), %COMMENT% = user comments.
When a single file for the plate is exported, the %NAME% and
%LABEL% fields are blank, and any leading, trailing, or duplicate
separators are removed.

Insert button

Inserts the text selected in the Wildcard drop-down list at the
cursor position in the File Naming Template text box. Each
wildcard can only be inserted once in the template.

Peak Table

If selected, the data in the Peak Table View is exported to a .CSV
file. Click the Browse (...) button to specify the desired path and
file name for the .CSYV file.

Well Table

If selected, the data in the Well Table View is exported to a .CSV
file. Click the Browse (...) button to specify the desired path and
file name for the .CSV file.

Raw Data

If selected, the raw (unanalyzed) data from the run is exported.

+ If the AIA Format check box is selected, the raw data is
exported to a file in the Chromatography Data Interchange
Format (formerly AlA). (Include Size Data and Export Single
Table are not available.)

« If the AIA Format check box is NOT selected, the raw data is
exported to a .CSV file. Click the Browse (...) button to specify
the desired path and file name for the .CSV file. The following
options are available:

— Include Size Data: If selected, the data is aligned to the
well's ladder (for one file per well) or to the first well (for a
single data file) and the size data is included in the
exported data. If not selected, the data is not aligned to a
ladder. (not available for CZE assays.)

— Export Single Table: If selected, the data for all wells in
the plate is exported to one .CSV file. If not selected, the
data from each well is exported to a separate .CSV file.

Electrophero-
gram

If selected, the graph displayed in the Graph View is exported to
the specified folder in the selected image format. Click the Browse
(...) button to specify the desired path for the image file. The file
names are <plate name>_Egram_<well number>. The following
options are available on the Export window.
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Option

Function

Electrophero-
gram (Contin-
ued)

+ Entire Collection: If selected, a separate graph is exported for
each well in the collection.

+ Selected Wells: If selected, a separate graph is exported for
each of the wells selected in the Gel View or Plate View or
Plate List.

Fluorescence
Intensity

(NAQuant NGS only) If selected, the graph displayed in the Graph
View is exported to the specified folder in the selected image
format. Click the Browse (...) button to specify the desired path for
the image file. The file names are <plate name>_Fluorescence
Intensity_<well number>. The following options are available on
the Export window.

+ Entire Collection: If selected, a separate graph is exported for
each well in the collection.

+ Selected Wells: If selected, a separate graph is exported for
each of the wells selected in the Plate View or Plate List.

Overlay
Electrophero-
gram

If selected, the graph displayed in the Overlay Electropherograms
Tab is exported to the specified folder in the selected image
format. Click the Browse (...) button to specify the desired path for
the image file. The file name format is
<DataFileName>_OverlayEgram.

Gel

If selected, the gels selected in the Gel View are exported to the
specified folder in the selected image format. Click the Browse (...)
button to specify the desired path for the image file. The file names
are <plate name>_Gel_<well number>. The following options are
available on the Export window.

+ Entire Collection: If selected, a gel is exported for each well in
the collection. (not available on the Auto Export window.)

+ Selected Wells: If selected, a gel is exported for each of the
wells selected in the Gel View or Plate View or Plate List. (not
available on the Auto Export window.)

» Single File: If selected, the selected gels are all included in the
same image file.

» Separate Files: If selected, the selected gels are each
exported to a separate image file.

* Height: Specifies the desired height, in pixels, of the gel
graphic.

Image Format for Gel and Electropherogram

Select the desired format for the exported image files.

Image Format for Fluorescence Intensity

Select the desired format for the exported image files.
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Folder Permissions Window

Use the Folder Permissions window to set access rights to folders
in the CDR for specific users. Each LabChip GX Touch user name
can be assigned Full Control, Read, and/or Write access to each
folder in the CDR. Permissions can be propagated to subfolders, if
desired. To open the Folder Permissions window, select Security
- Folder Permissions. This window is only available if the
LabChip GxP option is installed with the LabChip GX Reviewer
software.

o’ Folder Permissions nee
FYC0R LAy
SelechUiser | Opesstor e
- CDR
-J_'_,‘r Teat Selectsd Folder  CDR

Sel Peimissions
Full Conieol

Fead

4:4;;;?

Winte

 Apply the perrezecns 1o subliolders

Save Close

Figure 112. Folder Permissions

The Folder Permissions Window contains the following options:

Options Description
CDR radio If selected, the CDR folder and its subfolders display in the
button Folder List.

Assay radio

If selected, the ASSAY folder and its subfolders display in the

button Folder List.

Select User Displays the user name for which permissions are being set.
drop-down list

Folder List Select the name of the folder to apply the settings for the

specified user. The folder name displays next to Selected
Folder.

Set Permissions | Select or clear the Full Control, Read, and Write check boxes

to assign the desired permissions to the selected user name.
Full Control gives read and write permissions to the selected
user for the selected folder.
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Options Description

Apply If selected, the permissions set for a folder are applied to any
permissions to | subfolder in the selected folder. If not selected, the settings are
subfolders only applied to the selected folder.

check box
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Layout Options Window

PN CLS151165 Rev H

Use the Layout Options window to change the location of the views
in a collection. To open the Layout Options window, select
Collection > Layout on the LabChip GX Reviewer Main Window.
(Not available for NAQuant NGS assays.)

Layout Optons A
| iewes Lt Pt Bostom
) Ovelay Beciop | =] z z

F‘M-":.T‘!.ﬂ! 1 = = !E‘

T Beactrapbarograms

- ] = 5 =

M scxive il

i Filtler '1"
Vil Tabls . = . = . 'E'
soy oty Do Cancel

e

Figure 113. Layout Options Window

The Layout Options window contains the following options and
buttons:

Viewer column - Lists the viewers available to display in the
Collection Pane.

Left check box - If selected, the view displays on the right side of
the Collection pane. (The view displays at the top if any view is
selected to display at the bottom of the pane.)

Right check box - If selected, the view displays on the left side of
the Collection pane. (The view displays at the top if any view is
selected to display at the bottom of the pane.)

Bottom check box- If selected, the view displays at the bottom of
the Collection pane. (The view displays at the top if there are no
views displayed at the top left or right in the pane.)

Apply button - Applies the selections to the active collection and
closes the Layout Options window.

Restore to Factory Defaults button - Restores the active
collection to the default Layout options, table views, table columns,
and viewer properties.

Cancel button - Closes the Layout Properties window without
changing the collection layout.
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Layout Options Window (Continued)

NOTES
|

* Aview can only be displayed in one location. Selecting a
location automatically clears any other selected location.

« To hide a view, click on the selected location to clear the
selection.

* Alocation is hidden if it contains no views.
» The Gel View is always displayed and cannot be hidden.
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Load Assay into CDR Window
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Use the Load Assay into CDR Window to add installable assays
into the CDR. This window only displays if the LabChip GxP option
is installed. See Loading Installable Assays into the CDR Folder on
page 137 for instructions on installing or deleting assays.

To open the Load Assay into CDR Window, select Tools > Load
Assay into CDR on the LabChip GX Reviewer Main Window.

@5 Load Assay into CDR -

Select CDR Assay Folder:

u] X
Select Installable Assay Fie
New Assays

Comment

Extemal Source i |
Prior to adding or deleting assay files please make sure to close all

client applications.

Figure 114. Load Assay into CDR Window

The Load Assay into CDR window contains:

Select CDR Assay Folder text box - Click the Browse (...) button
to open the CDR Browser Window to specify the path to the CDR
assay folder.

Select Installable Assay File text box - Click the Browse (...)
button to open the Select File window to specify the path to the
installable assay file (*.iasyx). Installable assay files are available
only from Revvity. See the LabChip GX Touch User Manual for the
website location and installation instructions.

Comment text box - Type any applicable comments (if desired).

External Source text box - Type the source (e.g., Revvity or
Revvity Installable Assay) of the installable assay.

New Assays list box - Lists any Installable assays that have
already been loaded into the CDR.

Load Assay button - Adds the specified installable assay file into
the CDR assay folder.

Delete button - Deletes the assay selected in the New Assays list
box from the CDR. Installable assays can be deleted from the CDR.
Default assays cannot be deleted from the CDR.

Close button - Closes the Load Assay into CDR window.
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Login Window

Use the Login Window to log into the LabChip GX Reviewer
software when the LabChip GxP option is installed. The LabChip
GX Reviewer software will not open until a valid user name and
password are entered.

The Login Window opens when you start the LabChip GX Reviewer
software with the LabChip GxP option installed.

Login to Automated Electrophoresis

Enter username and password:

Username: |

Password: | |

N T

Figure 115. Login Window

The Login Window contains the following options:

Option

Function

Username text
box

Type the user name to log into the LabChip GX Reviewer
software. Each user should have a unique user name.

Password text
box

Type the password assigned to the Username. All passwords
must be at least 5 characters long and must contain at least one
uppercase letter and at least one number. The User Account
Policies specify additional password requirements.
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New Collection Window

The New Collection window is used to create a new collection using
either a Blank Collection (default) or a Template. To open the New
Collection window, select Collection > New Collection on the
LabChip GX Reviewer Main Window.

[ New Collection e l
| ~Create a new collection using: o

- —

) Template

(_) Blank Collection

) Cument Collection

Name: |Collecﬁ0n 1|
| TR

Figure 116. New Collection Window

The following options are available:

Option

Function

Template

If selected, opens a blank collection and then applies the selected
collection template.

Blank
Collection

If selected, opens a blank collection that does not contain any

data. The new collection will use the same settings as the last

saved collection of the same assay type.
The current collection settings are automatically saved in a blank
collection template in the current user’s “Documents and Settings”
folder on the local computer. These preferences are applied when a
blank collection is created. User preferences are saved by assay
type, with separate settings saved for DNA, RNA, Protein and Glycan
assays.

Current
Collection

Only enabled if a collection is currently opened. If selected, opens
a blank collection and applies the settings from the currently open
collection as a template.

Assay Type

Select the type of data files that can be imported into the
collection. Only enabled if this is the first collection and no plates
have been imported into the workspace. If a workspace already
contains a collection, all new collections are the same type as the
existing collections.

Name

Specifies the name of the new collection.
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Perform Electronic Signature Window

Use the Perform Electronic Signature Window to add an electronic
signature to a data file. Add signatures as required by the
company’s standard operating procedures. (Data files cannot be
signed while the assay is running.) If multiple data files are open in
the workspace, only one data file can be signed at a time. This
window is only available if the LabChip GxP option is installed with
the LabChip GX Reviewer software.

To open the Perform Electronic Signature Window, select Security
- Perform Signature on the LabChip GX Reviewer Main Window.

Perform Electronic Signature — *

You are currently signing the data file:
DNASK_2023-09-23_04-07-45_SimRun

Usemame: administrator v
Role: Administrator
Enter Commert: |

Approval State: (@) Unreviewed () Accepted (O Rejected
Lock L]

Enter your user |
password:

Figure 117. Perform Electronic Signature Window

The Perform Electronic Signature Window contains the following
options:

Options Description

Data File Displays the name of the data file being signed.

Name

Username Select the user name of the user that is signing the data file.

Role Displays the Access Level of the selected LabChip GX Touch user.
Comment Details on why the signature is being performed and what actions

have taken place. It is the signer’s responsibility to ensure all
details required by the company’s procedures are included.

Approval State

Select the desired option: Unreviewed, Accepted, or Rejected. The
icons in the CDR Manager Window indicate the Approval State of
the data file. All new data files are set to Unreviewed by default.
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Options Description

Lock If selected, the data file cannot be saved and the Approval State
cannot be changed. Only users with the Unlock permission can
unlock data files.

User The password for the user.

Password

Sign button Signs the data file and closes the window.

Cancel button | Closes the window without signing the data file.
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Print Validation Reports Window

Use the Print Validation Reports Window to print the results after
performing Installation Qualification (1Q).

To open the Print Validation Reports Window, select Validation -
Reports on the LabChip GX Reviewer Main Window.

[ Print Validation Reports 6

| ~Report Options:

%) Software 12 Report
|| Failed Tests Only

| ~Report Period:
From: | Thursday . July 28,2016 |4

To: | Saturday . August 27,2016 |4

Print Preview i ([ Print Close

Figure 118. Print Validation Reports Window

The Print Validation Reports Window contains:

Option/Button

Function

Software IQ Report | If selected, the results of Software |Q tests are printed.

Failed Tests Only If selected, only tests that have failed are printed. If not

selected, both passed and failed tests are printed.

Report Period

Specifies the dates when the tests were run. Tests performed
between the From and To dates (inclusive) are printed.

Print Preview
button

Displays a preview of the report and enables you to print or
export the results.

Print button

Opens the Print window to print the report.

Close button

Closes the window.
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Print Window

Use the Print window to print information from the currently open
workspace. If the workspace contains multiple collections,
information from the active (selected) collection is printed. To open
the Print window, select File = Print on the LabChip GX Reviewer

Main Window.
LabChip GX - Print X
Print All Print Settings
M Gd Pfge Option Table Option
T (0 Portrait [ ] Add Border
@ Lnadacopn Peak Table

Overlay Blectropherogram 0 Add Well Name
Well Table Well Option As Header
Peak Table: (O Entire Collection

[ Exclude Marker (®) Selected Wells

[~ Muttiple Electropherogram Interleave Well Data

Layout: 12 s Footer

Rows X Columns

Pt TopDF Y Pt Qi Cancel

Figure 119. Print Window

The Print window contains the following options:

Option Function
Print All Selects all of the options.
Gel Prints a graphic of the gel for either all wells in the collection or all

selected wells.

Electrophero- | Prints a graph of either all wells in the collection or all selected

gram wells.

Fluorescence |Prints a graph of either all wells in the collection or all selected
Intensity wells.

Overlay Prints a graphic of all electropherograms (either all selected or all
Electrophero- |in the collection) over-laid onto the same graph.

gram

Well Table Prints the well table for either all wells in the collection or all

selected wells. The columns selected for view in the well table are
printed. Changing the columns selected to view in the Well Table
View changes the columns that are printed.
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Option

Function

Peak Table

Prints the peak table for all wells in the collection or all selected
wells. The columns selected for view in the peak table are printed.
Changing the columns selected to view in the Peak Table View
changes the columns that are printed.

* Exclude Marker - If selected, markers are not printed.

Multiple
Electrophero-
gram

Prints a graph of either all wells in the collection or all selected
wells in the specified format, rows by columns.
(Multiple Fluorescence Intensity for NAQuant NGS assays.)

Page Option

Select the page orientation, either Portrait or Landscape.

Well Option

Select the wells to be included in the printout, either Entire
Collection or Selected Wells.

Interleave Well
Data

If selected, the printout displays the data for each selected well
immediately after its electropherogram. If not selected, the
printout displays all selected wells first, followed by their
electropherograms in sequential order.

Footer

If selected, the standard footer prints at the bottom of each page.
If not selected, the footer is not printed.

Print Replicate

Displays only if replicates have been defined in the Replicates

Reports Tab. If selected, opens the Replicate Report Generator Window to
type the settings for the Print Replicate Report.

Add Border If selected, the Well Table and Peak Table will print with a border

Option between each column and a border below the column header.

Add Well Name | If selected, a well header, containing the plate, well, and sample

as Header name for the well, is printed before each set of peaks in a well.
(This option is only available if Peak Table is selected.)

Column Specifies where to print the column headers, which identify each

Header column in the Peak Table. (This option is only available if Peak

Table is selected and Well Table is not selected.)

» If Per Page is selected, the column header is printed only at
the top of each page.

+ If Per Well is selected, the column header is printed at the top
of each page and at the start of each new well.

Preview button

Displays a preview of the selected options.

Print to PDF
button

Prints the selected information from the active collection to a pdf
file.

Print button

Prints the selected information from the active collection to the
default Windows printer.

Cancel button

Closes the Print window without printing.
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Replicate Report Generator Window

Use the Replicate Report Generator window to define the Print
Replicate Report settings.

To open the Replicate Report Generator window, click the Print
Replicate Reports button on the Print Window.

Plate: DNASK_2023-09-23_04-07-45_SimRun

a-! Replicate Report Generator — [m] x

Custom

Select Report Title Property Replicates Columns

N O v | <all>

Figure 120. Replicates Report Generator Window

The following buttons display in the Replicate Report Generator
window:

Button

Function

Exclude Wells

Opens a plate map to select wells to exclude from the
replicate averaging. The excluded wells appear in the
replicate report as strike-through values to indicate that they
are not included in the statistics.

Annotate Results | Displays the Replicate Report in a table format, including the

Replicate set number, replicate set name, well name, Mean,
StdDev., CV%, and user defined columns.

Setup Reports

Returns the window to the original view after selecting
Annotate Results.

Print Preview

Displays a preview of the report and allows you to print or
export the results.

Print to PDF Prints the selected information from the active collection to a
pdf file.

Print Opens the Print window to print the report.

Cancel Closes the window without applying the replicate report

settings.
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The following columns display in the Replicate Report Generator
window:

Column

Description

Select check box

Adds the selected report title to the Replicate Report.

Report Tile Type the desired report title.

Property Select a well property to be measured from the drop-down
menu.

Replicates If <all> displays, all replicate wells are included in the

Replicate Report. Double-click the row to select individual
replicates for the report.

Custom Columns

Double-click to open the Replicate Equation Editor Window to.
Type custom settings to include in the replicate report.
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Replicate Equation Editor Window

Use the Replicate Equation Editor Window to create custom
columns to add to the Print Replicate Report.

u:' Replicate Equation Editor = | X

| Cear | | vean I suoev JcvJf] a

e e |

Title %f‘,* Equation to Evaluate
BN C
O

Figure 121. Replicate Equation Editor Window

The following options display on the Replicate Equation Editor
window:

Option

Function

Clear button

Removes all current selections from window.

Mean button

Adds the mean value to the equation to evaluate.

StdDev button

Adds the standard deviation value to the equation to evaluate.

CV button

Adds the CV value to the equation to evaluate.

Replicate Selector
Drop-Down List

Selects the specific replicate property to be added to the
equation to evaluate.

+ '*I!<!>!<=!

>=, And, Or, (,)

Operator values added to the equation to evaluate.

Delete button

Removes the last item added to the equation to evaluate.

Space button

Adds a space between operate values in the equation to
evaluate.

Insert Number

Adds the numbered typed in to Insert number text box into the
equation to evaluate.

Insert Number text
box

Type the desired number to be added to the equation to
evaluate.
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Option Function

OK button Applies the changes set in the Replicate Equation Editor
window.

Cancel Closes the window without applying the changes set in the
Replicate Equation Editor window.

The following columns display in the Replicate Report Generator

window:
Column Description
Title Displays the preferred custom column heading title to be
added to the report.
Check box? If selected, adds a check box to the rows in the custom

column. If the result of the equation set in the Equation to
Evaluate column is true, the check box is selected in the
replicate report. If the result of the equation is false, the check
box is not selected.

Equation to Displays the equation to be evaluated in the custom column of
Evaluate the Replicate Report. For example, Mean > 100 & Mean <
150.
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Rename Collection Window

PN CLS151165 Rev H

Use the Rename Collection window to rename the currently
selected collection. The collection name displays on the Collection
tab at the top of the LabChip GX Reviewer Main Window. To open
the Rename Collection window, select Collection > Rename
Collection on the LabChip GX Reviewer Main Window.

Mame: Collection 1

o |

Figure 122. Rename Collection Win;:low

Name - Type the desired name for the selected collection.
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Run Info Window

Use the Run Info window to view information about the run options
for the selected plate data file. The Run Info window also displays
the calibration options for the selected well containing the VeriMAb
sample (for Protein Clear HR assays only).

To open the Run Info window, select View = Run Info on the Menu
Bar, or right-click on the name of the data file above the plate
diagram and select Run Info.

i Run Info  Evert Log
T Title WValue
1 HT DNA TK/A2K
; Assay Name HT DNA 12K Bxtended Time
5 | Software Version 20.257.0
3 | Fimware Version [1.04.0.16858L
7 | Instrument Name | ASTDEMO1
= | Instrument Serial Number | GX081BN000T
Operator Name :Operator
Reagent Kt Lot Number | NJ/A
Data File Path D:h\Labchip_ProjectLabChipiLabChip'LabChip'GX Touch*Build\Debug'Demo Data‘\Demo DNA 12K gxd
Auto Export | False
Auto Export Path |
Barcode
Barcode Used False
Plate Type |96
Plate Name 96-PCR Skited (Sip Middle}
Plate Height 115.00 mm)
Run Start Date/Time 28-08-2009 13:36:49
Mumber Of Cycles B
Sip Order Row-wise
Selected Samples |G1.G2.G3.G4.G9,G10,G11,G12, H1,H2, H3,H4 H5, HE, H7, HB
Sample Saver True
Sample Saver Repeats |6
Sample Count 56
Well Spacing 19.00 fmm)

Figure 123. Run Info Window
The information in this window is view-only and cannot be changed.

The Run Info tab displays assay information and run/calibration
information.

The Event Log tab displays the events that occurred during the
run/calibration.
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Run Info Window (Continued)

The Run Info window contains the following buttons:

Button

Function

Print
Preview

Opens the Print Preview window to view the run information before
printing.

Print

Opens the Print window to print the run information.

Cancel

Closes the Run Info window.
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Sample Name Editor Window

Use the Sample Name Editor window to specify names for the
samples in the plate. For DNA, Protein, Glycan, CZE, and gDNA
assays, also can be used to view, add, edit, or delete expected
peaks. Sample Names can be exported to a .CSV file to be re-used
in other workspaces or for other plates.

To open the Sample Name Editor window, choose Tools > Sample
Name Editor on the Menu Bar.

Apply to 12k DNA Demo 4_2009-08-28_01-36-43 (] Edit Expected Peaks
‘I'_'\;eb"el Sample Name User Comment
AT [ Ladder '
A2 1/2 Ladder

A 1/ Ladder
24 | Blark
a5 | Prix174 BsuRI ~25 g
26 PRiIX174 BsuRl ~2.5 ng/d
[a7 | Prix174 BsuRI ~0.25 ng/ul
28 | Blark
[as [10.000bp
A0 |5000bp
[a11 |2500bp
A2 |350bp
[B1 [ Blark ' |
B2 BetEll ~25 ng/dl '

PN CLS151165 Rev H

. - = Orderby: @ Row () Column :

Export Blank 96 Wells Blank 384 i Close
== E= = vty e 0 I D |
Figure 124. Sample Name Editor Window

Edit Expected Peaks check box - If selected, displays the
Expected Peaks and Window (%) columns for DNA, Protein,
Glycan, CZE, and gDNA assays. This option is not available for
RNA assays.

Add Size check box - If selected, the Size column is added to the
Sample Names Table. (NAQuant NGS assays only.)

Add Dilution check box - If selected, the Dilution column is added
to the Sample Names Table. (NAQuant NGS assays only.)
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The following columns display in the Sample Name table:

Column

Description

Well Label

Displays the row letter and column number of each well. Wells
are ordered by column if the Order by Column check box is
selected. If the window is opened from the Start Run Window, the
wells display by column or well depending on the selection on the
Run tab. If a plate is running when the window is opened, the
wells display by column or well based on the sip order of the
currently running plate.

Sample Name

The sample name for the sample in the specified well. Type a
new name to change the sample name.

Sample
Comment

Any comment to be associated with each well of the plate.
Displays in the Well Table View.

Expected Peaks

Displays the Expected Peaks for DNA, Protein, Glycan, or
Protein Charge Variant assays. (The Expected Peaks are also
displayed in the Expected Fragments/Proteins/Glycans Tab on
the Assay Analysis Window.)

Only displays if the Edit Expected Peaks check box is selected.

Window (%)

Specifies the tolerance window as a percent of the expected size
for the peak to allow for small variations in expected peak size.
Only displays if the Edit Expected Peaks check box is selected.

Size The size of the dsDNA in BP (Base Pairs).
Dilution The dilution factor of the samples. (Current concentration x
Dilution Factor = original concentration)
The following buttons and options are located at the bottom of the
Sample Name Editor window:
Button Description
Import Imports a sample name file (*.csv) into the Edit Sample Names
window.
Export Exports the current sample names and comments into a Sample
Names (*.csv) file. See Using Sample Names Files on page 39.
Blank 96 Wells | Clears the sample names in the window and creates a new

sample name that is the same as the well label for each well in a
96 well plate.

Blank 384 Wells

Clears the sample names in the window and creates a new
sample name that is the same as the well label for each well in a
384 well plate.

Order by

Row - The sample names are ordered by row (A1, A2, A3, etc.).
Column - The sample names are ordered by column (A1, B1, C1,
etc.).
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Group By
Quadrant

If selected, the sample names are grouped by quadrant, as well
as by rows or columns.

Apply

Applies the sample name changes to the plate. Sample Names
cannot be applied during a run.

Close

Closes the Edit Sample Names window. If changes have not
been applied to the plate, prompts you to discard the changes. To
save the changes, click the Apply button before clicking the
Close button.
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Save Workspace As Window

The Save Workspace File As window saves the currently open
workspace with the specified name in the specified location.

To open this window, choose File > Save Workspace As. This
window also opens the first time you save a new workspace.

5

Save Workipace File As =]
(¢ [ # LabChip GX » Cats » 2012-00-23 = o7 | [ 2tz =]
Degangs = M lolder Do W
Cahpar Life Soences
CD&
LabChip D
LabiChip G @
hazay
Cypress LISE Driver
Dusts
2002-00-23
Dernig Dats
Documentation
Fermiwang
FTDE RS2 Drever 3
File rame a
S i BypE | Wock ipace Tilei™ g &
= Ficia Fkdory fsm ) Cance

Figure 125. Save Workspace As Window

Tip: You may want to save the workspace file in the same location
as the plate data files to prevent missing plate data files when
moving workspace files.

If the LabChip GxP option is installed, the data files are saved in the
CDR. Workspace files are saved outside the CDR.
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Select a Data File Window

When you choose Import Data File from the File Menu, the Select
a Data File window opens as shown in Figure 126. (If the LabChip
GxP option is installed, the CDR Manager Window opens.) Data
files generated by the LabChip GX or GX Touch software have a
.gxd file extension. Data files generated by the LabChip HT
software have a .cla file extension; change the File Type to display

.cla files.
T < Build » Debug » Demo Data w & Search Demo Data -l
Organize « New folder =~ 0 0
~
M Desktop MName Date modified Type Size
% Debug [F] Demo cfDNA 28-03-2023 15:35 GXD File 7
LabchipReviwer [7] Demo DNA 1K GXD File Ty
o= DATA (D) D Demo DNA 5K 96 wells GXD File
D Demo DNA 5K 384 wells GXD File 16,
» @ OneDrive [7] Demo DNA 12K GXD File
« [ ThisPC D Demo DNA High Sensitivity GXD File
» i 0s(c) D Demo gDMNA 28-03-2023 15:35 GXD File
[ e G TGS SPUINIE ATy Aoy 30 A3 73 15.05 AVH Eil
5 = DATA (DY)
File name: | v LabChip GX Data files(*.gxd)
Open Cancel

Figure 126. Select A Data File Window

Select a data file name in the list box and click the Open button or
double-click a file name to open the data file.

To select multiple files, press and hold CTRL then click each file
name. To select a continuous block of files, click the first file, press
and hold SHIFT, and then click the last file. To select all files, press
CTRL+A.
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Software Installation Qualification Window

Use the Software Installation Qualification Window to perform the
IQ test. The 1Q test verifies proper installation of the LabChip GX
Reviewer software and verifies no unauthorized changes have been
made to the software. To open the Software Installation
Qualification Window, select Validation = Software I1Q on the
LabChip GX Reviewer Main Window.

Software Installation Qualfication
Application Information:
Directory Structure:

Files:

Summany:

Progress:

Figure 127. Software Installation Qualification Window

The Software Installation Qualification Window contains the
following information:

Option Function

Application Verifies that the LabChip GX Reviewer registry entries exist. If all

Information expected registry entries are found, displays Passed. If any
problems are found, displays Failed.

Directory Verifies that all folders exist. If all expected folders exist, displays

Structure Passed. If any folders are not found, displays Failed.

Files Verifies that all files that were installed by the LabChip GX
Reviewer software still exist. If all file exist, displays Passed. If
any files are not found, displays Failed.

Summary Displays Passed if all tests passed. Displays Failed if any of the
1Q tests failed.

Progress Displays a progress bar while the 1Q test is running.

View Details
Button

Displays the detailed results of the current IQ. (Only displays after
the 1Q has been completed.)

Previous
Result button

Displays the results of the last 1Q that was completed. (Only
available before another 1Q test is run.)

PN CLS151165 Rev H

LabChip GX Reviewer User Manual

VWV



Software Reference 253

Option Function
Save As Saves the results of the IQ in an .xml file.
button

Start 1Q button

Begins running the 1Q.

Close button

Closes the Software Installation Qualification Window.
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Unlock Application Window

Use the Unlock Application Window to access the LabChip GX
Reviewer software after it automatically locks. This window displays
on top of the LabChip GX Reviewer software when the software is
locked. The automatic lock option is set in the Set Policies tab on
the User Administration Window. This window only displays if the
LabChip GxP option is installed.

LabChip GX has been locked. Only
'administrator’ or an Administrator can unlock
this application.

Usermname: |administrator |

Password: | |

Figure 128. Unlock Application Window

The Unlock Application Window contains:

Option/Button

Function

Username Type the user name of the current user or a LabChip GX
Touch administrator’s user name.

Password Type the password for the specified user name.

OK button Verifies the Username and Password and opens the LabChip

GX Reviewer software if the Username and Password are
valid.
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Unlock Data File Window

Use the Unlock Data File Window to unlock a data file to enable the
data file to be saved or to change the Approval State of the data file.
Only users with the Unlock Data Files permission are permitted to
access this window. Administrators can change this setting in the
Edit Users tab on the User Administration Window. The Unlock
Data File option is only available if the LabChip GxP option is
installed.

To open the Unlock Data File Window, select Security — Unlock
Data File.

v Unlock Data file 5 bt

You are currently unlocking the data file:
2023-09-27_13-15-13_wwl

Usemame: administrator i
Role: Administrator

This file is being unlocked! Please explain reason for this action.

Enter Reason:

Enter your user | |

passwond:
| uniock | Cancel |
Figure 129. Unlock Data File Window

The Unlock Data File window contains:

Username - Select the user name of the LabChip GX Touch user
that is unlocking the data file.

Reason - Type the reason why the data file is being unlocked.

User Password - The password of the selected LabChip GX Touch
user.

Unlock button - Unlocks the data file specified at the top of the
window if the Username and Password are correct.

Cancel - Closes the Unlock Data File window without unlocking the
data file.

To lock a data file, use the Perform Electronic Signature Window.
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User Administration Window

PN CLS151165 Rev H

Select Task

Create New User

Edit Users

Show User Info

De/Activate User

Define Access

Set Policies

Close

Use the User Administration window to create new LabChip GX
Touch users, to edit existing users, to view user information, to
activate or deactivate users, to set rights for each access level, and
to set policies for LabChip GX Touch software and LabChip GX
Reviewer software. The User Administration Window only displays
if the LabChip GxP option is installed.

If multiple GX or GX Touch instruments are connected to the CDR,
all user accounts are available on all instruments and each user
name has the same access rights on all instruments.

To open the User Administration window, choose Security > User
and System Administration.

Create New User:

Usemame:

First Name:
Middle Name:
Last Name:

Posttion: Unknown

Access Level: Administrator L

Password:

Confirm Password:

a

User Can Perform Signature:
Accept/Reject/Lock data file:
Unlock data file

Figure 130. User Administration window

The User Administration window contains the following tabs:

Create New User on page 257
Edit Users on page 259

Show User Info on page 260
De/Activate User on page 262
Define Access on page 263
Set Policies on page 265

Close button - Closes the User Administration window without
saving changes. Save the changes on each tab before closing the
window.
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Create New User

Use the Create New User tab to add a new user name to the
LabChip GX Touch software and LabChip GX Reviewer software.
This window creates the LabChip GX Touch user account, it does
not create a Windows user account.

w LabChip GX - User Administration *
Select Task Create New User:
Create New User lsemame [
First Name: |
Middle Name |
Last Name [
Position: | Unknown
Access Level: ety i =

Password: |

Confirm Password: |

User Can Perform Signature:
Accept/Reject/Lock data file:
Unlock data file

oo®

Figure 131. User Administration Window - Create New User

The Create New User tab contains:

Option/Button Function

Username Type the user name that the new user will use to log into the
LabChip GX Touch software or the LabChip GX Reviewer
software.

First Name Type the first name of the user.

Middle Name Type the middle name or initial of the user.

Last Name Type the last name of the user.

Position If desired, type the job title of the user.
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Option/Button

Function

Access Level

Choose the access level for the user. The access level
controls the user’s rights in the LabChip GX Touch and GX
Reviewer software. The following access levels are available:
* Restricted User - Can only access Audit Trail.

* Operator - Operates the LabChip GX Touch instrument.

» Supervisor - Can save existing data files.

* Administrator - Run assays, analyze data files, edit assays,
and manage user accounts and CDR for LabChip GxP
option.

» Service - Run Assays and perform system validation.

The default permissions described above can be changed by

an administrator.

Password

Type the desired password for the user. The password must
meet the password policies selected on the Set Policies tab.

Confirm Password

Repeat the desired password for the user.

User Can Perform
Signature

If selected, the user can sign data files using the Perform
Electronic Signature Window.

Accept/Reject/
Lock Data File

If selected, the user can Accept, Reject, and/or Lock data files
in the Perform Electronic Signature Window.

Unlock Data File

If selected, the user can unlock data files using the Unlock
Data File Window.
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Edit Users
Use the Edit Users tab to edit an existing user account.
W LabChip GX - User Administration X

Select Task Edit a User:
Select User to Edit: User1
Usemame: User1

o e

Middie Name
Last Name
Pasttion: |Unknown
Access Level: Aehisectratre

User Can Perform Signature
Accept/Reject/Lock datafile:  []
Unlock data file 0

[[] Edit User Password:

Figure 132. User Administration Window - Edit Users

The Edit Users tab contains:

Option/Button

Function

Select User to Edit

Select the Username for the account to edit.

First Name The first name of the user.

Middle Name The middle name or initial of the user.
Last Name The last name of the user.

Position If desired, the job title of the user.

Access Level

The Access Level of the user.

User Can Perform
Signature

If selected, the user can sign data files using the Perform
Electronic Signature Window.

Accept/Reject/
Lock Data File

If selected, the user can Accept, Reject, and/or Lock data files
in the Perform Electronic Signature Window.

Unlock Data File

Data File Window.

If selected, the user can unlock data files using the Unlock

Edit User If selected, the user’s password can be changed.
Password
Password Type the desired password for the user. The password must

meet the password policies selected on the Set Policies tab.

Confirm Password

Repeat the desired password for the user.
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Show User Info

Use the Show User Information tab to view the account information
for an existing Username.

w LabChip GX - User Administration X
Select Task User Information:

Select User to Display- administrator v

Lisemame administrator

Full Name Default Administrator

Posttion:
how Use ki Access Level: Administrator

Can Perform Signature: YES

Can Accept/Reject/Lock data file: YES

Can Unlock data file: YES

Account Created On: Thursday, August 21, 2014 at 3:30:25 PM

Account Last Changed On: Saturday. September 23, 2023 at 7:17:51 AM

Status Active

3 Pt Al oo Pon Proion. | i

Figure 133. User Administration Window - Show User Info
The Show User Info tab contains:

Option/Button Function
Select User to Select the Username for the account to view.
Display
Username The user name for the displayed information.
Full Name The first, middle, and last name of the user.
Position The job title of the user.
Access Level Displays the Access Level of the user.
Can Perform Displays Yes if the user has rights to perform signatures.
Signature Displays No if the user does not have rights.
Can Displays Yes if the user has rights to Accept, Reject, and Lock
Accept/Reject/ data files. Displays No if the user does not have rights.
Lock Data File
Can Unlock Data | Displays Yes if the user has rights to unlock data files.
File Displays No if the user does not have rights.
Account Created |Displays the date and time when the account was created.
On
Account Last Displays the date and time when the account was last
Changed On changed.
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Option/Button

Function

Status

Displays Active if the user account is activated. Displays
Deactivated if the account has been deactivated.

Print All Users
check box

If selected, information for all user accounts will be printed.

Print Preview
button

Displays a preview of the printed report. The report can be
exported to a .rpt file from the Print Preview window.

Print button

Opens the Print window to print the report.
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De/Activate User

Use the De/Activate User tab to Deactivate an active user or to
Activate a deactivated user. Users cannot be deleted from the
database. User names that will not be used should be deactivated
to prevent unauthorized access to the LabChip GX Touch or
LabChip GX Reviewer software.

w LabChip GX - User Administration X
Select Task De/Activate a User:

Select User: Userl ~
User Information:
Usemame: User1
Full Name fiminn
Position: Unknown
Access Level: Administrator

Bariiae ter Account Created On:  Saturday. September 23, 2023 at 3:51:24 AM
Accourt Last Changed On: Saturday. September 23. 2023 at 3:51:24 AM
Status Active

Note: A deactivated user can no longer log in.

Figure 134. User Administration Window - De/Activate User

The De/Activate User Info tab contains:

Option/Button

Function

Select User

Select the Username to be activated or deactivated.

User Info

Displays the information associated with the selected
Username.

Activate button

Click to activate a deactivated Username.

Deactivate button | Click to deactivate an active Username.
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Define Access

Use the Define Access Tab to assign the desired rights to each
access level. These rights control the actions each user is permitted
to perform in the LabChip GX Touch software and the LabChip GX
Reviewer software.

w LabChip GX - User Administration X

Select Task Assign Access Levels:

Access Rights Administrator Supervisor Operator ricted

¥
0§
i

» ] |

O O

|save Existing Data File | (| (]

Save Workspace ] ] [l ]

Plate Editor | L] ] L]

Hide/Show in CDR 0l O (]

Manage CDR Folders O L] O u
Perform Validation O O

Print/Export Analysis Resuits [ 0 ] O O

Aot Trail Aecess O g

Assay Editor | L] ] ||

Figure 135. User Administration Window - Define Access

The Define Access tab displays a column for each access level
(Administrator, Supervisor, Operator, Restricted User, and Service).
Select the check box for each right to be allowed for an access
level, or clear the check box for each right not allowed for an access
level.

The table below describes the function of each Access Right.

Access Right

Function

User
Administration

If selected, allows access to the User Administration Window
to add and edit users, set access rights, and set policies.

Run Assay

If selected, allows users to run assays and save the new data
files that are created by the run. Users are not permitted to
save changes to existing data files.

Save Existing Data | If selected, allows users to save changes to existing data

File files.

Save Workspace If selected, allows users to save new and existing
workspaces. If Save Existing Data Files is not selected,
users can only save workspaces where the data files have
not changed.

Plate Editor If selected, allows users to add plates or edit plate

dimensions in the Plate database.

PN CLS151165 Rev H

Hide/Show in CDR | If selected, allows users to hide and show data files in the

CDR Manager Window.
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Access Right

Function

Manage CDR
Folders

If selected, allows users to create, rename, and delete
folders in the CDR Manager window.This permission is not
required for automatically creating daily subdirectories or to
move data files in the CDR.

Perform Validation

If selected, allows users to perform 1Q (Installation
Qualifications), OQ (Operation Qualifications), Teaching the
robot, and Optics Calibration/normalization.

Print/Export
Analysis Results

If selected, allows users to print or export analysis results.

Audit Trail Access

If selected, allows users to view the Audit Trail in the Audit
Trail Window.

Assay Editor

If selected, allows users to edit and save assays.
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Set Policies

Use the Set Policies tab to specify password, login, automatic lock,
and signature policies for the LabChip GX Touch software and
LabChip GX Reviewer software.

W LabChip GX - User Administration X
Select Task Set Policies
Policies:
Password expires after 50 4| (1to 1000 Days)
Number of retired passwordsto |3 2] (0to5)
remember:
Minimum password length 5 £/l (5to 30 Characters)
Maximum login attempts: 3 2| (3to20)
Minutes to automatic lock 5 <] (5Minsto 3 Days)

[0 Redquire signature on file update
Users who do not have perform signature right will not be allowed to
update existing data files.

Note: Policies are global. They apply to ALL login passwords. (However,

administrators are exempt from the maximum login restriction )

[_Save [l Pint Proview. [l Print_|

Figure 136. User Administration Window - Set Policies

The Set Policies tab contains:

Access Right

Function

Password Expires After

Specifies the number of days until each password
expires. Range is 1 to 1000 days.

Number of Retired
Passwords to Remember

User cannot reuse the specified number of old
passwords.

Minimum Password
Length

Specifies the minimum length of each password.

Maximum Login
Attempts

Specifies the number of times the user can attempt to
log in before being locked out of the software. Range is
from 3 to 20. This option can be disabled to allow
unlimited retries without locking the user out.

Minutes to Automatic
Lock

Specifies the number of minutes that the software is
inactive until the LabChip GX Touch software or
LabChip GX Reviewer software locks automatically.
Range is from 5 to 4320 minutes (3 days). To disable
this option, clear the check box.
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Access Right

Function

Require Signature on File
Update

If selected, an electronic signature is required to save
modified data files. Signatures can be performed by
any user with the Perform Signature option selected in
the Set Policies tab.
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Troubleshooting and Diagnostics

This section contains the following topics to help troubleshoot
problems with the LabChip GX Reviewer software:

* Running Installation Qualification (IQ) on page 268
» Software Troubleshooting on page 269

— Cannot Save a File on page 269

— Computer Software Lock-Ups on page 270

— Cannot Connect to Remote CDR Server on page 270
» Zipping the Log Files on page 271
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Running Installation Qualification (1Q)
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The Installation Qualification (1Q) verifies proper installation of the
LabChip GX Reviewer software and verifies no unauthorized
changes have been made to the software. The IQ can be run
whenever required by your laboratory procedures.

The Installation Qualification can be used to check software
installation qualification after routine computer maintenance, such
as disk cleanup, after installing antivirus software, or after installing
Microsoft® service packs. The Installation Qualification checks
LabChip GX Reviewer software registry settings, the directory
structure, and the integrity of each file specified for the software
application.

To run the 1Q:

1 On the LabChip GX Reviewer Main Window, select Validation
— Software 1Q. The Software Installation Qualification Window
opens.

2 To view the results of the previous 1Q before running a new IQ,
click the Previous Result button. The View Installation
Qualification Results Window displays the results of the last 1Q
that was run.

3 To start the 1Q, click the Start 1Q button. The Software
Installation Qualification window displays the tests that are run
for the 1Q, the progress of each test, and the Pass/Fail status of
each test as it is completed.

4 To save the results of the IQ, click the Save As button, specify
the desired location and name of the file, and click the Save
button. 1Q results are saved as .XML files.
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Software Troubleshooting

If any of the following software problems occur, follow the
suggestions to correct the problem:

+ Cannot Save a File
* Computer Software Lock-Ups on page 270
» Cannot Connect to Remote CDR Server on page 270

Cannot Save a File
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File has been saved as a Read Only file.

If you editing an existing file, verify the file is not Read Only. If it is,
the title bar shows Read Only after the file name. Read-only files
can be edited and saved with a new name or in a new location with
the same name, but cannot be saved over the original file.

Hard drive is full.

Verify there is sufficient free space on the drive to save the file. If
not, clear some space on the hard drive. On systems that do not
have the LabChip GxP option installed, you can archive files that
you are not using to another location.

If you do have sufficient space, try closing all open applications and
then turning off the power to the computer. After a few seconds,
restart the computer, open another file, and try re-saving it to verify
the Save function is working properly.

LabChip GX Reviewer software is corrupted.

Reinstall the software. If the problem persists, contact Revvity
Technical Support (see page 2).
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Computer Software Lock-Ups

If a computer or software lock-up occurs:

1 Try to exit and then re-launch the LabChip GX Reviewer
software.

2 If this is not successful, exit the application using the Task
Manager:

a Right-click in the desktop menu bar and select Task
Manager.

b Click the Applications tab.

¢ While holding down the Shift key, select all running
applications.

d Hold the Ctrl key and click End Task.

3 Ifthe Task Manager cannot be accessed, try one or all of the
following:

* Press the Ctrl, Alt, and Delete keys on the keyboard
simultaneously.

* Perform a hard reboot by turning off the computer and then
restarting it.

4 Contact Revvity Technical Support (see page 2).
Cannot Connect to Remote CDR Server

If experiencing trouble connecting to the CDR server computer:

* If using a firewall other than Windows® Firewall, open Port
TCP/3690 for incoming traffic on the server computer.

* Ensure that the server computer is reachable from the GX
Reviewer client by pinging the CDR server from the DOS
Command window on the client computer.

* Verify that the network provides a DNS for name to IP mapping.

— The Windows® name Service will not work for name
mapping the SVN connection.

— If the server computer does not have an entry in the
DNS, the server IP address must be used for mapping
and the IP address must be assigned statically.
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Zipping the Log Files

The LabChip GX Reviewer Log Zipper utility zips the LabChip GX
Reviewer log files and system info files and places the resulting
DiagnosticsLog.zip file on the computer desktop. This utility
packages all of the log and diagnostic files together so the files can
be emailed to Revvity Technical Support.

To zip the LabChip GX Reviewer diagnostics logs:

1 On the Windows desktop, select Start > All Programs >

Revvity > LabChip GX Reviewer Log Zipper. The GX
Reviewer Log Zipper window opens.

-,
=

This Litility will zip all the diagnostics related directories and files.

Figure 137. GX Reviewer Log Zipper Window

2 Click the Zip button. The DiagnosticsLog zip file is saved to the
computer desktop. The file name is DiagnosticsLog-
<date>_<time>.zip, where <date> format is YYYY-MM-DD and
<time> format is hh-mm-ss.
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Tips and Shortcuts

This section describes the shortcuts and actions that can be
performed in the LabChip GX Reviewer software by clicking, right-
clicking, etc.

Single Click
* In Plate View - Selects or clears a well.

* In Gel View - Selects a well and displays the graph in the Graph
view.

* In Well Table View - Selects a well, displays the graph in the
Graph view, and selects the well in the Gel view.

* In Peak Table View - Selects a peak, displays the graph in the
Graph view, and selects the well in the Gel view.

Ctrl + Click

* In Gel View - Overlays second and subsequent well data over
original well data in the Graph view (for each Ctrl + click on a
lane in the gel). Each well in the graph is shown in a different
color.

* In Well Table view - Overlays second and subsequent well data
over original well data in the Graph view (for each Ctrl + click on
a row in the Well Table). Each well in the graph is shown in a
different color.

Ctrl + Shift + Click

* In Gel View - Highlights corresponding well data trace in
Overlay Electropherogram view (adds trace to overlay if not
already included). This trace becomes the foreground trace for
peak selection. Repeat click to undo highlighting.

Right-Click

* Right-click in any view to display a shortcut menu with available
options. In the Graph View, different shortcut menus display
depending on whether the cursor is near a peak or not near a
peak.
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Glossary of Terms

This Glossary includes explanations and examples of the following

terms:

*  Apex

* Assay File
* Baseline

« CLA

* Clipboard

» Collection

* Collection Template
+ Data Files

+ Data Points

« Data Filtering

+ DNA Assay Analysis
» Electrokinetic Forces
* Electroosmotic Flow
* Electrophoresis

 End Point

« End Time

+ Filter Width

* Genomics Quality Score [0-5]
* GXD Files

* Inflection Threshold

* Lab-on-a-Chip

* Ladder

» Ladder Analysis

* Lower Marker

* Log Files

* Microfluidics

* Migration Time Drift

*  Minimum Peak Height

*  Minimum Peak Width

* Molarity

* Molecular Separation Techniques
*  NAQuant NGS Assay Analysis
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Apex

* Optical Calibration

* Peak Baseline

+ Peak Height

* Peak Identification

* Point-to-Point Fit

* Polynomial Filter

* Polynomial Order

* Protein Assay Analysis

* Protein Charge Variant Assay
*  RNA Assay Analysis

* RNA Degrade Factor

* Rolling Ball Baseline Curve Example
» Slope Threshold

» Slope Threshold

*  Smear

+ Standard Curve

+ Start Point

e Start Time
* Titer
» Tool Tip

* Upper Marker
»  Workspace
» Zero Baseline

After locating a start point, the peak find algorithm looks for the first
negative slope value and saves the previous point as the apex. If
the value of the apex is less than the minimum peak height limit, the
algorithm starts looking for a new peak.

Assay File
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File used by the LabChip GX or GX Touch software to specify assay
and default analysis settings, such as Ladder and marker sizes and
concentrations, peak find settings, expected peaks, and excluded
peaks.

Create assay files and modify analysis settings in the LabChip GX
Reviewer software.
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Baseline
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A baseline is established just after the start time setting. (For DNA
and RNA assays, you can change the Baseline Start time on the
Analysis Tab.) After the overall baseline is established, a local
baseline is calculated for each peak to compensate for baseline
drift.

To select the desired baseline algorithm for all of the samples in the
plate, choose the desired option on the Peak Find Tab: No
Baseline, Zero Baseline, or Baseline Subtraction. See Zero
Baseline on page 300 for more information about the Zero Baseline
option.

Baseline Subtraction can use either Spline fit or Rolling Ball fit for
the baseline curve algorithm.

* Spline - Creates a smooth line fit to the baseline data points and
subtracts this smooth fit from the data. The Threshold
determines how much the baseline fit follows changes in the
data. Lowering the Threshold below the default value of 20
allows the baseline fit to ignore regions that are slow changes of
real signal peaks and not baseline drift. This spline curve is not
constrained to remain below the signal and may produce
negative signal values when subtracted from the signal.

* Rolling Ball - Generates a smooth baseline curve by
mathematically rolling a ball under the sample signal, keeping it
in contact with the closest signal point without crossing into the
signal. Time Diameter and Signal Diameter determine the
smoothness of the curve in the Time and Signal axes and
determine how closely the curve follows the signal. The ball is
constrained to never cross into the signal, therefore the baseline
curve is never greater than the signal and will not produce
negative signal values when subtracted from the signal. See
Rolling Ball Baseline Curve Example on page 293 for more
information.

For isolated peaks, the local peak baseline is a straight line
connecting the start point of the peak with the end point. For peaks
that are very close together, an average baseline is used when the
value between the peaks does not drop to the actual baseline.

Figure 138 on page 276 shows baselines established for DNA
assay peaks (based on the settings in the Peak Find Tab). DNA
peaks are determined on a peak-by-peak basis (the overall baseline
is shown).
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Figure 138. Baselines

CLA

The file extension for data files created by the LabChip HT
software. CLA files can be opened in the LabChip GX or GX
Reviewer software only if the LabChip GxP option is not installed.
Opening a .CLA file (see page 36) creates a .GXD file with the
same name.

Clipboard

A temporary storage area that contains information you have cut or
copied. You can paste the contents of the clipboard into other
programs (provided that program supports that type of information).
Information remains on the clipboard until you replace it with the
information from another cut or copy command.

Collection

Use a collection to view the plate data. A workspace can contain
multiple collections to supply different views of the same data.
Each collection specifies:

» the wells selected for view in each plate data file,

» the layout of each Collection tab, and

» the display properties for each view in each collection.
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Collection Template

A collection template saves the display options for a collection and
any defined filters in the collection. Collection templates are used to
create new collections using the saved display settings and filters.
Collection templates do not save the list of plates or the wells
selected in the plates.

To save a collection template based on the settings in the open
collection, select Collection -> Save As Template on the main
Menu Bar.

To apply a collection template to a new collection, select the
Template option in the New Collection Window.

To apply a collection template to an existing collection, select the
tab for the desired collection and then select Collection - Apply
Template on the main Menu Bar.

Data Files

While running an assay, the raw data received from the instrument
is automatically saved to the plate data file (*.gxd). As the data from
each single well is received, it is saved to the data file. The name of
the data file is specified during the run. If a run is stopped before
the run is complete, the data file contains the data for the completed
wells.

After a run is complete, the data is analyzed using the analysis
settings in the assay. The analysis settings are saved in the data file

(.gxd).

After the run, you can change the analysis settings using the Assay
Analysis Window. When the new settings are applied, the data is
reanalyzed and the updated results are displayed. Changes to the
analysis settings are not saved until the workspace is saved. To
save analysis settings without saving the workspace, select
Workspace — Save Plate or right-click on the plate name above
the plate diagram on the left side of the window and choose Save
Plate.

Changes to the analysis settings are saved at the end of the plate
data file without overwriting previous settings in the file. The
Restore Plate option can be used to return to previous analysis
settings.
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Data Points

Data points are determined by the data collection rate set in the
assay properties.

Show Data Points is an option in the Graph View Properties that
displays the data points used to generate the graph.

Data Filtering

Before identification of peaks in the fluorescence data can proceed,
the raw data is smoothed to prevent the detection of signal noise as
peaks. For details on the data filtering process, see Data Smoothing
on page 1009.

DNA Assay Analysis

DNA samples contain two marker peaks outside the limits of the
DNA fragment sizes the assay is designed to detect. The ladders
contain the same two marker peaks. The sample data is aligned to
the ladder data by matching the peak times of the two markers in
the sample data with the same two markers in the ladder data. The
size of each sample peak is calculated by linear interpolation
between the known ladder peak migration time and size using the
peak aligned migration time. The analysis settings can be changed
to perform the interpolation using a local third order polynomial fit to
the time instead of the size relationship provided by the ladder.

The concentration of the sample peaks is calculated using the
known area and concentration of the ladder peaks. The molarity of
each sample peak is calculated using the sample concentration, the
DNA fragment size (in base pairs) attributed to the peak, and the
known molecular weight of the DNA base pair.

Electrokinetic Forces
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Electrokinetic forces are used to move, switch, mix, and separate
the nucleic acid samples. Active control over voltage gradients
directs the movement of materials using the phenomenon of
electroosmotic flow or electromigration.
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Electroosmotic Flow

A phenomenon that results from an electrical double layer formed
by ions in the fluid and surface electrical charges immobilized on
the capillary walls. When an electric field is applied, the bulk
solution moves towards one of the electrodes. This phenomenon
can be used to move fluids through microfabricated channels

Electrophoresis

A technique of separating molecules on the basis of their mobility.
An electrical potential is applied across a capillary containing a
sample in a fluid medium. Positive molecules migrate towards the
cathode and negative molecules migrate towards the anode at
different speeds depending on their electrophoretic mobility.

End Point

The peak find algorithm looks for a leveling off when the value of
the slope is less than the value set for the slope threshold. This is
marked as the end point of the peak.

End Time

This setting determines the time after the start of a run before which
the last peak or fragment will be located (any peaks appearing after
this time are ignored).

Filter Width

This setting on the Peak Find Tab determines the width of the
polynomial (in seconds) to be applied to the data for filtering (noise
reduction). The default depends on the assay selected.

Genomics Quality Score [0-5]

Calculated in gDNA assays to measure the quality (relative
intactness) of the gDNA. The Genomics Quality Score ranges from
0 to 5, where 5 represents the highest quality of gDNA. The
Genomics Quality Score can be used to measure the quality of
gDNA before proceeding with further analysis of the sample. The
Genomics Quality Score displays in the Well Table View.
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GXD Files

The file extension for data files created in the LabChip GX and GX
Touch software. The data file contains the data from the read, assay
information, analysis settings, and Run Information for the run.

Data is saved to the file as each well is read. If a run is stopped
before the run is complete, the data for any completed wells is
saved in the data file.

The file name is specified during the run.

Inflection Threshold

Peaks that are very close together are identified as a single peak if
the peaks do not have a clear valley between them. The Inflection

Threshold property splits peaks based on the slope. The inflection

threshold defines the value that the slope minimum must be below
to trigger a splitting of the peak. As the threshold is increased, more
peak splitting occurs. For details, see Understanding Peak Finding
on page 108.

Lab-on-a-Chip
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The generic term for a microfluidic product, signifying a chemical
process or material movement taking place on a microchip. In
contrast to analysis in a standard laboratory that relies on human
intervention at several stages to manipulate or observe samples
and record results, the self-contained lab-on-a-chip represents an
almost hands-free technology.
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Ladder
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Ladders are used to align the data and calculate the size of data
peaks. (Protein Charge Variant assays do not use ladders or
markers.) The Ladder vial is located in the front right corner of the
microplate carrier, next to the buffer vial. The Ladder is sipped
before the first well and then after every 12 wells. The ladder is
analyzed before sample analysis starts.

The peak sizes and markers defined for the ladder in the assay are
assigned consecutively, starting with the first peak detected in the
ladder. If too few peaks are detected in the ladder well, analysis
stops and an error is generated. Peaks appearing above the upper
marker do not have to be detected. The Peak Table View for the
ladder well shows the peak size and concentration set in the Assay
Analysis Window.
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Ladder Analysis

A ladder is a mix of compounds of known sizes that is used to
create a size ruler for the samples. Ladder data is used to convert
the migration time of each sample peak into a size for the
compound responsible for that peak. The known sizes of the ladder
compounds are supplied in the assay file and can be viewed in the
Analysis Tab on the Assay Analysis Window.

The initial step in ladder analysis is to identify the most prominent
peaks in the ladder well and associate each peak with the known
ladder sizes. The analyzed ladders provide a table of values
relating size to migration time. Typically the migration time uses the
center of the peak in the ladder and the sample.

Failure to find the correct number of ladder peaks prevents further
analysis of the sample wells using the faulty ladder. The software
automatically attempts to use the nearest good ladder before
generating an analysis error.

A Ladder Quality Score is computed for each Ladder well. The
Ladder Quality Score is the R? value for the fit of the peak migration
times to size curve multiplied by 10. If the Ladder Quality Score is
less than the Ladder Rejection Threshold specified on the
Alignment Tab in the Assay Analysis Window, the ladder well
generates an error and is not used for sizing or quantization. The
software will use the nearest good ladder to analyze the samples.

The analysis settings can specify which ladder is used to size any
particular sample row. If more accurate sizing can be obtained by
measuring migration times at the start of each peak, this option can
be selected in the Assay Analysis Window.

Lower Marker

An internal standard that is added to a sample in a well to assist in
determining size and concentration of the sample. For DNA assays,
the marker is the same as the first peak in the DNA ladder. DNA
ladders and samples also contain an Upper Marker. For Protein and
RNA assays, the marker is the same as the first peak in the ladder.
Protein Charge Variant assays do not use ladders or markers.
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Log Files

The LabChip GX Reviewer software log file displays in the Export
Window. The log file maintains a running record of all events that
occur in the LabChip Reviewer software. Each event specifies the
date and time of the event, source of the event, the event code, and
a description of the event.

Microfluidics
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The miniaturization of chemical processes generally pertaining to
systems involved in the control of fluid flow. This includes pumps,
valves, jets, and microchannels.
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Migration Time Drift

Isolating the markers in the sample is key to alignment and sizing.
The markers in the sample appear similar in size and migration time
to the markers in the ladder. Markers are discriminated from nearby
peaks through a weighing scheme which attributes a numerical
value to the migration time similarity and area similarity. This
approach is usually successful as long as the first peak is the
marker, but when there is a peak of similar size arriving just before
the true marker, the first marker is likely to be confused with the
marker. When the primary differentiator between the two peaks is
the migration time, the migration time drift can be used to narrow
the acceptable range for the migration time by increasing the
importance of the similarity between the sample and ladder marker
peak times. The migration time drift specifies the accepted range as
a percentage of the ladder migration time. The blue and yellow
triangles shown in the figure below represent the weight assigned
to a peaks migration time for a tolerance of 100% and 10%
respectively.

- 100% Dirift

10% Drift  dTemetsed

Figure 140. Migration Time Drift

PN CLS151165 Rev H LabChip GX Reviewer User Manual



Glossary of Terms 285

As the migration time drift is reduced, the acceptable deviation from
the ladder marker migration time is reduced, causing the analysis to
reject nearby peaks preceding the true marker.

The migration time drift is specified on the Advanced Tab of the
Assay Analysis Window (see page 211).

Minimum Peak Height

The Minimum Peak Height value determines the height limit below
which a peak will not be detected. For each peak, the difference
between the peak start time and the peak apex must be greater
than the Minimum Peak Height value.

The Minimum Peak Height is specified on the Peak Find Tab of the
Assay Analysis Window.

Minimum Peak Width

The Min Peak Width value determines the width (in seconds) under
which a peak will not be detected. For each peak, the difference
between the peak start time and the peak end time must be greater
than the Minimum Peak Width value.

The Minimum Peak Width is specified on the Peak Find Tab of the
Assay Analysis Window.

Molarity

Molarity = (Concentration * 106)/(660 * Size)[nmol/l], where

* Molarity is measured in nanomoles per liter (nmol/l),

« Concentration is measured in nanograms per microliter (ng/uL),
» Size is measured in base pairs (bp), and

* 660 * [g/(mol * bp)] is the molecular weight of a single base pair

Molecular Separation Techniques

Processes such as gel electrophoresis, liquid chromatography, and
capillary electrophoresis, which can separate biomolecular organic
substances from other compounds.
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NAQuant NGS Assay Analysis

The NAQuant NGS dsDNA sample fluorescent intensity is
measured at a steady state between 33 and 37 seconds and is
averaged to obtain the Fluorescence Intensity value.

The concentration of the sample is calculated using calibration
curves generated from the eight Standards. The molarity of each
sample is calculated using the sample concentration, the DNA
fragment size (in base pairs), and the Dilution factor. The Sample
Size and Dilution factor can be provided in the Sample Names file,
in the Sample Names Tab before a well is run in the LabChip GX
Touch software, or in the Sample Name Editor Window in the
LabChip GX Reviewer software.

Optical Calibration

The LabChip GX and GX Touch instruments read fluorescence of a
laser illuminated dye attached to compounds present in a sample.
The absolute value of this fluorescence has little meaning as all
computed quantizations, such as concentration, are derived from
ratios of fluorescence to known standards found in the supplied
ladder. Due to component variations in the optical subsystem, the
same sample delivers different absolute fluorescence on different
instruments, making it somewhat disconcerting to the user when
comparing the e-grams of similar samples run on different
instruments. In order to provide a more consistent absolute
fluorescence for visual comparisons, an optical calibration process
is included in the LabChip GX and GX Touch software.

The Optical Calibration uses a calibrated test chip (Test Chip C),
which has a stable, dry fluorescent material embedded in the
channel. Test Chip C is provided with all new instruments. Test Chip
C is factory-calibrated with a reference contrast value written in the
chip RF tag. Each instrument uses this test chip to determine an
optical gain correction factor, which will scale its optical response to
a common standard.
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Peak Baseline

A local peak baseline is calculated for each peak. For isolated
peaks, the local peak baseline is a straight line connecting the start
point with the end point. For peaks that are very close together, an
average baseline is used when the value between the peaks does
not peak to the actual baseline. The peak baseline for each peak in
Figure 141 is shown in a different color.
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Figure 141. Peak Baselines

The peak baseline algorithm starts at the earliest peak and checks
whether the end point is within a certain distance from the start of
the next peak. When a cluster of peaks is detected, the peak
baseline is the line joining the first peak’s start to the last peak's
end. The start and end points of adjacent peaks in the cluster are
averaged to the same point so that no gaps exist between peaks.

The peak baseline Start Point and End Point can be moved in the
Overlay Electropherograms Tab if Show Peak Baselines is
selected in the Graph View Properties.

Peak Height

The value at the apex of the peak minus the local baseline start
value.
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Peak Identification

From the smoothed data, peaks are identified using a hill-climbing
algorithm running along the smoothed data and its first derivative.

The peak baseline is drawn across the peak bottom by taking local
averages just outside the peak start and end points and connecting
the two points. The peak height, measured from the apex down to
the peak baseline, must exceed the minimum peak height specified
in the Assay Analysis Window for the bump to be identified as a
peak. For details, see Understanding Peak Finding on page 108.

The peak start, end, and baseline can be viewed in the Graph View
by selecting the Show Peak Baselines option in the Graph View
Properties. The area of each peak is determined by trapezoidal
integration of the peak signal between peak boundaries and above
the peak baseline.

Point-to-Point Fit

This curve fit is composed of line segments between each pair of
data points that are used to interpolate data between the points.

Polynomial Filter

The first step the software takes in analyzing the raw data is to
apply Data Filtering. Data filtering is performed by means of a
polynomial “filter” that is applied to the raw data. The figure below
approximates the shape of the filter and shows what peaks may
resemble if the filter application is too strong.

—

Polynomial Order

This setting on the Peak Find Tab determines the order of the
polynomial filter used to convolve with the data. A polynomial filter
is used to filter the data to increase the signal-to-noise ratio and
calculate filter slope information for peak detection. The default
setting is 6 (for 6th order). A setting of 4 produces a straighter
baseline, preventing quick changes in the signal.
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Protein Assay Analysis
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Protein assays utilize a chemistry that generates an extra set of
peaks (system peaks) just above the lower marker that should not
be included in the analysis. These system peaks must be identified
and excluded from further quantitative analysis. For ladder analysis,
peaks occurring after the lower marker less than the “Ladder Ratio”
analysis setting, are tagged system peaks to avoid confusion with
legitimate ladder peaks.

Protein samples contain a single lower marker. Alignment to a
single marker does not provide enough constraints to align large
proteins, so data is aligned to two ladders, one sipped just before
the sample wells and another sipped just after the sample wells.
The second ladder is called the bracket ladder. Samples are scaled
so the sample’s lower marker is nearly aligned with both ladder
lower markers. The scaling is weighted by the proximity in sip time
to each ladder. The sample sipped closest to the primary ladder is
scaled to align more closely to the primary ladder and the sample
sipped just before the bracket ladder is scaled to align most closely
to the bracket ladder. Then each sample is shifted in time so the
sample's lower marker aligns exactly with the primary ladder lower
marker.

After alignment, the size of the protein producing each peak is
calculated from the aligned peak time using a log (size) versus
1/(Time-TO) fit to the primarily ladder peaks of known size and
measured migration time. TO is determined empirically as the time
offset which delivers the best straight line fit to the ladder data, The
value of TO used for the fit can be viewed in the Well Table View.

This fit to the ladder peak data can be viewed by selecting Standard
Curve from the Analysis menu. After sample peaks have been
sized, the system peaks are identified and excluded based on their
size. Any peak of size greater than the lower marker but less than
the Min. Sample Size specified in the Assay Analysis Window is
labeled a system peak and excluded from concentration and purity
analysis.

To determine sample peak concentration, the peak areas are first
corrected to compensate for the fact that the fluorescence
intensities are sampled at a constant time interval so slower moving
proteins spend more time under the detector than fast moving
proteins. The peak concentration is then calculated using the ladder
peak areas and concentration for the ladder supplied in the Assay
Analysis Window. The concentration is adjusted for the differing
peak ratios of sample and ladder.
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To quantitize the sample peak concentration based on a different
standard, the new standard must be added into each sample well at
a known concentration. The analysis settings provide a Sample
Peak Quantitation option using the peak area and concentration of
the User Standard instead of the ladder concentrations.

Protein Charge Variant Assay

PN CLS151165 Rev H

Capillary Zone Electrophoresis (CZE) is an electrophoretic
separation technique used to evaluate the charge heterogeneity of
proteins in a sample. The LabChip GXII or GXII Touch performs a
microfluidic adaptation of this technique for the Protein Charge
Variant Assay. For Protein Charge Variant assays, the separation
channel does not contain a polymer gel because the analytes are
not separated by size.

Protein Charge Variant assays separate analytes based on
differences in their net charge: molecules with a higher net charge
migrate faster than those with a lower net charge. The relative
difference in migration speeds (and therefore the resolution)
between molecules of different pl is higher when the pH of the
running buffer is closer to the PLS of the molecules.

For the HT Protein Charge Variant assay, the pH of the running
buffer is less than the PLS of the variants, so molecules have a net
positive charge. Variants that are more basic (have a higher pl) than
others appear earlier in electropherogram. The software can be
used to track expected variants, based on migration time, and to
determine the relative amount of each variant, based on peak area.

Protein Charge Variant assays do not use ladders or markers to
align the data. The size of a peak is not calculated, only the % Rel
amount of each peak. Protein Charge Variant assays and data files
do not include any ladder or marker parameters or options.
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RNA Assay Analysis

RNA analysis initially progresses similarly to DNA analysis except
that the baseline for RNA peaks is calculated using a spline-fit,
much like the baseline used for the Baseline Subtraction option.
However, this computed fit is not subtracted from the data; instead it
is used to determine the peak height and to limit the peak extends.

The RNA ladder is similar to the DNA ladder but does not contain
an upper marker. RNA sample data is aligned with the lower maker
and then the sample peaks are sized using point-to-point
interpolation between ladder peaks. The most prominent peaks
found within predefined size windows are identified as ribosomal
rRNA genes 5S, 18S and 28S (for eukaryote RNA), 16S and 23S
(for prokaryote RNA).

For the purpose of quantitizing the full RNA content in the sample, a
straight-line baseline is drawn across the bottom of the sample by
finding the local averages about its endpoint. The area baseline
endpoints can be moved on the Graph View after the “Show Peak
Baselines” option is selected in the Graph View Properties.
Trapezoidal integration from the straight-line baseline to the data
signal is used to calculate the total RNA area. Integration is
performed from the end of the lower marker to the endpoint of the
area baseline. The range from the end of the 5S to the start of the
18S peak is termed the Fast Area. This area is calculated in the
same way as the total RNA area.

For the purpose of quantitizing the rRNA peaks, a two-point
baseline is drawn across the bottom of each peak identified as
rRNA and the area is computed. These areas and rRNA peak
heights and some relevant ratios are available for display in the
Well Table View. A combination of the quantities is used to assess
the quality of the RNA sample.
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RNA Degrade Factor
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This value quantifies the degradation of the ribosomal peaks, which
typically leads to an increase in the fast area region between the 5S
and the 16S (prokaryote) or 18S (eukaryote) ribosomal peaks. The
quantity is computed as follows:

For prokaryote:

200 * Fast Area / (Fast Area Time Span) / (Height of 16S +
Height of 23S)

For eukaryote:

200 * Fast Area / (Fast Area Time Span) / (Height of 18S +
Height of 28S)

As the sample RNA degradation increases, this factor will increase.
A value below 10 is obtained with high quality RNA but the user
should determine their own threshold for discriminating between
good and bad RNA. This quantity can be viewed and reported in the
Well Table View.
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Rolling Ball Baseline Curve Example

The figures below show the effect of changing the size of the ball
when using the Rolling Ball Baseline Curve.

Figure 142 shows a baseline (the light blue line) generated by a ball
with settings of Time Diameter = 5 sec and Signal Diameter = 100
RFU.

Figure 142. Rolling Ball - 5 Sec x 200 RFU

Figure 143 on page 294 shows a baseline (the light blue line)
generated by a ball with settings of Time Diameter = 10 sec and
Signal Diameter = 200 RFU. The baseline curve does not follow the
signal as closely because the ball is larger. Increasing the ball size
generates a smoother baseline.

Either ball dimension can be used to increase the smoothness of
the curve, but increasing the Time Diameter increases the
computation time required to compute the curve, while increasing
the RFU Diameter does not.
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Figure 143. Rolling Ball - 10 Sec x 200 RFU

Slope Threshold
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The Slope Threshold setting represents the amount of change in
response over time required to differentiate between a peak and
baseline noise. Changing this setting may cause certain peaks that
were previously detected to be ignored or to interpret noise as
peaks. For details, see Understanding Peak Finding on page 108.

The Slope Threshold setting can be changed in the Peak Find Tab.
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Smear
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Specifies a size range in which to detect the region of the
fluorescence signal instead of specifying a specific size for a peak.
Use a smear to detect a broad mix of molecules of similar but
distinct sizes in a sample. The concentration or fractional presence
within a specified range of molecule sizes is measured. Specify the
Start Size and End Size of a smear in the Assay Analysis Window
on the Smear Analysis Tab.

The Smear Properties can be viewed in table form in the Well Table
View. To view the Smear Properties in the table, add the desired
property to the Well Table View. The properties extracted from the
smear match those of a peak, having start and end points, area,
concentration, etc. % Purity is the ratio of smear concentration to
total sample peak concentration, exclusive of markers, system
peaks, and excluded peaks. Excluded peaks are not excluded from
analysis calculations such as concentration or area within the
smear region, so the limits must avoid excluded peaks. An
additional Peak Count property is available for smears. Peak Count
is the number of non-excluded sample peaks in the region, where
the center of the peak is inside the smear limits.

In the Graph View, the smear regions display with the start and end
points drawn at the base of the smear in the chosen color and the
trace highlighted with the smear color. Override the smear baseline
by dragging with the mouse in the Graph view. The baseline start
and end points can be adjusted in the graph to change the height of
the baseline or the size range of the smear. Smears can overlap to
include the same region in multiple smears.

In the Gel View, the smear region is shown on the gel as a colorized
region. The color is a transparent version of the color selected for
the region, so that the fluorescence intensity shows through.
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Standard Curve
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The Standard Curve window shows the Standard curve used for the
selected plate data. Each window displays the following menus:

View menu - Select or clear the ladders (standards for NAQuant
NGS assays) to display in the window.

Copy menu - Copies the current view to the clipboard.

Print menu - Displays the Print Preview or prints the Standard
Curve.

DNA Assays

When you choose Standard Curve from the Analysis menu for a
DNA assay, a window similar to Figure 144 opens. The standard
curve is drawn from the values obtained for the DNA ladder. It is a
plot of the size of the ladder peaks vs. time with a point-to-point fit.
For each sample peak, the apex is interpolated from the Standard
Curve to determine the peak size in bp (base pairs).
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Figure 144. DNA Assay Standard Curve

For more information about the use of the standard curve during
analysis, see How the Software Analyzes DNA Data on page 17.

Protein Assays

When you choose Standard Curve from the Analysis menu for a
Protein assay, a window similar to Figure 145 opens. The standard
curve is drawn from the values obtained for the protein ladder. Itis a
plot of the size of the ladder peaks vs. time with a Log fit. For each
sample peak, the apex is interpolated from the Standard Curve to
determine the peak size in kDa (kiloDaltons).
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Figure 145. Protein Assay Standard Curve

For more information about the use of the standard curve during
analysis, see How the Software Analyzes Protein Data on page 19.

RNA Assays

When you choose Standard Curve from the Analysis menu for an
RNA assay, a window similar to Figure 146 opens. The standard
curve is drawn from the values obtained for the RNA ladder. It is a
plot of the size of the ladder peaks vs. time with a point-to-point fit.
For each sample peak, the apex is interpolated from the Standard
Curve to determine the peak size in nt.
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Figure 146. RNA Assay Standard Curve

For more information about the use of the standard curve during
analysis, see How the Software Analyzes RNA Data on page 23.
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gDNA Assays

When you choose Standard Curve from the Analysis menu for a
gDNA assay, a window similar to Figure 147 opens. The standard
curve is drawn from the values obtained for the gDNA ladder. It is a
plot of the size of the ladder peaks vs. time with a point-to-point fit.
For each sample peak, the apex is interpolated from the Standard
Curve to determine the peak size in kb (kilo base pairs).
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Figure 147. gDNA Assay Standard Curve

Start Point

The peak find algorithm analyzes the data from time zero looking
for a slope greater than the Slope Threshold. The point where the
slope is greater than the slope threshold specified in the Peak Find
Tab is marked as the start point of a peak.

Start Time

This setting determines the time after the start of a run when peaks
will be detected. Any peaks appearing before this time are ignored.
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Titer

Allows the use of a standard with a known concentration to be used
as a calibration standard instead of using a ladder. The well location
and known concentrations of the standard are specified in the
Assay Analysis Window on the Titer Tab.

The Titer Standard Curve used for calibration is normalized against
the lower marker (protein and RNA) or upper marker (DNA) to
adjust for slight variations in each well. A normalization standard
can be added to each well to be used only for normalization.
(normalization standards must be the same concentration in each
well.) Specify the normalization standard in the Assay Analysis
Window on the Advanced Tab. Titers can also be imported from
another plate if the normalization Standard is the same. If Sample
Peaks is selected, the Sample Peaks must be the same size.

The Concentration to Favor in Fit adjustment on the Titer tab
enables you to choose whether to weight either the higher or lower
concentrations more heavily when calculating the Titer Standard
Curve.

Tool Tip

A small box containing text that describes the item indicated by the
mouse pointer. To view a Tool Tip, position the cursor over an item
on the window. Leave the cursor stationary for a moment and a
Tool Tip (if one exists for that item) displays.

Upper Marker

An internal standard that is added to a DNA sample in a well to
assist in determining size and concentration of the sample. The
marker is the same as the last peak in the DNA ladder.

Workspace

Use a workspace file to view the plate data from a run. Multiple
plate data files can be opened in the same workspace to enable
comparison between data from different plates or different runs.

Each workspace can contain multiple Collections for viewing the
same data in different layouts.
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A Workspace file includes:
the links to the plate data files in each collection
the selected wells and arrangement of the wells in the views

the layout selected for each collection

Zero Baseline

Selecting this setting in the Peak Find Tab offsets the graphs shown
for the individual wells but does not affect analysis. The mean of

100 points before the baseline time (derived when calculating well
noise) is used as the zero baseline value.

PN CLS151165 Rev H

All electropherograms produced with the instrument show some
amount of background fluorescence. By default, the LabChip GX
Reviewer software enables the Zero Baseline function. To change
the Baseline Algorithm, select none, Zero Baseline, or Baseline
Subtraction on the Peak Find Tab.
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Revvity Software License Agreement

***IMPORTANT INFORMATION-PLEASE READ CAREFULLY***

This Software contains computer programs and other proprietary material and information, the use of which is subject to and expressly
conditioned upon acceptance of this License Agreement (the “Agreement”). This Agreement is a legally binding agreement between you
(meaning the individual person or the entity that the individual represents that has obtained the Software for its internal productive use and not for
outright resale) (the “Licensee”) and Revvity (which means (i) Revvity Health Sciences, Inc., if the Licensee is located in the United States; (ii)
the local Revwvity, Inc. sales subsidiary, if the Licensee is located outside the United States and in a country in which Revvity, Inc. has a local
sales subsidiary; and/or (iii) Revvity Cellular Technologies Germany GmbH, if the Licensee is located outside the United States and in a country
in which Revvity, Inc. does not have a local sales subsidiary), with offices at 940 Winter Street, Waltham, Massachusetts 02451. Unless Revvity
agrees otherwise in writing, this Agreement governs Licensee's use of the Software, except to the extent all or any portion of the Software is
governed by a third party licensor's terms and conditions.

BY DOWNLOADING, INSTALLING, OR USING THE SOFTWARE, OR BY OPENING THE SOFTWARE PACKAGE OR ISSUING A PURCHASE
ORDER FOR A License TO USE THE SOFTWARE, AS THE CASE MAY BE, YOU ARE (I) Representing TO REVVITY THAT YOU ARE
AUTHORIZED TO BIND THE LICENSEE; (Il) AGREEING ON BEHALF OF THE LICENSEE THAT THE TERMS OF THIS AGREEMENT SHALL
GOVERN THE RELATIONSHIP OF THE PARTIES WITH REGARD TO THE SUBJECT MATTER IN THIS AGREEMENT AND ARE WAIVING
ANY RIGHTS, TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, TO ANY CLAIM ANYWHERE IN THE WORLD CONCERNING
THE ENFORCEABILITY OR VALIDITY OF THIS AGREEMENT; AND (lll) AGREEING THAT THE SOFTWARE IS ACCEPTED AS DELIVERED.
IF YOU DO NOT HAVE AUTHORITY TO AGREE TO OR DO NOT ACCEPT THE TERMS OF THIS AGREEMENT ON BEHALF OF THE
LICENSEE, REVVITY WILL NOT AND DOES NOT LICENSE THE SOFTWARE TO THE LICENSEE AND YOU MUST IMMEDIATELY RETURN
THE UNOPENED SOFTWARE PACKAGE WITHIN FORTY-EIGHT (48) HOURS OF RECEIPT FOR A REFUND, CEASE ANY FURTHER
ATTEMPT TO INSTALL, DOWNLOAD OR USE THIS SOFTWARE FOR ANY PURPOSE, AND REMOVE ANY PARTIAL OR FULL COPIES
MADE FROM THIS SOFTWARE.

THIS IS A LICENSE AGREEMENT AND NOT AN AGREEMENT FOR SALE.
1 Definitions:

a ‘“Affiliates” means, with respect to a party to this Agreement, any Person that controls, is controlled by, or is under common control
with that party. For the purpose of this definition, “control” shall mean, direct or indirect, ownership of fifty percent (50%) or more of
the shares of stock entitled to vote for the election of directors, in the case of a corporation, or fifty percent (50%) or more of the
equity interest in the case of any other type of legal entity, status as a general partner in any partnership, or any other arrangement
whereby the entity or person controls or has the right to control the board of directors or equivalent governing body of a corporation
or other entity, or the ability to cause the direction of the management or policies of a corporation or other entity.

b  “Documentation” means user manuals, technical manuals and any other materials provided by Revvity, in printed, electronic or
other form, that describe the installation, operation, use or technical specifications of the Software.

c  “Person” means an individual, corporation, partnership, joint venture, limited liability company, governmental authority,
unincorporated organization, trust, association or other entity.

d “Software” means the software program(s) associated with the LabChip GX Touch and/or LabChip GX Touch Il products for which
Licensee is obtaining a license, as may be set forth in any purchase order, and also includes any associated hardware. Software
also includes any updates and/or purchased upgrades to the Software that Licensee may receive and/or purchase from time to time
under a separate services or support contract.

e  “Third Party” means any Person other than Revvity and Licensee.

2 License Grant and Scope. Subject to and conditioned upon Licensee's payment of any fees due for the license granted hereunder and
Licensee's strict compliance with all terms and conditions set forth in this Agreement, Revvity hereby grants to Licensee a non-exclusive,
non-transferable, non-sublicensable, limited license during the Term to use, the Software, solely as set forth in this Section 2 and subject to
all conditions and limitations set forth in Section 3 or elsewhere in this Agreement. This license grants Licensee the right to:

a download, copy, and install, in accordance with the Documentation, the Software on a single computer owned or leased, and
controlled by, Licensee. In addition to the foregoing, Licensee has the right to make one (1) copy of the Software solely for archival
and backup purposes; provided that Licensee shall not, and shall not allow any Person to, install or use any such copy other than if
and for so long as the copy installed in accordance with the preceding sentence is inoperable and, provided, further, that Licensee
uninstalls and otherwise deletes such inoperable copy. All copies of the Software made by the Licensee: (i) will be the exclusive
property of Revvity; (ii) will be subject to the terms and conditions of this Agreement; and (iii) must include all trademark, copyright,
patent and other intellectual property rights notices contained in the original;

b  use and run the Software, in executable code only, as properly installed in accordance with this Agreement and the Documentation;
and
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c download or otherwise make one (1) copy of the Documentation and use such Documentation, solely in support of its licensed use of
the Software in accordance herewith. All copies of the Documentation made by Licensee: (i) will be the exclusive property of Revvity;
(ii) will be subject to the terms and conditions of this Agreement; and (iii) must include all trademark, copyright, patent and other
intellectual property rights notices contained in the original.

3 Restrictions. Licensee shall not, and shall require its employees and/or other authorized s not to, directly or indirectly:
a use (including make any copies of) the Software and/or Documentation beyond the scope of the license granted in Section 2;

b  modify, translate, adapt or otherwise create derivative works or improvements, whether or not patentable, of the Software and/or
Documentation or any part thereof;

c combine the Software or any part thereof with, or incorporate the Software or any part thereof in, any other programs;

d reverse engineer, disassemble, decompile, decode or otherwise attempt to derive or gain access to the source code of the Software
or any part thereof;

e remove, delete, alter or obscure any trademarks or any copyright, trademark, patent or other intellectual property or proprietary
rights notices from the Software or Documentation, including any copy thereof;

f except as expressly set forth in Section 2(a) and Section 2(c), copy the Software and/or Documentation, in whole or in part;

g rent, lease, lend, sell, resell, sublicense, assign, distribute, publish, transfer or otherwise make available the Software or any
features or functionality of the Software, to any Third Party for any reason, whether or not over a network and whether or not on a
hosted basis, including in connection with the internet, web hosting, wide area network (WAN), virtual private network (VPN),
virtualization, time-sharing, service bureau, software as a service, cloud or other technology or service;

h  use the Software in, or in association with, the design, construction, maintenance or operation of any hazardous environments or
systems, including: (i) power generation systems; (ii) aircraft navigation or communication systems, air traffic control systems or any
other transport management systems; (iii) safety-critical applications, including medical or life-support systems, vehicle operation
applications or any police, fire or other safety response systems; and (iv) military or aerospace applications, weapons systems or
environments;

i use the Software in violation of any federal, state or local law, regulation or rule;
j use the Software for purposes of competitive analysis of the Software, the development of a competing software product or service;

k install or use the Software on more than one computer simultaneously without the purchase of additional licenses and/or the express
written consent of an authorized Revvity representative; and/or

| use the Software to provide outsourcing, service bureau, online services or trainings to a Third Party, without the express written
consent of an authorized officer of Revvity.

4  Open Source. The Software may contain or be provided with open source libraries, components, utilities and other open source software
(collectively, “Open Source”), which Open Source may have applicable license terms as identified by Revvity upon written request, or as
otherwise may be provided with the applicable Documentation. Notwithstanding anything to the contrary herein, use of the Open Source
shall be subject to the applicable Open Source license terms and conditions to the extent required by the applicable licensor
(which terms shall not restrict the license rights granted to Licensee hereunder but may contain additional rights) and such Open Source
license terms shall only apply to such Open Source component and not the entire Software. Any breach by Licensee of any Open Source
license shall also be deemed a breach of this Agreement. In the event of a conflict between the Open Source license and this Agreement,
the Open Source license will prevail solely with respect to the Open Source component.

5 Responsibility for Use of Software. Licensee is responsible and liable for all uses of the Software through access thereto provided by
Licensee, directly or indirectly. Specifically, and without limiting the generality of the foregoing, Licensee is responsible and liable for all
actions and failures to take required actions with respect to the Software by its employees or by any other Person to whom Licensee may
provide access to or use of the Software, whether such access or use is permitted by or in violation of this Agreement.

6  Security Mechanisms. Revvity and its Affiliates endeavor to take all legal actions available to it to eliminate piracy of its software
products. As such, the Software may include a security mechanism which collects and transmits usage data for the purpose of detecting
the installation or use of illegal copies of the Software. Data collected will not include any Licensee data created with the Software. Licensee
consents to such detection and collection of data, as well as its transmission and use. Revvity also reserves the right to use a hardware lock
device, license administration software, and/or a license authorization key to control access to the Software. Licensee shall not take any
steps to avoid, remove, disable, circumvent, defeat, or otherwise create or implement any workaround to any such measures. Use of the
Software by Licensee without the required lock device or authorization key provided by Revvity is strictly prohibited.
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7  Compliance. Revvity may, in Revvity's sole discretion, audit the Licensee's use of the Software under this Agreement at any
time during the Term to ensure Licensee's compliance with this Agreement, provided that (i) any such audit shall be conducted on not less
than ten (10) business days' prior notice to Licensee, and (ii) no more than one audit may be conducted in any twelve (12) month period
except for good cause shown. Revvity also may, in its sole discretion, audit Licensee's systems within twelve (12) months after the end of
the Term to ensure Licensee has ceased use of the Software and removed all copies of the Software from such systems as required
hereunder. Licensee shall reasonably cooperate with Revvity's personnel conducting such audits and provide all reasonable access
requested by the Revvity to records, systems, equipment, information and personnel, including serial numbers and related information.
Revwvity shall only examine information directly related to the Licensee's use of the Software. Revvity may conduct audits only during
Licensee's normal business hours and in a manner that does not unreasonably interfere with the Licensee's business operations.

8  Ownership. The Software is licensed, not sold, to Licensee subject to the terms of this Agreement. Revvity reserves all rights not
expressly granted to Licensee. Licensee owns the media, if any, on which the Software is recorded, but Revvity retains ownership of all
copies of the Software itself. Licensee acknowledges that the Software contains and embeds valuable, unpublished information that is
proprietary and confidential to Revvity and its licensors and suppliers. Licensee agrees to keep all such information confidential. This does not
preclude Licensee from using information Licensee lawfully obtain from another source.

9 Term. This Agreement is effective on the date Licensee accepts this Agreement and/or downloads or installs the Software, whichever is
earlier, and will continue until terminated. This Agreement and the licenses granted hereunder will terminate immediately without notice to
Licensee if (i) Licensee materially breaches any term or condition of this Agreement; or (ii) if Licensee files, or has filed against it, a
petition for voluntary or involuntary bankruptcy or pursuant to any other insolvency law, makes or seeks to make a general assignment for
the benefit of its creditors or applies for, or consents to, the appointment of a trustee, receiver or custodian for a substantial part of its
property. Licensee also may terminate this Agreement, at any time, by destroying the Software and all copies thereof. Upon any
termination, the license granted to Licensee shall immediately cease and Licensee agrees to discontinue all use of the Software, promptly
erase all copies of the Software and portions thereof from License's computer storage or any other media, and return or destroy all copies
of the Software. Termination is not an exclusive remedy.

10 Limited Warranty. Revvity's sole warranty with respect to the Software is that for a period of ninety (90) days from the date of receipt,
the Software will substantially contain the functionality described in the published specifications, and when properly installed on a
computer meeting the specifications set forth in, and operated in accordance with, the Documentation, will substantially perform in
accordance therewith. THE FOREGOING WARRANTY DOES NOT APPLY, AND REVVITY STRICTLY DISCLAIMS ALL
WARRANTIES, WITH RESPECT TO ANY THIRD PARTY MATERIALS.

11 Warranty Disclaimer. TO THE MAXIMUM EXTENT PERMISSIBLE UNDER APPLICABLE LAW, REVVITY EXPRESSLY
DISCLAIMS ALL OTHER WARRANTIES OF ANY KIND, EXPRESS, IMPLIED OR STATUTORY, INCLUDING WITHOUT LIMITATION,
THE IMPLIED WARRANTIES OF MERCHANTABILITY OR SATISFACTORY QUALITY, FITNESS FOR A PARTICULAR PURPOSE,
NON-INFRINGEMENT OF THIRD PARTY RIGHTS, AND ANY IMPLIED WARRANTIES ARISING FROM COURSE OF DEALING OR
COURSE OF PERFORMANCE. REVVITY DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL
MEET THE LICENSEE'S REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-
FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. FURTHERMORE, REVVITY DOES NOT WARRANT OR MAKE
ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE OR RELATED
DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN INFORMATION
OR ADVICE GIVEN BY REVVITY SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY.
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT
APPLY TO THE LICENSEE. THE TERMS OF THIS DISCLAIMER DO NOT AFFECT OR PREDJUDICE THE STATUTORY RIGHTS OF A
CONSUMER ACQUIRING REVVITY PRODUCTS OTHERWISE THAN IN THE ORDINARY COURSE OF BUSINESS, NEITHER DO THEY
LIMIT OR EXCLUDE ANY LIABILITY FOR DEATH OR PERSONAL INJURY CAUSED BY REVVITY'S NEGLIGENCE.

12 Limitation of Liabilities. Revvity's and its Affiliates' entire liability and Licensee's sole and exclusive remedy shall be, at Revvity"s
sole discretion, either (A) the return of any license fee paid for the Software, or (B) correction or replacement of the Software that does not
meet the terms of this limited warranty and that is returned to Revvity with a copy of the purchase receipt. REGARDLESS OF WHETHER
ANY REMEDY SET FORTH HEREIN FAILS OF ITS ESSENTIAL PURPOSE OR OTHERWISE, IN NO EVENT WILL REVVITY, ITS
AFFILIATES, ITS LICENSORS OR SUPPLIERS BE LIABLE TO LICENSEE OR ANY THIRD PARTY UNDER ANY LEGAL THEORY OF
LIABILITY FOR ANY LOSS OF PROFITS OR REVENUE, LOSS OR INACCURACY OF DATA, INTERRUPTION OF BUSINESS, COST OF
SUBSTITUTION, INTERRUPTION, DELAY, LOSS RESULTING FROM SYSTEM OR SYSTEM SERVICE FAILURE, BREACHES IN
SYSTEM SECURITY, OR ANY OTHER INDIRECT, SPECIAL, CONSEQUENTIAL, EXEMPLARY OR INCIDENTAL DAMAGES OF ANY
NATURE ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF REVVITY HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES AND WHETHER OR NOT SUCH DAMAGES ARE FORESEEABLE. IN NO EVENT WILL THE
LIABILITY OF REVVITY, ITS AFFILIATES, ITS LICENSORS OR SUPPLIERS EXCEED THE GREATER OF ONE U.S. DOLLAR OR THE
LICENSE FEE RECEIVED BY REVVITY FROM LICENSEE FOR THE SOFTWARE. Some jurisdictions do not allow the exclusion or
limitation of liability for consequential or incidental damages, so the above exclusion may not apply.
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U.S. Government End s. The Software is commercial computer software, as such term is defined in 48 C.F.R. §2.101. Accordingly, if the
Licensee is the US Government or any contractor therefor, Licensee shall receive only those rights with respect to the Software and
Documentation as are granted to all other end s under license, in accordance with (a) 48 C.F.R. §227.7201 through 48 C.F.R. §227.7204,
with respect to the Department of Defense and their contractors, or (b) 48 C.F.R. §12.212, with respect to all other US Government
licensees and their contractors. If this Agreement fails to meet the Government's minimum needs or is inconsistent in any respect with
Federal procurement law, the Government agrees to return this software, unused, to Revvity.

Export Law. The Software is subject to U.S. export control laws and may be subject to export or import regulations in other countries.
Licensee agrees to strictly comply with all such laws and regulations and acknowledge that Licensee has the responsibility to obtain any
required export, re-export, or import licenses. Licensee agree to indemnify and hold Revvity harmless from all claims, losses, liabilities,
damages, fines, penalties, costs and expenses relating to Licensee's breach of these obligations.

Trademark Acknowledgement. The Revvity logo is a registered trademark of Revvity, Inc. Revvity and LabChip are
registered trademarks of Revvity, Inc. and/or its Affiliates. All other Third Party brands, products, service names, trademarks, or registered
service marks are used to identify the products or services of their respective owners, and are the property of their respective holders.

General.

a  This Agreement will be governed by the laws of the Commonwealth of Massachusetts, without giving effect to conflict of laws
principles that require the application of the laws of any other jurisdiction. The UN Convention on Contracts for the International Sale
of Goods will not apply to this Agreement. Licensee hereby irrevocably submits to the personal jurisdiction and venue of, and agrees
to service of process issued or authorized by, state and federal courts with jurisdiction over Suffolk County, Massachusetts, and
Licensee waives any objection thereto. The prevailing party in any action under this Agreement is entitled to receive its costs and
expenses, including reasonable attorneys' fees, incurred in that action, in addition to any other relief it may receive.

b  If any term or provision of this Agreement is invalid, illegal or unenforceable in any jurisdiction, such invalidity, illegality or
unenforceability shall not affect any other term or provision of this Agreement or invalidate or render unenforceable such term or
provision in any other jurisdiction. This Agreement may only be amended, modified or supplemented by an agreement in writing
signed by each party hereto. No waiver by any party of any of the provisions hereof shall be effective unless explicitly set forth in
writing and signed by the party so waiving. Except as otherwise set forth in this Agreement, no failure to exercise, or delay in
exercising, any right, remedy, power or privilege arising from this Agreement shall operate or be construed as a waiver thereof; nor
shall any single or partial exercise of any right, remedy, power or privilege hereunder preclude any other or further exercise thereof
or the exercise of any other right, remedy, power or privilege. Licensee may not assign or delegate this Agreement, nor any rights or
duties hereunder, in whole or in part, without Revvity's prior written approval, which may be withheld in its sole discretion, and any
purported attempt to do so is void. Only a written amendment referencing this Agreement and executed and delivered by both parties
can modify this Agreement.

¢ Revwvity shall not be in default hereunder by reason of any failure or delay in the performance of its obligations hereunder where
such failure or delay is due to strikes, labor disputes, civil disturbances, riot, rebellion, invasion, epidemic, hostilities, war, terrorist
attack, embargo, natural disaster, acts of God, flood, fire, sabotage, fluctuations or non-availability of electrical power, heat, light, air
conditioning or Licensee equipment, loss and destruction of property or any other circumstances or causes beyond Revvity's
reasonable control.

d This Agreement and all other documents that are incorporated by reference herein, constitutes the sole and entire agreement
between Revvity and Licensee with respect to the subject matter contained herein, and supersedes all prior and contemporaneous
understanding, agreements, representations and warranties, both written and oral, with respect to such subject matter. This Agreement
shall be construed without regard to any presumption or rule requiring construction or interpretation against the party drafting an
instrument or causing any instrument to be drafted.
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